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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©0ctober 2018

Trademarks
Intel, Pentium and Intel Celeron are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
Thisdeviceisin compliance with the essential requirements and other relevant provisions of the R& TTE Direc-
tive 1999/5/EC.

Thisdevice will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
Thefigures below note the power consumption of thiscomputer in compliance with European Commission (EC)
regulations on power consumption in off mode:

« Off Mode <0.5W
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CE Marking

This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters“CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark

is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R& TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and hasissued afavorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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FCC Statement

(Federal Communications Commission)

Y ou are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limitsfor aClass B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonabl e protection against harmful interferencein
aresidential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, thereisno guarantee that interference will not occur in aparticular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

« Connect the equipment into an outlet on acircuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.
And

2. This device must accept any interference, including interference that may cause undesired operation of the
device.
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FCC RF Radiation Exposure Statement:
1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator

and your body.

N2
2

Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the

equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.

4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

5. This product is intended to be supplied by a Listed Power Unit according to the model’s requirements:

For Model A, Model B Design | & Model C
 Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19V/7.89A OR 19.5V/7.7A(150W) mini-
mum.

For Model B Design |1
* Full Range AC/DC Adapter - AC Input 100 - 240V, 50 - 60Hz, DC Output 19.5V/6.15A (120W) minimum.

Vi



Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions.

1.

Preface

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

=l

Do not expose the computer
to any shock or vibration.

87 .
R

surface.

Do not placeit on an unstable

Do not place anything heavy
on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-

aged.

Do not expose it to excessive
heat or direct sunlight.

Do not leaveit in a place
where foreign matter or mois-
ture may affect the system.

Don't use or store the com-
puter in a humid environment.

Do not place the computer on
any surfacethat will block the
Vents/Fan Intakes.

Vi



Preface

Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don'’t forget

to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance
on your computer.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.

VIiI
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Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and may expose you and
the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from
the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

»  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

* If the computer does not work normally when you follow the operating instructions.

* If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
* If thereisan unusua odor, heat or smoke coming from your computer.

\ A/
LS
Bottom Cover Removal Warning

Users should not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may violate the terms of
your warranty. If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please contact your dis-
tributor/supplier for further information.

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and

screw(s) before restoring power to the system.
Also note the following when the cover is removed:

e Hazardous moving parts.
* Keep away from moving fan blades.
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Power Safety
The computer has specific power requirements:

ﬁ * Only use apower adapter approved for use with this computer.
* Your AC/DC adapter may be designed for international travel but it still requires a steady,
Power Safety uninterrupted power supply. If you are unsure of your local power specifications, consult
L) your service representative or local power company.

Before you undertake » The power adapter may have either a2-prong or a 3-prong grounded plug. Thethird prong
any upgrade proce- isan important saf ety feature; do not defeat its purpose. If you do not have accessto a
dures, make sure that compatible outlet, have aqualified electrician install one.
VEIEVERTIGEEREIGES  « \When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
power, and discon- itswire.

Jeas B E S .\ ake sure the socket and any extension cord(s) you use can support the total current load
and cables (including

telephone lines and of all the con.nected devices. L

power cord). * Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

You must also remove
your battery in order to
prevent accidentally Do not plug in the power Do not use the power cordif | Do not place heavy objects
turning the machine cord if you are wet. it is broken. on the power cord.

on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.




Preface

Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

» Polymer batteries may experience aslight expansion or swelling, however thisis part of the battery’s safety mecha-
nism and is not a cause for concern.

e Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

» If you are working in areas of low temperature use the AC/DC adapter to power the computer.

See aso the general battery precautionary information overleaf for further information.

Xl
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General Battery Precautions

» Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

» Do not remove any batteries from the computer while it is powered on.

» Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
resultinfire.

» If you do not use the battery for an extended period, then remove the battery from the computer for storage.

» Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

» Donot try to repair abattery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

» Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

» Keep the battery away from metal appliances.

» Affix tape to the battery contacts before disposing of the battery.

» Do not touch the battery contacts with your hands or metal objects.

\ A/
2R
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

Xl
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Cleaning Instructions

(For Computer Models Supplied with Light Blue Cleaning Cloth)
Some computer modelsin this series come supplied with alight blue cleaning cloth. To clean the computer case
with this cloth follow the instructions below:

Power off the computer and peripherals.

Disconnect the AC/DC adapter from the computer.

Use a little water to dampen the cloth slightly.

Clean the computer case with the cloth.

Dry the computer with a dry cloth, or allow it time to dry before turning on.
Reconnect the AC/DC adapter and turn the computer on.

ok wnpE

X1l
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Travel Considerations
Asyou get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both
hardware and software. Make sure your “papers” are handy.

SN
L&

Power Off Before Traveling

agprwbNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.

XV
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these pointsin mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Bewar e of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
Theserestrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power whereyou can - If an electrical outlet isavailable, usethe AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from acold to awarm location, water vapor can condense inside the computer.
Wait afew minutes before turning it on so that any moisture can evaporate.

XV
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Developing Good Work Habits

Developing good work habitsisimportant if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

«Adjust the height of the chair and/or desk so that the keyboard isat or sightly below the level
of your elbow. Keep your forearms, wrists, and hands in arelaxed position.

*Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a
footrest if necessary.

*Use achair with aback and adjust it to support your lower back comfortably.

«Sit straight so that your knees, hips and elbows form approximately 90-degree angles when
you are working.

*Take periodic breaksif you are using the computer for long periods of time.

Remember to:

Alter your posture frequently.

«Stretch and exercise your body several times a day.

*Take periodic breaks when you work at the computer for long periods of time. Frequent and
short breaks are better than fewer and longer breaks.

XVI



Preface

Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
Position the display directly in front of you at a comfortable viewing distance.

Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image per sistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

Set the Windows Power Plans to turn the screen off after a few minutes of screenidle time.

Use arotating, moving or blank screen saver (this prevents an image from being displayed too long).
Rotate desktop background images every few days.

Turn the monitor off when the system isnot in use.

LCD Electro-Plated Logos

Note that in computers featuring araised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may devel op sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.

XVII
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guideto using some of the main features of the computer e.g. the stor age devices (hard disk,
optical device, Multi-in-1 card reader), TouchPad & Mouse & Audio.

e Chapter 3  The computer’'s power saving options.

e Chapter 4 Theinstalation of the driversand utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

e Chapter 7 A quick guide to the computer’'s PC Camera, WirelessL AN, Combo Bluetooth & WLAN, TPM
(security), Intel and 4G modules (some of which may be optional depending on your purchase
configuration).

e Chapter 7 A troubleshooting guide.

« Appendix A Definitions of the interface, ports/jackswhich allow your computer to communicate with external
devices.

» Appendix B Information on Control Center.

* Appendix C Information on the Video driver controls.

» Appendix D The computer’s specification.

. |
Overview 1 -1
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Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page4 - 1 and “BIOS Utilities” on page5 - 1 in the remainder of the User’'s
Manual. Y ou may also find the notes marked with a /Z of interest to you.

Beginners and Non-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in the Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark | remainder of the User's Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
utors foatiroe. <™ | may find it useful to refer to the notes marked with a s indicated in the margin,
For amore detailed description of any of the interface ports and jacks see “ I nterface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview



Quick Start Guide
Not Included

Operating Systems (e.g. Windows 10) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “ Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn't been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Interface (Ports & Jacks)” on page A - 1 for a description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Model Differences

This notebook series includes three different models (Model B includes 2 designs based on specification dif-
ferences within the design) that vary slightly in appearance. Note that though your computer may look slightly
different from that pictured throughout this manual, all ports, jacks (other than those indicated in the specifica-
tion) and general functions are the same for al the design styles (see Appendix D for further details).

. |
Overview 1 -3
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System Startup

1. Remove all packing materials, and place the computer on a stable surface.

2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

3. When first setting up the computer use the following procedure (as to safeguard the computer during
shipping, the battery will be locked to not power the system until first connected to the AC/DC adapter and
initially set up as below):

» Attach the AC/DC adapter cord to the DC-In jack on the left of the computer, then plug the AC power cord into an outlet, and connect
the AC power cord to the AC/DC adapter and leave it there for 6 seconds or longer.

» Remove the adapter cord from the computer’s DC-In jack, and then plug it back in again; the battery will now be unlocked.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other
hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

e
Shutdown TR e s e

Note that you should al-
ways shut your comput-
er down by choosing the

Shut Down command
in Windows (see page \
1 - 36). This will help . . . .

prevent hard disk or sys- Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In
tem problems.

J

1 -4 System Startup
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System Software

Y our computer may aready come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for adifferent system, you will find the Windows 10 (64-bit) operating system
IS supported.

4

Windows OS

Note that the information included on the following pages is for Windows 10 only.

In order to run Windows 10 (64-bit) your computer requires a minimum 8GB of system memory (RAM).

L_________________________________________________________________________________________________________________________________________________|
System Startup 1 -5
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Figure 1 -2
LCD Panel Open

=

Built-in PC Camera
PC Camera LED
Built-In Array
Microphone

LCD

Speakers

Power Button
Keyboard
Touchpad & Buttons
Fingerprint Reader
(Optional

with Secure Pad)

wnN

©oNo oA

164

Left Buiton zone i
i
i

Right Button zone

Note that the Touchpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines above.

LCD Panel Open - Model A

1 -6 LCD Panel Open - Model A

2NZ
L&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the WLAN, Bluetooth &
3G/4G module(s) are OFF
if you are using the comput-

er aboard aircraft by putting
the system in to Airplane
Mode (see

)-
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LCD Panel Open - Model B Figure 1 - 3

LCD Panel Open

\ A/ P
7£l< 1. Built-in PC Camera
Wireless Device 2. PC Camera LED
Operation Aboard 3. Built-In Array
Aircraft Microphone
4. LCD
The use of any po_rta_ble 5. Speakers
electronic  transmission
devices aboard aircraft is 6. Power Button
usually prohibited. Make 7. Keyboard
sure the WLAN, Blue- 8. Touchpad & Buttons
tooth & 3G/4G module(s) 9. Fingerprint  Reader
are OFF if you are using (Optional for Design
the computer aboard air- | Only with Secure
craft by putting the system Pad)

s e i e in to Airplane Mode (see

1L E L T ¥ u I UIF.
- | [20E=] [ e e S 7 el s ))

Z |55 S el ]| e | S | S

©

Let Bution zone H
'
|

Right Button zone

Note that the Touchpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines above.

LCD Panel Open - Model B 1-7
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Figure1-4
LCD Panel Open

Built-in PC Camera
PC Camera LED
Built-In Array
Microphone

LCD

Speakers

Power Button
Keyboard
Touchpad & Buttons
Fingerprint ~ Reader
(Optional

with Secure Pad)

wn e
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©
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1
|

Note that the Touchpad and
Buttons has a valid opera-
tional area indicated within
the dotted lines above.

1-8LCD Panel Open - Model C

MNL
L&
Wireless Device

Operation Aboard
Aircraft

The use of any portable
electronic  transmission
devices aboard aircraft is
usually prohibited. Make
sure the WLAN, Blue-
tooth & 3G/4G module(s)

are OFF if you are using
the computer aboard air-
craft by putting the system
in to Airplane Mode (see




LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Quick Start Guide

Icon Color Description
Orange DC Power is Plugged In
D,,/d) Green The Computer is On

Blinking Green

The Computer is in Sleep Mode

Orange

The Battery is Charging

Green

The Battery is Fully Charged

Blinking Orange

The Battery Has Reached Critically Low Power Status

Green

Hard Disk Activity

+ @ E

Green

Airplane Mode is ON (the WLAN, Bluetooth & 3G/4G Modules are OFF)

Table 1 -1 - LED Indicators

LED Indicators 1 -9
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llluminated Color LED Keyboard

4 (For Model A, Model B Design | & Model C)
Clver Seplseres The illuminated colored keyboard has an embedded numerical keypad for easy nu-
If your keyboard is dam- || Mmeric data input, and features function keys to allow you to change operational fea-
aged or you just want to & tures instantly. See Table 1 - 4, on page 1 - 14 for full function key combination

make a change, you can : “« : ”
use any standard USB details. and see“ I lluminated LED Keyboard” on page 1 - 11.

keyboard. The system will

detect and enable it auto-

matically. However spe- - ' ) 1Me |~ 1[& ] *"'[";"-"S" | 11
cr Lk Ke . o =

cial  functions/hot-keys - Play/Pause Key ILs e JlLz]le]lallo]L- = e |l] B Tol| %] =

unique to the system’s ] i | ey ’

regular keyboard may not TR q @

E
work. E . o = = ...4._.':._.2.
i E] E] E] EILE IR LR =" LS Numericalf L2

"pgup | [Pgon

(Fa_ ) [Fao_ ) [Fan, | [Faz | [Bresc||[ s N[ gu | [ !
léfll serk ||| O | |Home ] | End | | pouse | | Ereak

[ec] [F2] Pl Ps] [* |Function Keys *erl [Pl %] [P5) 0] (5]

rI[T[y[u][1)a][e }" | ‘Num Lk Key | 8

Home Pglp

Scr Lk [ —— = —— : . — Kevpad
& shift Game CLontrgl Ke!s v | B || N | nMenu/Application Key i EJq ):p -
J J | J L L JL JL ) b f L nd_§ J LESE ) | e
Hold down the Fn Key =, - — ¢ = =
and Scr Lk to enable ctrl fo || = lendows Logo Key ar || B2 [lew - Y » || 0 L
scroll lock and check the : : e : ek et =
LED indicator for status. Figure 1 - 5 - llluminated Color LED Keyboard

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

1-10 llluminated Color LED Keyboard



uminated LED Keyboard

(For Model B Design 11)

The optional white illuminated keyboard has an embedded numerical keypad for
easy numeric datainput, and features function keysto allow you to change operation-
a featuresinstantly. See Table 1 - 4, on page 1 - 14 for full function key combination

details.

(=[] ] [Fs) 7] Funciion Keys s [P [Pa) (7] [Pl 5] ]| =] (=] (=] (2] (22)

o || Play/Pause Keﬂ‘“‘ s |15 [k Ik | ! [‘ +Ser Lk Keyl woll 2 1|« [] -
[ 1[@ 7] ‘"w HE T'R |"T ¥ qu RIE | "p 17 | ] [ Num Lk Key s

L JL JL JL JL JL JL JL JL JL JU_Ju_ s ] Lpome J [T LPoe |

- - " - " r . ] 1r " r " r " ~ - +

[owe  |[A 1[5 D MF le I[H {J K | L ‘ ‘ e j 4 |[5 16

L L J JL=J\L - J J — L J L JL JLU L / "' Numerical:
[ | 1 [N ' Menu/Application Key || , |7 Keypad

L J J JL I JU L JL e e vt J e gy,
|C i = | V\llindows Logo Key Ha || & e il v][»][] = |

Figure 1 - 6 - llluminated (White) LED Keyboard
e

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLKk is on.

Quick Start Guide

4

Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial  functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Scr Lk

Hold down the Fn Key
and Scr Lk to enable
scroll lock and check the
LED indicator for status.

llluminated LED Keyboard 1 - 11



Quick Start Guide

Keyboard Backlight LED Device

(For Illuminated Color Keyboards Only)

Press Fn plusthe - | @ key to toggle the keyboard LED on/off. The keyboard LED may be configured using
the Fn + key combination outlined in the table below. In addition press Fn plusthe |- | @ key to launch the
keyboard backlight application to configure the settings (see “ LED Device Menu - Colored LED Keyboards”

on page B - 10).

Main Keyboard Colored LED Function key Combinations
Fn +& o Launch the Keyboard Backlight Application ' =" ' ] ' b‘ b‘
Fn + — ‘ 9Toggle the Keyboard Backlight LED On/Off - A ' 98; 99_ .
En + “ ‘ ® Keyboard Backlight LED Low :§: ? ?Z a_
—_— O Keyboard Backiight LED High 2132 \
Fn + :L eToggIe the Left Keyboard LED On/Off l L.n,
Fn + T @Toggle the Middle Keyboard LED On/Off Left
en + [2] @ Toggle the Right Keyboard LED On/Off

Table 1 - 2 - Main Keyboard LEDs (for llluminated Colored Keyboards Only)

1-12 Keyboard Backlight LED Device
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Keyboard Shortcuts

The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi- 4
gation/operation in Windows 10. Windows Logo

; Keyboard Shortcut
Windows Logo L
ul Koy + Description Use the Windows logo
am €Y o
key gm * D key com-
Tap Winkey Toggle the Start menu bination to switch be-
- tween the Start screen
A Open the Action Center and Windows Desktop.
B Select the Taskbar Notification Area Menu/Application
c Launch Cortana (in listening mode) Keyboard Shortcut
D Toggle the Desktop When the Desktop app
- - iS running you can use
E Launch File Explorer (Quick Access tab) the Menu/Application
+ Number (1, 2, etc) | Launch an application from the taskbar (numbered from left to right) key [E] on the key-
board to display the
Table 1 - 3 - Keyboard Shortcuts context menu as per a

mouse right-click.

Keyboard Backlight LED Device 1 - 13
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Function/Hot Key Indicators

Keys Function Function

Fn + i Play/Pause (in Audio/Video Programs) Brightness Decrease/Increase

*Fan Control Toggle
Automatic Fan Control / Full
Power / Max-Q* (*NVIDIA
video adapter dependent)

PC Camera
Power Toggle

TOUCH PAD ON

Airplane Mode

TouchPad Toggle Toggle

»- Airplane mode on
all  Airplane mode off

Turn LCD Backlight Off
(Press a key to or use TouchPad to turn on)

n

leep Toggle

NUM LOCK ON

Mute Toggle

Fn + NumLk

Number Lock

Toggle
Scroll Lock SCH LOCK DN
Volume Decrease/Increase Fn + ScrLk Toggle
[K' CAPE LOCK ON
! Caps Lock
Display Toggle Caps Lock Toggle | Rea tat

Control Center Toggle Fn + Backspace Flexikey® Enable/Disable

Fe =]

Fn + Power Button Powered USB 3.0 Port Power Toggle *Note: It is recommended that you use Maximum fan speed when playing games (use Fn + 1)

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down

Table 1 - 4 - Function & Hot Key Indicators

1 - 14 Function/Hot Key Indicators



Quick Start Guide

Control Center

When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click theicon ﬂ inthenotification area of thetaskbar to toggle the Control Center on/off. The Con-
trol Center gives quick accessto frequently used controls and enables you to quickly turn the camera/touch pad
on/off. You can aso configure the keyboard L ED Device settings from the Control Center (see Appendix B).

Y CONTROL CaENTErR 8.0 d
Q) = 4
¥ & Control Center Access
To run the Control Center

press the Fn + Esc key com-
bination, or double-click the

icon “ in the notification
area of the taskbar.

Close the Control Center by
clicking the @ close icon in
the top right of the panel.

Figure 1 - 7 - Control Center

Control Center 1 - 15
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Flexikey® Application

The Flexikey® application isaquick hotkey configuration application, which allowsyou to assign asinglekey
to launch multiple key combinations, or to launch programs and applications, to create text macr os and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey in the Control Center to launch the application (see Appendix B for full details).

C CONTROL CENTER 2.0 O ¥ \ o/
J L

Windows Key F-
Fn & P Keys

Note that you can
assign actions to
any keyboard key
except the Win-

dows key FH Fn
and P key.

Macro Keyboard

Figure 1 - 8 - Flexikey® Application

.|
1 - 16 Flexikey® Application



Quick Start Guide

Front & Left Views - Models A & C Figure 1- 9

Front & Left Views

LED Indicators
Vent/Fan  Intake/
Outlet

DC-In Jack
HDMI-Out Port
*Mini DisplayPort 1
*Mini DisplayPort 2
2*USB 3.1 Gen 2
(Type C) Ports

The USB 3.0 ports capable of 5Gbps (SuperSpeed) are classified as USB 3.1 Gen 1. 8. USB 3.0 (USB 3.1
There are three USB 3.1 Gen 1 (Type A) ports on this computer model. In addition Gen 1 - Type A)
there are two USB 3.1 Gen 2 ports (Type C) capable of 10Gbps SuperSpeed+. Type Port

C ports are the smaller sized USB ports, and the larger USB Type A ports are denoted by 9. 1 * Powered USB
their blue color. 3.0 (USB 3.1 Gen
1) Port

N

No Ok

USB Ports

Note that the USB 3.0 port is not operational under DOS and does not support wake on
USB. The powered USB 3.0 (Q) port can supply power (for charging devices only, not
for operating devices) when the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery with a capacity level above 20%
(this may not work with certain devices - see page 7 - 11). Toggle power to this port by us-
ing Fn + power button.

*MiniDisplay Ports 1.3

Front & Left Views - Models A& C1-17
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Figure 1 - 10 Front & Left Views - Model B

Front & Left Views

P

Security Lock Slot
Vent/Fan  Intake/
Outlet

DC-In Jack
HDMI-Out Port
*Mini DisplayPort 1
*Mini DisplayPort 2
2 * USB 3.1 Gen 2 U e

(Type C) Ports The USB 3.0 ports capable of 5Gbps (SuperSpeed) are classified as USB 3.1 Gen 1.
9. USB 3.0 (USB 3.1 There are three USB 3.1 Gen 1 (Type A) ports on this computer model. In addition

Gen 1 - Type A) there are two USB 3.1 Gen 2 ports (Type C) capable of 10Gbps SuperSpeed+. Type

Port C ports are the smaller sized USB ports, and the larger USB Type A ports are denoted by
10. 1 * Powered USB their blue color.

3.0 (USB 3.1 Gen

1) Port Note that the USB 3.0 port is not operational under DOS and does not support wake on
USB. The powered USB 3.0 (@) port can supply power (for charging devices only,
not for operating devices) when the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery with a capacity level above 20%
(this may not work with certain devices - see page 7 - 11). Toggle power to this port by us-
ing Fn + power button.

wn e

O N oA

*MiniDisplay Ports 1.3

1-18 Front & Left Views - Model B
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Right & Rear Views - Models A & C Figure 1 - 11

Right & Rear Views

@ 1. Microphone-In
Jack
2. 2-In-Audio Jack
(Headphone /

S/PDIF-Out Jack)
3. USB 3.0 (USB 3.1
Gen 1 - Type A)

Port
Z 4.  Multi-in-1 Card
Multi-In-1 Card Reader Reader
5. SIM Card Reader
The card reader allows you to use the most popular digital storage card formats: (for 4G SIM Cards
MMC (MultiMedia Card) / RS MMC - see page 1 - 21)
SD (Secure Digital) / Mini SD / SDHC / SDXC up to UHS-II 6. *RJ-45 LAN Jack

7. Security Lock Slot
8. Vent/Fan Intake/

\ A/
L& Outlet

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while *You will need to open

the computer is in use. the RJ-45 LAN Jack cov-
er dightly before insert-
ing aLAN cable

Right & Rear Views - Models A& C1-19
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o

Figure 1-12

Right & Rear Views

Microphone-In
Jack

2-In-Audio  Jack
(Headphone /
S/PDIF-Out Jack)
USB 3.0 (USB 3.1
Gen 1 - Type A)
Port

Multi-in-1 Card
Reader

SIM Card Reader
(for 4G USIM Cards
see over - For
Design | Only)
*RJ-45 LAN Jack
Vent/Fan Intake/
Outlet

*You will need to open
the RJ-45 LAN Jack cov-
er dightly before insert-
ing aLAN cable

Right & Rear Views - Model B

Multi-In-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC up to UHS-II

2AN\Z
/Q\

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan intake(s) while
the computer is in use.

1 - 20 Right & Rear Views - Model B



4G Module SIM Card Installation

(For Model A & Model B Design | Only)

Insert the SIM card @ asillustrated below (pay careful attention to the orientation of the card asthe gold contact
side of the card should face upwards towards the top of the computer) until it clicks fully into position. To eject
the card simply pressit until it gjects, but do not attempt to g ect the card while connected to a 4G network (see

below).

SIM Card
Orientation

Note that the SIM card’s
readable side (with the
gold-colored contacts)
should face upwards as
illustrated.

Figure 1 - 13
SIM Card Insertion

Quick Start Guide

2dNL
2§

SIM Card Ejection

Simply press on the SIM card to
eject it, however do not do this
while a connection is in prog-
ress.

If you do eject the card while a
4G connection is ongoing, you
will need to shut down the sys-
tem, reinsert the SIM card, re-
start the system and then
reestablish the 4G connection.

If you wish to change SIM cards
then you will need to shut the
system down, reinsert the SIM
card, restart the system and
then reestablish the 4G connec-
tion.

4G Module SIM Card Installation 1 - 21
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Figure 1 - 14
Bottom View

1. Vent/Fan Intake/
Outlet

2. RJ-45 LAN Jack

3. SIM Card Reader
(For Model A
Only)

4

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.

See “Battery Information”
on page 3 - 16 for full in-
structions. This model’s bat-
tery is embedded and cannot
be removed without violating
the terms of your warranty.
Contact your distributor/sup-
plier for details.

Bottom View - Models A & C

\ A/

Y/ \§
Bottom Cover Removal Warning

L&
Overheating

To prevent your com-
puter from overheating
make sure nothing

blocks the Vent/Fan

Intake while the com-
puter is in use.

Do not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may
violate the terms of your warranty.

If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please

contact your distributor/supplier for further information.

1-22 Bottom View - Models A & C
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Bottom View - Model B Figure 1 - 15

Bottom View

ﬂt 1. Vent/Fan Intake/
Overheating Outlet
2. RJ-45 LAN Jack

To prevent your com-
k y 3. SIM Card Reader

puter from overheating

make sure nothing (Design 1 Only)
blocks the Vent/Fan

Intake while the com- 4

puter is in use.

Battery Information

Always completely dis-
charge, then fully charge, a
new battery before using it.
Completely discharge and
charge the battery at least
once every 30 days or after
about 20 partial discharges.

. See “Battery Information”
Bottom Cover Removal Warning on page 3 - 16 for full in-
structions. This model’s bat-
tery is embedded and
cannot be removed without
If you need to replace/remove the hard disk/RAM/optical device etc., for any reason, please violating the terms of your

contact your distributor/supplier for further information. warranty. Contact your dis-
tributor/supplier for details.

Do not remove any cover(s) and /or screw(s) for the purposes of device upgrade as this may
violate the terms of your warranty.

Bottom View - Model B 1 - 23
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Windows 10 Start Menu

Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start
Menu by clicking theicon gg in the taskbar in the lower |eft corner of the screen (or by pressing the Windows

Logo Key 2@ on the keyboard).

4

Windows Screens

Note that the Win-
dows screens on the
following pages are
included as a basic
guide and introduc-
tion to navigating
around Windows 10.

However note that
these screens are al-
ways subject to
change, upgrade and
redesign. Check the
Microsoft website for
detalils.

Recently added
i—' OpenOffice Writer

’e" OpenOffice Base

BI OpenOffice Cale Calendar Mail
Expand

pef
& n

Instagram c
s Get Office

A
Alarms & Clock

C

-

Calendar

Camera

By :

B Candy Crush Soda Saga
™ Connect

O corena

[

0 hype nere tu tearch

We speak Gmail

OneNote  [3

Figure 1 - 16 - Windows Start Menu

1-24 Windows 10 Start Menu
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Right-Clicking the Windows Logo In Start Menu
Right-click the Start Menu gg icon (or use the Windows Logo Key g@ + X key combination) to bring up an
advanced Context M enu of useful features such as Apps and Features, Power Options, Task Manager, Search,
File Explorer, Device Manager, Computer Management and Network Connections etc.

Programs and Features
| Mobility Center

Power Options

Event Viewer

System

Device Manager

Network Connections

Disk Management

Computer Management

Command Prompt

Command Prompt (Admin)

Task Manager
Contral Panel

File Explorer

Search

Figure 1 - 17 - Right-Click Windows Logo in Start Menu

Windows 10 Start Menu 1 - 25
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Start Menu Apps & Tiles

The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not al of these apps can fit on the screen so may need click and drag the handles at the edge of
the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Calendar Mail ~]

® 0

Get Office OneNote {2

Suggested

Ictagram

Aok

(ST holter thEE-\

A
Alarms & Clock.

R Type here to search

Figure 1 - 18 - Expanding the Start Menu

. |
1-26 Windows 10 Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu

To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on aprogram’sicon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. Y ou can use the same method to pin apps/pro-
gramsto/from the taskbar (select pin to taskbar/unpin this program from the taskbar).

Open

Run with graphics processor
Open file location

!; Run as administrator
Troubleshoot compatibility
Pin to Start

Ea Scan with Windows Defender...

Pin to taskbar

Restore previous versions

Send to

Cut
Copy

Create shortcut
Delete

Rename

Properties

Recently added Create
’. OpenOffice Writer
!. OpenOffice Base We speak Gmail

1 ‘OpenOffice Calc Calendar

Expand ™

pef
& n

@ Siegecraft Defender Get Office OneNote @7
*okks

A I )
Alarms & Clock @

. ﬂ [t G| tonch of 0l

i cocuior T —
. — 58 Unpin from Start 5
[ Calendar /
Camera ®

8] Connect

B e

F

Bl rocebook

[l

New window

New InPrivate window

£ Type here to search

Figure 1 - 19 - Pin to Start/Unpin from Start

Windows 10 Start Menu 1 - 27
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Windows 10 Control Panel

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of waysin Windows 10.

» Select Control Panel
under the Windows
System item in the
Start Menu.

» Type Control Panel
into the Search box in
the taskbar and click on
the icon when it pops

up.
* You can pin the Con-

trol Panel tileto Start
or taskbar.

w 3D Preview
Create

Voice Recorder

:._’ Weather
Calendar

& 0

Get Office

B Windows Accessories

B Windows Administrative Tools

== Windows Defender Security Center

. Windows Ease of Access
. ‘Windows PowerShell
. Windows System

a

= Command Prompt
QBB Control Panel \,
P Fiie Bplorer = Pin to Start

= ron More

Store

q Task Manager R t
‘g This PC Windows Administrative Tools

X Storage Spaces

';‘ Xbox

Figure 1 - 20 - Windows 10 Control Panel Access

& & Filters
Best match.

Control Panel
Desktop app

[E1 Settings

Settings

]

= Set up USB game controllers
Change User Account Control settings
App & browser control

Connect wireless Xbox One controllers

Ea =R

Change how Marrator reads hints
for controls and buttons

@ Control the computer without the mouse
or keyboard

Search suggestions

£ control - search the web

1-28 Windows 10 Control Panel
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Settings
The Settingsitem in the Start Menu (and also as an App) gives you quick access to anumber of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Apps,

Accounts, Time & language, Gaming, Ease of Access, Privacy and Update & security.

Windows Settings

System Phaone Network & Intemet
o— m
O —
— )
Z = L AT

Personalization Apps Accounts Time & Language

M Type here to search

Figure 1 - 21 - Settings

. |
Windows 10 Control Panel 1 - 29
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Windows 10 Taskbar

In many instances throughout this manual you will see an instruction to access the notification ar ea of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
Figure 1 - 22 - Taskbar

Y ou can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “ Pining/
Unpinning Apps & Programs to/from the Start Menu” on page 1 - 27).

1 - 30 Windows 10 Control Panel
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Action Center

The Action Center appears as avertical panel on the right side of the screen when you swipe in from the right
or click the button in the notification tray. This gives you access to commonly needed functions like Network,
All Settings, Airplane Mode, and Project etc.

P OneDrive

Get to your files from anywhere

Clear all

= @ €
Connect Network All settings

i ®)

Location Quiet hours

son  Cuiethous  100% Ba Project

Lt
= r
VN

aght light

10:17 AM
Bl

Hj - g '|::|:|
. T4 10/31/2017

Figure 1 - 23 - Action Center

Windows 10 Control Panel 1 - 31
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Video Features

Y ou can switch display devices, and configure display options, from the Display settings (click the Start Menu
and click Settings > System or right-click the desktop and select Display settings) control panel (see over). In
Windows 10 it is possible to quickly configure external displays from the Project menu (press the Windows
logo key @ on your keyboard and the P key or Fn + F7).

To Configure Displays using Project
1. Attach your display to the

R . Project \ o/
appropriate port, and turn it o 7£l§
on. D .
C screen on Configuring External Displays

2. Press the 3@ + P (or Fn + = A guring play

F7) key combination. When a single external display is attached to
3. Click on any one of the : the HDMI or Display Ports, use the System (in

options from the menu to e Settings - page ) control panel or the

select PC screen only, + P (or Fn + F7 - page ) key combination,

Duplicate Extend or to configure the external display.

Second screen only. £ When multiple external displays are attached
4. You can also click Connect you should use the NVIDIA (page ) con-

to a wireless display at the trol panel to configure the external displays.

. Second screen only
bottom of the Project screen " You cannot configure external displays us-
and follow the steps to ing the Intel(R) HD Graphics control panel.

connect to any wireless
enabled display.

Figure 1 - 24 - Project (Devices)

1 - 32 Video Features



To access the Display Settings:

1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings.

2. Adjust the settings for Brightness and color, Scale and layout, Resolution and Orientation from the menus.

3.  When and external display is attached you can arrange the display configuration from the Multiple Displays
menu, and arrange the configuration from Select and rearrange displays.

4. Click Apply to save any changes made.

View > Saltis
Sort by >
H;
Refresh @ Home
Paste Find a setfing
Paste shortcut
Intel® Graphics Settings y
B NVIDIA Control Panel | @ Display
New >
[ Notifications & actions
t’l Display settings
W @) Power & sleep
= Battery
= Storage
@ Tablet mode
I Multitasking
=7 Projecting to this PC
¥ Shared experiences
@ Avout

Quick Start Guide

Display
DISpiay Select and rearrange displays
ge display
Brightness and color Select a display below to change its settings. Some settings are apphied to all displays.

Change brightness

Might light

Scale and layout

Change the size of text, apps, and other items

1007% [Recommended) |

Custom scaling

Multiple displays

Rersolution

1366 » 768 (Recommended) | Duplicate these displays

Orientation Extend these displays
Landscape | Show only on 1

Multiple displays Show only on 2

Display adapter properties
Older displays might not always connect automatically. Select

Figure 1 - 25 - Display Settings

Video Features 1 - 33
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To access the Intel(R) UHD Graphics Control Panel:

1. Right-click the desktop and select Intel(R) Graphics Settings from the menu.
OR
2. Click the icon in the notification area of the Desktop taskbar and select Intel(R) Graphics Settings from the menu.

View >
Sort by >
Refresh

Paste

Paste shortcut

Intel ® Graphics Settings )
MNVIDIA Control Panel

New >

E_:I Display settings
iﬁ Personalize

TUNE YOUR GAME FOR INTEL GRA?HICS

Better Environments. More Detailed C

Intel ® Graphics Settings

Power Options and
Support

Exit Tray

10:21 AM E‘ Display Video Gammg

S D)
= D) o312017

Figure 1 - 26 - Intel® UHD Graphics Control Panel
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To access the NVIDIA Control Pandl:

1. Right-click the desktop and select NVIDIA Control Panel 0 (Figure 1 - 27).

OR

2. Double-click the icon E 9 (Figure 1 - 27) in the Windows control panel.

3. To configure displays in Discrete mode use the NVIDIA Control Panel (see page C - 17).

) NVIDIA Control Panel - =] X
View >
File Edit Desktop 30 Settings Help
Sort by >
Q= -Q| %
Refresh
Select a Task... g it = = ~
) 3D Settings ’{se‘_ tﬁ ings with Preview
Paste - destndee
-Manage 30 setfings This page slows you to preview changes you make to the image and rendening settings, These wil be your defauit settings for your
Paste shortcut Configure Surround, PhysX hardware-accelerated 3D applications that utilize Direct 3D or OpenGL.
Performance: Preview:
‘ B NvIDIA Control Panel o
New > |
: X ity:
B3 Display settings (el
& Personalize
e Lt : * "._
O v ¢ e G > What do T look for?
Moving towards the (®)Let the 3D appiication decide
Performance side wil
increase frame rate, (O use the advanced 30 image settngs  Take me there
but curved ines wil (O Use my preference emphasizing: Quality
appesr jagzed
ol Performance Qualty
Quaity side wil improve
the smoothness you
can se= on curved nes.
Description:
[8) system Information Typical usage scenarios:
S

Figure 1 - 27 - NVIDIA Control Panel
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Power Options

Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can aso add Hiber nate/Sleep to
the menu - see page 1 - 37). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Using the Power Button

1. Go to the Start Menu.

2. Click the Power button .

3. Select the power state required from
the menu.

‘We speak Gmail

£ Type hete to search

Figure 1 - 28 - Shut Down/Restart

1 - 36 Power Options



Quick Start Guide

Y ou can also use the context menu (right-click the Start Menu gg icon or pressthe Windows logo gg + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

4

Adding Hibernate/Sleep to the Power Men

1. Go to the Power Options (Hardware and Sound) control
panel (or go to Windows Settings > Power & sleep >
Additional power settings).

2. Click Choose what the power buttons do.

3. Click “Change settings that are currently unavailable”

; By Change settings that are currently unavailable .

B 4. Click to put a check in the Hibernate/Sleep box under

Sete Shutdown settings.

e Bipores Seep 5. Click Save Changes and close the control panel.

Sraech

Figure 1 - 29 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination

You can usethe CTRL + ALT + DEL key combination to bring up a full-screen displaying L ock, Sign out,
Changeapassword, Task Manager and Switch User. If you click the Power iconin the lower right corner of
the screen a power management option menu appears to display Sleep, Hiber nate, Shut down, and Restart.

.|
Power Options 1 - 37
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Minimum Screen Resolution Settings

1. Windows 10 has minimum screen resolution requirements.
2. Right-click a blank area of the Desktop and select Display Settings.
3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

% Home Display

| Find a setting el I Night light settings

Scale and layout
System

Change the size of text, apps, and other items
I 3 Display

| 100% (Recommended) -]

L] Notifications & actions Custér Salifig

& Power & sleep Resolution
( 1920 x 1080 (Recommended) )

= Battery

1680 = 1050
—= Storage 1600 = 1200

1600 = 900
L@ Tablet mode

1440 = 900
01 Multitasking 1400 = 1050

1366 = 768
&1 Projecting to this PC

1360 = 768

MM LR S S S o o

Figure 1 - 30 - Display (Resolution)
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Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive/Solid State Drive
Multi-In-1 Card Reader

Touchpad and Buttons/Mouse
Realtek Audio Console

. |
Overview 2 - 1



Features & Components

e Hard Disk Drive/Solid State Drive

T - The hard disk drive/solid state drive is used to store your data in the computer. The
Removal Warning hard disk can be taken out to accommodate other serial (SATA) hard disk drives,
T S i h_owe'\_/er you will need to contact your distributor/supplier to do thisin _order to a\_/0|d
Sonriree o g v olating the terms of your warranty. The system can also support solid state drives
e e cle | asstorage devices (see “ Storage” on page D - 2 for specification information).

upgrade as this may vio-
late the terms of your
warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.

. |
2 - 2 Hard Disk Drive/Solid State Drive



Features & Components

Multi-In-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the Z
card into the slot and it will appear as a removable device, and can be accessed in Push-Push Card
the same way as your hard disk (s). Make sure you install the card reader driver (see Reader
“Card Reader” on page 4 - 8). The card reader fea-
. . tures a push-in/push-out
* MMC (MultiMediaCard) / RSMMC card insertion and ejec-
* SD (Secure Digital) / Mini SD / SDHC / SDXC up to UHS-1I tion mechanism. Simply

push the card to insert
and eject it, however Ms
Duo cards require an
adapter.

*Note: Some of these cards require PC adapters that are usually supplied with the cards.

- Models A& C

DEDMME o

1. Card Reader

Figure2-1
Right Side View

Multi-In-1 Card Reader 2 - 3
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Touchpad and Buttons/Mouse

The Touchpad is an alternative to the mouse; however, you can also add a mouse to

" order o . your computer through one of the USB ports. The Touchpad buttons function in

pner(;:)remrar(l) C'emif :rs \rl]z Cpeas_ much t_he same Y)/ay as atwci-button mouse. Make sureyou haveinstalled the Touch-

sary to keep the surface Pad driver (see “ Touchpad” on page 4 - 8).

clean and free of finger-

HISEEINESEE Touchpad Sensitivity

Use a soft dry cleaning The mouse button zones at the bottom of the pad measure about 15mm from the

cloth to keep the pad bottom of the pad, and theleft and right buttonsare divided roughly down the mid-

SUfface ciean dle. Press the left button zone for aleft click, and right button zone for aright click
Disabling the Pad action.

2N
/Q\

Touchpad Cleaning

Use the Fn + F1 or Con-
trol Center button to dis-
able the Touchpad.

4

Mouse Driver

. If you are using an external
Figure2- 2 mouse your operating system
Touchpad may be able to auto-configure
Sensitivity your mouse during its installa-
tion or only enable its basic
functions. Be sure to check
the device’s user documenta-

tion for details.

B e |

2 - 4 Touchpad and Buttons/Mouse
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Mouse Properties Control Panel e
. . . . 7/ \Y
Y ou can configure the functions from the M ouse control panel in Windows as fol- , ,
lows Disabling the
' Touchpad
1. Right-click the Start Menu g icon.
2. Select Control Panel. If you need to disable
3. Click Mouse (Hardware and Sound > Devices and Printers). the Touchpad for any
4. Click the menu headings tabs to adjust your mouse preferences. reason (e.g. you may

find that when using

@ Mouse Properties X the computer’s internal
keyboard you acciden-
tally trigger the Touch-
pad when resting your
wrists or palms on it)
you can do so by using
Fn + F1 key combina-
tion.

Buttons  Pointers  Pointer Options  Wheel Hardware

Button configuration
[[]switch primary and secondary buttons
Select this check box to make the button on the g

right the one you use for primary functions such as
selecting and dragging.

Double-click speed

Double-click the folder to test your setting. If the
folder does not open or close, try using a slower

setting.

Speed:  Slow ' Fast

ClickLock Figure2-3
[J Tum on ClickLock Sattings... Mouse Properties
Enables you to highlight or drag without holding down the mouse button. Contro | Pan el -
To set, briefly press the mouse button. To release, click the mouse

button again. Buttons

ST

Mouse Properties Control Panel 2 - 5
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Figure2-4
Mouse Properties
Control Panels

@ Mouse Properties

Butions  Powiers  Pomior Options  Wheol  Hardware

Schama
Winddows Dafaut (systen schoma)

Sayo As..

@ Mouse Properties

Motion

& Satoct a postor speed:

Butions  Poinisrs  Pomier Options  Wheol  Hardware

Duiete Slow ' Foast
4 Enhanca pointar pracision
Sk Snap To
Q dialog box
Help Select
Warking In Baciground o Visbikty
i o [:; [l crsplay posrnor rads
Fracision Select +
Toxt Soloct I & 1 ] tiide poiniee whis yping
H ks ET ot ti' (] Show tocation of poirar when | press the CTRIL kay
oK Cancel Apoly oK Cancel Apoly
@ Mouse Properties x @ Mouse Properties
Butions  Poinisrs  Pomior Options  Whesl  Hardware Butions Pointars  Pomior Optons  Wheal  Hardwars
Vertical Scrofing Dovicos:
o Floll the wheal ane noteh 1o scrol Hama Type
= == HID-compliant mouse Mice and othar ..
(ST foflowing.ombeof Anes 18 e @ Lognech USE WhnealMcuse. Mice and other ...
i & Synaptics SMBus TouchPad Mice and other ..
() Ora screon a1 & ime
Davico Propertios.
Honzontal Scrofing Manufaciurer;  Merosoll
s Tih the whee! 1 scroll the foliowing number of .
] et a e Location: on Synaptics HID-Compliant Touch pad Device
Davice status:  This devacs = working propsiy.
3 =
oK Cancel Apoty oK Cancel
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Mouse & Touchpad Devices

Y ou can configure the functionsfrom the M ouse or Touchpad control panelsin De-
vices in the Settings control panel as follows.
1. Click the Settings item in the Start Menu (or All Settings in the Action Center).

2. Click Devices.
3. Click Mouse or Touchpad.

n Settings SO R Settings

Windows Settings

%% Home
| Find a setting

System Devices Metwork & Internet  Personalization Devices ) Flgure 2 - 5

v, natifica Sl - aiplang mode, VEN Kactceaivid, Jock sc Windows Settlngs
58 Bluetooth & other devic > Mouse/Touchpad

gg (ﬁt\\i @ t Printers & scanners

Apps Accounts Time & language ) Gamlng )
E  Touchpad

-

Ease of Access Prl\fﬂf}' UNR‘E & ‘H’IJH')‘ Tvpl ng

A% Pen & Windows Ink

Mouse & Touchpad Devices 2 - 7
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Mouse Settings

Y ou can select the primary mouse button and scrolling options and access Mouse
Properties from Additional mouse options.

£ Home

l Find a setting

Devices

Figure2- 6 |0 voue
Windows Settings B3 Touchpad

Mouse
Typing

&) AutoPlay

A use

Bluetooth & other devices

51 Printers & scanners

% Pen & Windows Ink

Mouse
Select your primary button

Left |

Roll the mouse wheel to scroll

i Multiple lines at a time

Choaose how many lines to scroll each time

Scroll inactive windows when | hover aver them

@ on

Related settings

Additional mouse options

Have a question?
Get help

Make Windows better.

Give us feedback

2 - 8 Mouse & Touchpad Devices



Features & Components

Touchpad Settings
Y ou can disable the Touchpad by clicking the Touchpad button to turn it off.

Y ou can set the system to automatically disable the internal Touchpad when an ex-
ternal USB point device (e.g aUSB mouse) is attached. Click “L eave touchpad on
when a mouse is connected” to off.

Settings - o x

@ Home Touchpad
I Find a setting ) | Your PC has a precision touchpad.
Touchpad
Devices Q On
\
Blietoath & atherdevices < Leave touchpad on when a mouse is connected > ]
& Printers & scanners Change the cursor speed FI gure 2 - 7
a . .
O Wi | Windows Settings
Taps Touchpad
E  Touchpad
; o o (Touchpad turned off
Use taps to click, right-click, and select. Turn down the sensitivity if
Typing they activate while you're typing when mouse
% Pen & Windows Ink Touchpad sensitivity conn eCted)
Medium sensitivity
(® AutoPlay -
A use Tap with a single finger to single-click
Tap with two fingers to right-click
Tap twice and drag to multi-select
Press the lower right corner of the touchpad to right-click

Mouse & Touchpad Devices 2 - 9
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Touchapd Taps

The Touchpad Sensitivity feature hel ps prevent recognizing taps on the pad by ac-
cident, by recognizing when your palm isresting on it or brushing its surface while
you are typing.

Click in the check box to enable/disable the different gestures or taps on the surface
of the pad to perform specific actions to manipul ate documents, objects and applica-
tions.

Touchpad sensitivity
Medium sensitivity v |=———

Most sensitive

High sensitivity

Figure2-8 z i
Windows Settings Tap with a single finger to single-click SRR

Touchpad e
Sensitivity & Taps Low sensitivity

Tap with two fingers to right-click
Tap twice and drag to multi-select

Press the lower right corner of the touchpad to right-click

2 - 10 Mouse & Touchpad Devices
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Touchapd Scroll and Zoom
Click to enable/disable the two finger scrolling and pinch zooming gesture.

Scroll and zoom

Figure2-9
Drag two fingers to scroll \p\ Scroll and Zoom/
\ 1~ .
Scrolling direction \ \ \J qﬁ SCI’O”IHg Gesture

Down motion scrolls up ~

Pinch to zoom

Thetwo-finger scrolling feature worksin most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Thetwo-finger pinch to zoom gesture can be used to perform the same function as
a scroll wheel in Windows applications that support CTRL + scroll wheel zoom
functionality. Placetwo fingers on the pad (for best results use thetips of thefingers)
and slide them apart to zoom in, or closer together to zoom out.

i
\ Figure2- 10
‘ _ Zooming Gesture

\

Mouse & Touchpad Devices 2 - 11
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of different functions. Select the appropriate function from the drop-down menu.

Three-finger gestures

The three-finger and four-finger swipes and taps can be configured for a number

Nothing
Swipes

Switch apps and show desktop

Switch apps and show desktop

Switch desktops and show desktop

Fi gure 2-11 T Multitasking view Change audio and volume
Three-Finger 4 Showdeskiop
Gestures Nothing
(Swipes & Taps) & Sentchapes Search with Cortana
> Switch apps Action Center
Taps Play/pause W

Search with C v ) ' |
Middle mouse button R—- ] \
)/

Four-finger gestures o
Nathing
Swipes
Switch apps and show desktop
Switch desktops and show deskiop
Switch desktops and show desktop

T Multitasking view Change audio and volume

4 Show desktop

i Mothing
Figure2-12 e
. th Cortana
FO u T-FI n g er € Switch desktops earch wr
GeStU res =»  Switch desktops AcHon Ceten
(SWipes & Taps) Taps Play/pause
[ Action Center ~ | Middle mouse button
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Realtek Audio Console

Y ou can configure the audio options on your computer from the Sound - control
panel in Windows, or from the Realtek Audio Console Windows Start menu.
Make sure you have installed the driver and checked the Microsoft Store for Thesoulr_‘dkyo'“m? 'e‘f'
updates (see “ Audio” on page 4 - 9). The volume may also be adjusted by means Sﬁﬂjmeecc'gn't?gl Li':c')r;‘gt 2
of the volume icon in the taskbar or the audio dlider in the Settings menu (see | in the notification area

sidebar). of the taskbar.

Create Play

4

Volume Adjustment

More ways

We speak Yahoo to play. Join
us!

@

| Paint 3D

Calendar

~]
People = . §
e | =m
Photos r u
x

= [MINECRWFY

Get Off OneNote @3 Soli P i -
. Realtek Audio Console 2 = it — Flgure 2 13
' AU el Realtek Audio
Explore - ]
y i, Console
] e il (Windows Start
ﬁ T Menu)

Settings

Microsoft Store

Skype

Sound Blaster Connect

Sticky Notes

Realtek Audio Console 2 - 13
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Realtek Audio Console - Main

Y ou can adjust the Speaker and Microphone levels by using the slidersin the Re-
altek Audio Console Main window.

Reaitek Audio Console = a =
. | A Main Playback Devices
Flgure 2 - 14 | Speakers =
Realtek Audio Playback Devices S — O muee (83
Console W) Speskers
(Main) Recording Devices
rding Devices
Q/ Microphone Microphone AN
= D Mute Q

ﬁ' Device advanced settings
B Power Management

o Information

2 - 14 Realtek Audio Console



Features & Components

Realtek Audio Console - Speakers 5
Click Speakersto access controls for the format and speaker balance etc.

Reattek Audio Console O *

A Main Main Volume
Balance

§ OmMute 1—Ff—nr

Playback Device: Flgurez = 15
Realtek Audio

W Speakers Default Format
; Select the sample rate and bit depth to be used when running in shared mode. CO nso I e
ding Devices
| 48000Hz 2a8Bits | Resat (Speakers)

&  Microphone
Speaker Configuration
..........

Full-range Speakers

Front left and right

H B

':} Device advanced settings
W) Power Management

o Information

Realtek Audio Console 2 - 15
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Realtek Audio Console - Microphone

Click Microphone to access advanced controls for recording on the microphone.
Adjust the recording Main Volume level to around 60, to obtain the optimum re-
cording quality. The On-Screen menu which appears will depend on whether or not

you have enabled Cortana,

Figure2 - 16
Realtek Audio i
Console odn
(Microphone -
Cortana Enabled) @ speaers
& Mioophone

L} Device advanced settings
B} Power Management

© information

2 - 16 Realtek Audio Console

Main Volume

S

Microphone Boost

D Mute
|“ +20 dB ]

Microphone Effects

® anoit O uni-Directional O omni-Directional
= —
O Enhance Voice Recognition (O High Quality Record
|
—
e

"D

Default Format

Saelect the sample rate and bit depth to be used when running in shared mode.

| 48000Hz 168its Reset
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[T — = 0 %

W Main Main Volume

3 [ e

Microphone Boost

i Speakers [+z0a8 |

Microphone Effects Fl gUI'e 2 - 17

Noise suppression reduces ambient stationary naises, |.e. Motebook PC fan, air candition fan nalse, thus improving speech intelligibility and Real t e k A u d | (0]
rediscing listenes fatigue.

& on Console

Beam forming enhances the voice signal inside the beam while suppressing noise outside the beam. (M | Cro p h one -

@ on Cortana Disabled)

AEC removes the acoustic echo coupled int the microphanes fram the loudspeaker output thu air.

@ on

& Microphane

Default Format
Select the sample fate and bit depth to be used when rnning in shared made.

48000Hz 168its Reset

£} Device advanced settings
& Power Management

@ information
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Realtek Audio Console - Device Advanced Settings

\ A/
ZAS Device Advanced Settings alows for further configuration of the Connector Set-
Device Advanced tings, Playback Device and Recording Device.
Settin gs Fealtek Audio Console - g x

For the purposes of re- A Main Connector Settings
cording it is recommend- Disable front panel popup dialog
ed that you enable Playback Devices @D of
“Separate all input 4 Speakers
jacks as independent Connector Retasking...
input devices” in De- R oxcias ANALOG
vice advanced settings. & Microphone

This will help prevent a
situation where the inter-
nal microphone seems to

Playback Device

be dlsabled! or Where @ Mute the internal output device, when an extemnal headphone plugged in,

SOUnd can St|” be heard O Make internal and external output devices playback two different audio streams simultaneously.
from the speakers even
though the headphones Recording Device

are plugged into the O Tie up same type of input jacks, i.e. line-in or microphone, as an input device,
head phone jaCk. (® separate all input jacks as independent input devices.

Figure2- 18 e
Realtek Audio
Console - Device
Advanced Settings © information

B Power Management

2 - 18 Realtek Audio Console
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Chapter 3. Power Management >
Overview OS Note 3
Power management .

To conserve power, especially when using the battery, your computer power man- functions will vary slight-
agement conserves power by controlling individual components of the computer | |y gepending on your
(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.

» The Power Sources

* Turning On the Computer

» Power Plans

» Power-Saving States

» Configuring the Power Buttons
» Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OSto set devicesinto low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
If the system “hangs”,

Useonly the AC/DC adapter that comeswith your computer. Thewrong type of AC/
and the Ctrl + Alt + Del . .
key combination doesrt | DC adapter will damage the computer and its components.

work, press the power 1. When first setting up the computer use the following procedure (as to safe-

button for 4 seconds, or guard the computer during shipping, the battery will be locked to not power the

longer, to force the sys- system until first connected to the AC/DC adapter and initially set up as below):

12 19 (L D2 Gl . Attach the AC/DC adapter cord to the DC-In jack on the left of the computer, then plug
the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter
and leave it therefor 6 secondsor longer.

. Remove the adapter cord from the computer’s DC-1n jack, and then plug it back in again;
the battery will now be unlocked.

2. Raise the lid/LCD to a comfortable viewing angle.

3. Press the power button to turn “On”.

4

Forced Off

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet isunavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely beforerecharging (see “ Battery FAQ” on page 3 - 21).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “ Battery Information” on page 3 - 16.

3 - 2 The Power Sources
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Turning On the Computer

Now you are ready to begin using your computer. To turnit on simply pressthe pow-

er button on the front panel.
When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use

Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.

4

Power Button as Stand by or Hibernate Button

You can use the OS's “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).

Turning On the Computer 3 - 3
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Shutting the Computer Down

Note that you should always shut your computer down by choosing the Shut down
command asthiswill help prevent hard disk or system problems. Use the Power
item in the Start M enu and select Shut down.

Y ou can also use the context menu (right-click the Start Menu &g icon or pressthe
Windows logo gg@ + X key combination) to Sign out, Sleep, Hibernate, Shut
down, and Restart.

If you want to add Hibernate/Sleep to the Power Menu see “ Adding Hibernate/
Sleep to the Power Menu” on page 3 - 10.

Figure3-1
Shut Down/Restart

3 - 4 Shutting the Computer Down
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Power Plans

The computer can be configured to conserve power by means of power plans (Con-
trol Panel > Power Options). Y ou can use (or modify) an existing power plan, or
create a new one.

4

Resuming
Operation

See Table3 - 1, on
page 3 - 11 for informa-
tion on how to resume

f L .
Click Change plan settings and then click Change advanced power settings to ac- ;;?;_ a powersaiing

cess further configuration optionsin Advanced Settings.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity.

Password

Change setting

Choose the seep i

@ Power Options % x
Advanced sesings

\ Select the power plan that you want to customize,
; and then ¢

tings that reflect how you want
Your computer 1o manage power

Balanced [Active] it

Balanced >
= Require a password on wakeup
On banerny: ves -
Plurpeged in: Vi
il Hard disk
£ Internat Explorar
4+ Deskiop background settings
il Wireless Adapter Settings
4 Sleep

Bestore plan defaults

Gonc

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure3-2
Power Plan
Advanced Settings

Power Plans 3 - 5
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. Thisisworth bearing in mind if you are experiencing
any reduced performance (especialy under DC/battery power).

Choose High perfor mance (you may need to click Show additional plansto view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

‘% Power Options = O X
« v N "® > Control Panel > All Control Panel ltems > Power Options v O | Search Control Pane| P
FI gure 3 - 3 Cl | Ck to OW/H I de S LD Choose or customize a power plan
Power Pl ans wdl tl Onal Require a password on wakeup A power plan is a collection of hardware and system settings (like display brightness, sleep, etc) that
OWer I ans manages how your computer uses power. Tell me more about power plans
p p Whmagewhat the power
buttons do Plans shown on the battery meter
Choose what closing the lid WPPaiae Battery Change plan settings
does
Create a power plan (O Power saver Change plan settings
k! Choose when to turn off the Saves energy by reducing your computer's perforiiaMmghere possible,
display
® Change when the computer Show additional plans
sleeps
See also
Personalization
Windows Mobility Center
User Accounts Screen brightness: @ '

3 - 6 Power Plans



Power-Saving States

Y ou can use power-saving states to stop the computer’ s operation and restart where
you left off. Windows 10 uses the Sleep, Hiber nate and Shut Down power-saving
states.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last | eft
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.

.|
Power-Saving States 3 - 7
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Wake On LAN
Support

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows.

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
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Figure3-4
Power Button &
Start Menu Power

Hibernate

Hiber nate uses the least amount of power of al the power-saving states and saves
al of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last |eft off within seconds. Y ou should
put your mobile PC into Hiber nate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hiber nate to the
Power Menu see “ Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down

Y ou should Shut down the computer if you plan to install new hardware, plan to be
away from the computer for several days, or you do not need it to wake up and run
ascheduled task. Returning to full operation from Shut down takeslonger than from
Sleep or Hibernate.

Task Manager

Sleep

Settings Sign out

Hibernate

File Explorer i
Shut down E e

Search Hibernate
Restart

Run Shut down

n Facebook

o

Shut down or sign out SEE

Desktop

£ Type here to search
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Configuring the Power Buttons

The power/sleep button (Fn + F12 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttonsdo on
the left menu in Power Optionsto bring up the menu.

& System Settings

“ « T ‘@ « Al Control Panel ltems » Power Options »

page apply to all of your power plans.
& Change settings that are currently unavailable

Power and sleep buttons and lid settings

I On battery
@ When | press the power bulton: | Sleep
@ When | press thee sleep button: Sleep
-
,‘ When | clase the lic: Sleep

Password protection on wakeup

(@) Require a password (recommended)
‘When your computer wakes from sleep,
password to unlock the computer. Crea

() Don't require a password

locked.

Shutdown settings

Turn nn fact etartun lreenmmendedl

System Settings

Define power buttons and turn on password protection

Choose the power settings that you want for your computer. The changes you make to the settings on this

AF Plugged in
Sleep
Sleep

Sleep v

ata without entering the comect
count password

When your computer wakes from sleep, anyone can access your data because the computer isnl

Cancel

Power Management

4

Password
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure3-5
Power Options
Define Power
Buttons

Configuring the Power Buttons 3 - 9
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Figure3-6
Power Options
Define Power
Buttons - Shutdown
Settings

Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Slegp to the Power Menu as follows.

agpNE

Go to the Power Options (Hardware and Sound) control panel.

Click “Change settings that are currently unavailable” @ change settings that ar= currently unsvsilsble .
Click Choose what the power buttons do.

Click to put a check in the Hibernate/Sleep box under Shutdown settings.

Click Save Changes and close the control panel.

o

Shutdown settings

Turn on fast startup (
This helps start your PC

Sleep
Show in Power menu.

Hibernate
Show in Power menu.

Lock
Show in account picturn

3 - 10 Configuring the Power Buttons
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Resuming Operation

Y ou can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F12 key combo).

Power Status Icon D-/() Color To Resume
Table3-1
Power Off Off Press the Power Button Resuming
Press the Power Button Operation
Sleep Blinking Green Press the Sleep Button (Fn + F12 Key
Combo)
Off (battery)
Hibernate Press the Power Button
Orange (AC/DC adapter)
Display Turned Off Green Press a Key or Move the Mouse/Touchpad

4

Power Button

4

Closing the Lid
When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Configuring the Power Buttons 3 - 11
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Ctrl + Alt + Delete Key Combination

YoucanusetheCTRL + ALT + DEL key combination from almost any of the Win-

dows 10 interfaces/Apps to bring up a full-screen displaying L ock, Switch User,
Sign out, Change a password and Task Manager options. If you click the Power

icon in the lower right corner of the screen a power management option menu ap-

pearsto display Sleep, Shut down, and Restart.

Figure3-7
Ctrl + Alt + Delete
Menu

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

3 - 12 Configuring the Power Buttons



Power Management

Settings Menu Power Controls

The Settingsitem in the Start Menu (or viathe Action Center) givesyou accessto

anumber of power settings control panelswhich enable you to quickly adjust power
options. Click System to access the menu including the power option settings.

— —
B Calculator Setings

Calendar i .
Windows Settings
Camera

[l Connect

Settings O Cortana

= i S
System _ Devices Fhone MNetwork & Intemet
Figure3-8
Settings
= R <
4 = AT
Apps Accounts Time & Language

Personalization

Settings Menu Power Controls 3 - 13
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Figure3-9
Settings > Battery
Saver

Battery Saver

Battery in Settings will display the battery level, and by clicking Battery usage by
app you can see the current state of battery usage by application etc. The Battery
saver can be level can be adjusted to be turned on if the battery level falls below a
certain level to limit background activity and push notifications.

- Settings [m]
& Home Battery
| Find a setting | Overview
95%
L1 Display Battery usage by app
[J Motifications & actions

™ Power & sleep
l T Battery
= Storage
3 Tablet mode
O Multitasking
&1 Projecting to this PC

> Shared experiences

o

Remole Desklop

@ About

Battery notifications

Ne notifications for battery life right now

ery saver

Extend battery life by limiting background activity and push
notifications when your device is low on battery.

E Turn battery saver on aulematically it my battery falls below:

] 20%

Lower screen brightness while in battery saver

3 - 14 Settings Menu Power Controls
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Power & Sleep
Power & sleep gives you quick access to Screen and Sleep settings. Click Addi-
tional power settingsto go to the main power options control panel.

@ Home Power & sleep
| Find a setling | Screen
On battery power, turn off after
s 5 minutes .
0 Display

Motifications & actions

When plugged in, turn off after

10 minutes |

I & Power &sleep
= gattery Sleep
On battery power, PC goes to sheep after
= Storage .
15 minutes |
C&  Tablet mode
‘When plugged In, PC goes to sleep after 1 _
0 Multitasking FI gure 3 10

Projecting to this PC

¥ Shared experiences

Remote Desktop

About

I 30 minutes |

Related settings
‘: Additional power settings

Have a question?

Get help

Settings > Power &
Sleep

Settings Menu Power Controls 3 - 15




Power Management

4

Power Slider

The Power Slider (click
the battery icon in

the notification area) lets
you trade performance
Vs battery life, by
choose the power mode
you want (see over).

Figure3- 11
Battery Icon
(Notification Area) &
Battery Advanced
Settings

Battery Information

Follow these simple guidelines to get the best use out of your battery.

Battery Power

Y our computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. Y ou can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3-3o0n page3-6).

Click the battery icon in the notification areato see the current battery level and
charge status. You can also adjust the Power Slider towards Best battery life or
Best performance, or click Battery Settingsto quickly adjust battery settings).

() 100% Fully charged

Power mode (plugged in): Better performance

Balanced [Active]

3 - 16 Battery Information
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Power Slider Settings

4

Battery Saver

Better Best

Battery Saver Better Battery Performance Performance

Note that some Win-
dows features and back-
ground applications may
behave differently, or
may be blocked, when
the system is in Battery
For DC Only For AC & DC Saver mode (check with
Microsoft for details).

i} 5% =} 94%

n cle {on battery): Battery saver Pk attery): Better battery

m 93%

de (on battery): Best performance

Slightly Favors

Lower Power than Favors Performance

Lowest Power Setting Default Settings Performance Over Over Power
Power
, Table3- 2

Windows Features .

Throttled & Screen Default Position Power Slider
Brightness Reduced Settings & Notes

Auto Enabled at 20% of
Battery Capacity
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Conserving Battery Power

Z » Useapower plan that conserves power (e.g Power saver), however note that
Windows Mobility this may have an affect on computer performance.
Center

The Windows Mobility

* Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

Center control panel . . .
provides an easy ppoim * Reduce the amount of time before the display is turned off.
of access for information .

on battery status, power
plans used and wireless

not being used.

device status etc. .
ExpressCards etc.
ﬁg Windows Mobility Center
Display A

&] brightness ~ =-"})‘ [ Mute

(| ]

Brightness Volume
.Figure 3 - 12 :J;jﬂs[f:rcm i @iy Notpresenting

Windows Mobility
Center Sync settings Turn on
(Control Panel) , :

Sync Center Presentation Settings

Close wireless, Bluetooth, modem or communication applications when they are

Disconnect/remove any unnecessary external devices e.g. USB devices,

= X
Fully charged No display
ﬁ.ﬂ (100%) connected
Balanced w Connect display

Battery Status External Display

)
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improveits performance, fully discharge and recharge the battery at least
once every 30 days. We recommend that you do not remove the battery yourself.

New Battery

Always completely discharge, then fully charge, a new battery (see “ Battery FAQ”
on page 3 - 21 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hoursto fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery chargetimeisless. Refer to “ LED Indica-
tors’ on page 1l - 9 for information on the battery charge status, and to “ Battery
FAQ” on page 3 - 21 for more information on how to maintain and properly re-
charge the battery pack.

.|
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Proper handling of the Battery Pack

ﬂ‘ * DO NOT disassemble the battery pack under any circumstances
Caution * DO NOT expose the battery to fire or high temperatures, it may explode

5 o * DO NOT connect the metal terminals (+, -) to each other
anger of explosion if

battery is incorrectly re-
placed.

2NZ
2L &

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to alow battery. Don't

turn off the computer even if amessage indicates the battery iscritically low, just let
the computer use up al of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

- W

& Eda Pan Sethng

T & = Fower Opbons * Edit Plan Seftings

Change settings for the plan: Discharge Battery
Chooue the sheep and Gaplay SeTings Thal you WEnT FouUr OOMgeDer 10 Ui
i On hasiery A Pugged in FI gure 3 - 13
Power Plan Create
i Tum oft the daplay Mewrr Mesaer
! PUl The compater 10 sleenc | Newly [iTE ]
" J '

Adjunt plas brightness

Battery Information 3 - 21



Power Management

3. Click Change plan settings (after creating it) and click Change plan settings >
Change advanced power settings.

F Fower Optians = [n] X

- « T '@ v Control Fanst 3 centrod Faned ¥ tions v {)
1 Control Paned » All Costrol Panel tems » Power Opti p
A POWES [E30 15 3 CONSCTION OF RATWAre ana syssem
Control Panel Home N MARMOES hova your EOMPUTEr Lses power, Tal me

2 QISAY OOGRINESS, Si8ep, #9c.)
DO ROWE! DR

Plians showen on The battery meter
Fequire a password on wikeup
# Discharge Batt { i ’
(hoose what the power i Cinchane Ratiory - ’
buttons do

) Fower saver Cha

Choose what ciosing the id T
does Sawes energy by reducing your compuler's performance whese possible.

Create & power plan
Hide additional plans

FI gure 3 _ 14 = E\:c: when 1o tum off the 5 e PR
Ch an g e Plan , Change when the computer Autceatically balances with enargy t ihie hardware.
sieepy
. ") High pertormance hange plan sEhngs
Settings / Change ‘ ik ek b s

Advanced Power Fesonaiziton .

. Windows Mobiity Center Sereen brightness © '
Settings
@ £ Pan Settings a "
- « T W = Power Opticns + Edit Plan Settings v . p

Change settings for the plan: Discharge Battery

Choous the seen and daplay SeT1ings TR You WaNE YUl COMPUtE 15 k.

i On bastery 4 Puggeain
I Tum ot the daptay. Hewes < Newr
W Putthe computer o sieep:  Never ¥ Never
Adjust plas brightress 0 v o ]

C_ —
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

38 Power Options ? X

Advanced settings

= Select the power plan that you want to customize,
; and then choose settings that reflect how you want
your computer to manage power.

Discharge Battery [Active] w
Plugged in: _Do nothing ~
= Low battery level H
On battery: 0% Flgure 3 - 15
Plugged in: 0% Power Options

(= Critical battery level

On battery: 1% Advanced Settings -
Plugged in: 1% Battery
[ Low battery notification
= Low battery action
On battery: Do nothing
Plugged in: Do nothing

T Darnnsn bnttans Laeal

Restore plan defaults

* Low battery levels= 0%

» Critical battery Levels=1%

» Low battery action = Do Nothing

» Critical battery action (On battery) = Shut Down
 Critical battery action (Plugged in) = Do Nothing
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How do | fully chargethe battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Chapter 4: Drivers & Utilities

This chapter dealswith installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won't be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities.

What to Install

You will need to attach an external optical CD/DVD devicedriveto install the
driversfrom the Device Drivers & Utilities + User’s Manual disc. The disc con-
tains the drivers and utilities necessary for the proper operation of the computer. Ta-
ble4 - 1, on page 4 - 4 lists what you need to install and it is very important that
thedriversareinstalled by the method outlined in thischapter, and in the or der
indicated. Note that the information on the following pagesis for Windows 10 (64-
bit only).

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth & WLAN
Combo, Intel Technology, Sound Blaster and 4G modules are provided in “ Mod-
ules’ on page6 - 1.

. |
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Drivers & Utilities

\ 7/
L&
Driver Installation &
Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
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Driver Installation

Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click the message “Tap to choose what happens with this disc.”

Click Run autorun.exe.
Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

PN

() Drivers Installer — *

Figure4 - 1- Drivers Installer Screen 1
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order)
which is the same as that listed in the Drivers Installer menu below.

Click to select the driver you wish to install, (you should note down the drivers as you install them).

Follow the instructions for each individual driver installation procedure as listed on the following pages.

N o

9 Drivers Installer = X

Please follow steps from top to
bottom in order to install drivers.

Figure4 - 2 - Install Drivers
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Win 10 (64-bit) Page # Win 10 (64-bit) - Optional Items Page #
Chipset Page 4 -7 | Setting Up SATA Mode (Optane™ or AHCI) Page 6 - 2
Intel Video (VGA) Page 4 -7 | Wireless LAN Module Page 6 - 10
NVIDIA Video (VGA) | Page 4 -7 | Fingerprint Reader Module (Model A, Model B Design | & Model C) | Page 6 - 15
NVIDIA Apps Page 4 -8 | Bluetooth & WLAN Combo Module Page 6 - 19
LAN Page 4 -8 | Sound Blaster Audio Page 6 - 25
Card Reader Page 4 -8 | Intel® Software Guard Extensions Driver Page 6 - 37
Touchpad Page 4 -8 | Intel® Speed Shift Technology Driver Page 6 - 38

i Intel® Rapid Storage Technology i
Control Center Page 4-8 (required for hard disks in AHCI & Optane modes) Page 6 - 39
Int.el® HID Filter Page 4 -8 | PC Camera Page 6 - 46
Driver
MEI Driver Page 4 -9 | Trusted Platform Module (no driver installation required) Page 6 - 52
Audio Page 4-9 g(;sl\i/lgondlt;le (no driver installation required for Model A & Model B Page 6 - 58

All drivers provided are for the Windows 10 (64-bit) operating system.
Note that you need to install both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
Table4 - 1 - Driver Installation
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Manual Driver Installation

Click Browse CD/DVD (button) inthe Driversinstall-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update

After installing all the drivers make sure you enable
Check for updates (Settings > Update & security >
Check for updates) in order to get al the latest secu-
rity updatesetc. (all updateswill includethe latest hot-
fixes from Microsoft). See “Windows Update” on
page 4 - 10 for instructions.

Drivers & Utilities

Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs icon (Programs > Unin-
stall a program). Click to select the driver (if it is not
listed see below) and click Uninstall, and then follow
the on screen prompts (it may be necessary to restart
the computer). Reinstall the driver as outlined in this
chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go tothe Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Devices and Printers > Device
Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+” to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.
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User Account Control

If aUser Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow theinstallation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

Y ou will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
aready received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the install ation proce-
dure.

4 - 6 Driver Installation

4

Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.
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Driver Installation Procedure NVIDIA Video (VGA)

Insert the Device Drivers & Utilities+ User’'sManual 1. Click 3.Install NVIDIA VGA Driver > Yes.
disc and click Install Drivers (button). 2. Click AGREE AND CONTINUE (button) to
_ accept the terms of the license agreement.

Chipset 3. Click Next.
Note: During thedriver installation processthescreen 4. After all the drivers have been installed (an
resolution may change. Make sureyou restart after the internet connection is required) run the

driver installation process, as instructed, in order to

resiare the original resolution, NVIDIA GeForce Experience by clicking the

desktop icon kg (or App).
1. Click 1Linstall Chipset Driver > Yes. 5. Restart thecomputer and run the application
2. Click Next > Accept > Install. again after restart.

3. Click Restart Now to restart the computer. _ _ _ _ )
Note: After installing the video driver go to the Dis-

Intel Video (VGA) play/Display Settings control panel to adjust the vid-

1. Click 2.Install Intel VGA Driver > Yes. €0 settingsto the highest resolution.
2. Click Next > Yes> Next > Next.
3. Click Finish to restart the computer.

|
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NVIDIA Apps

1. Click 4.Install NVIDIA Apps> Yes.

2. Click AGREE AND CONTINUE (button) to
accept the terms of the license agreement.

3. Click Next.

4. Click Closeto complete the installation.

LAN

Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the systemand re-
install the LAN driver.

1. Click 5.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader

1. Click 6.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad

1. Click 7.Install Touchpad Driver > Yes.

2. Click OK.

3. Click Restart Now (the prompt will appear
after a few seconds) to restart your computer.

Control Center

1. Click 8.Install Control Center AP > Yes.
2. Click Next > Install.

3. Click Finish to restart your computer.

Intel® HID Filter Driver

Click 9.Install HID Filter Driver > Yes.
Click Next.

Click Yesto accept the license.

Click Next.

Click Finish to restart the computer.

gk owDdNE
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MEI Driver

1
2.
3.

4.
5.

Click 10.Install MEI Driver > Yes.

Click Next.

Click the check box to accept the license and
then click Next.

Click Next.

Click Finish.

Audio

1.

2.
3.
4

~N

Click 11.Install Audio Driver > Yes.

Click Next.

Click Finish to restart the computer.

Realtek Audio Control Panel will download
but you will need to have aworking internet
connection.

Click the Start menu in Windows to access the
Microsoft Store App tile under Explore.
Click the Sign in icon &, and select Down-
loads and updates.

Click Check for Updates.

A list of apps being downloaded will pop-up.

Drivers & Utilities

9. To prioritize the Realtek audio driver you can
click Pause all to pause the download queue.
10. Click on Realtek Audio Control and click on

theresumeicon O to download the driver.
11. When just installed the Realtek Audio Con-
sole will appear in the Windows Start menu.

After installing the audio driver the system will not re-
turn to the Drivers Installer screen. To install any of
the optional drivers, gject the Device Drivers & Utili-
ties+ User’s Manual disc and then reinsert it (or dou-
ble-click the disc icon in My Computer), and click
Option Drivers (button) to access the optional driver
menu.

It is recommended that you install the Sound Blaster
Audio application (see “Sound Blaster Audio” on
page 6 - 25) and Intel Rapid Storage Technology
driver (see “Intel® Rapid Storage Technology” on
page 6 - 39 - required for AHCI & RAID mode).
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4 - 10 Driver Installation

e
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

Go to the Control Panel.

Click Windows Update (System and Security/
Security).

Click Check for updates (button).

The computer will now check for updates (you
need to be connected to the internet).

Click Install now (button) to begin checking for the
updates.

Click Install updates (button) to install the
updates.
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Optional Drivers

See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option.

) Drivers Installer — x

o 1.\/.10b1_|e (_/m__'s iputingy

Please follow steps from top to
bottom in order to install Option
drivers.

Figure4 - 3 - Optional Drivers Installer Screen
Notethat you need toinstall both the WLAN & Bluetooth driversfor the WLAN & Bluetooth Combo modules.
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Chapter 5: BIOS Utilities "

Overview BIOS Screens

This chapter gives a brief introduction to the computer’ s built-in software: i e e B
screens  pictured on

. these pages are intend-
If your computer has never been set up, or you are making important changesto the BESEERIREREE IRE

system (e.g. hard disk setup), then you should review this chapter first and note the B FSEeNIE S R
original settings found in Setup. Even if you are abeginner, keep arecord of the set-  JHEISES
tings you find and any changes you make. This information could be useful if your

- BIOS versions are sub-
system ever needs servicing. ject to constant change

and revision, therefore
Thereis one general rule: Don’t make any changes unless you are sure of what you VSISl lE]

. . . : screens may appear
aredoing. Many of the settings are required by the system, and changing them could slightly _ different _from

cause it to become unstable or worse. If you have any doubts, consult your service  BEFSEE IS T
representative. pages.

. |
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BIOS Settings
Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Opti-
mized Defaults with
<F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.

The Setup Utility

Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

Asthe POST proceeds, the computer will tell you if thereisanything wrong. If there
isaproblem that prevents the system from booting, it will display asystem summary
and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can't get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot L ogo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a*“Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is aready on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.

5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST . There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
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4

Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer's menus will
indicate the configura-
tion appropriate for your
model and options.

Figure5-1
Navigation Menu

Setup Screens

The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
esto Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up aGeneral Help screen, and then use
the arrow keys to scroll up or down the page.

Theltem Specific Help on the upper right side of each screen explainsthe highlight-
ed item and has useful messages about its options.

If you see an arrow p next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.
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Main Menu

Aptio Setup UDtility — Copyright (C) 2018 American Megatrends Inc.

Figure5-2
System Date Ma'n Menu

SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of devices on the

computer’s SATA Ports.

. |
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System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @2 = midnight; 13 = 1 pm). If you
can change the date and time settingsin your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

SystenVExtended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

MB Series/ BIOSRevision / KBC/EC firmware Revision / MAC Address
This item contains information on the BIOS version, network adapter address etc.,
and is not user configurable.

5 - 6 Main Menu
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Advanced Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

Figure5- 3
Advanced Menu

p Advanced chipset Control

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enable/disable FlexiCharger, Software Guard
Extensions, VT-d and Fast Boot (see page 5 - 9).
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Intel® Optane™

Intel® Optane™ is a combi-
nation of a compatible
memory device and Intel
Rapid Technology soft-
ware. This combination is
designed to speed up your
system performance.

Contact your distributor or
supplier to see if your sys-
tem supports this technolo-
ay.
SATA Mode
Selection

If you have installed the
Windows OS with either
AHCI or Intel RST (Op-
tane) mode enabled, DO
NOT disable the set mode
(if you wish to disable the
set mode you will need to
reinstall the Windows OS).

SATA Mode (Advanced Menu)

The SATA (Serial ATA) control is configured to operatein AHCI (Advanced Host
Controller Interface) mode or in Intel RST Premium With Intel Optane System
Acceleration (for Intel® Optane™) mode.

The SATA M ode should be set BEFORE installing an oper ating system, and after
you have backed up all necessary files and data (see sidebar). See“ Setting Up SATA
Mode (Optane™ or AHCI)” on page 6 - 2 for details. Make sure you install the I n-
tel Rapid Storage Technology application if you have set the SATA Modeto I ntel
RST Premium..., or to AHCI (see“IRST Driver Installation” on page 6 - 39).

If you wish to change your SATA mode to/from AHCI/Intel RST (Optane) mode
note that doing so may prevent your operating system from booting, and may require
areinstall of the OS. If you do wish to change the SATA mode then backup any nec-
essary dataon your hard disk(s) asyou will need wipethe disksclean in order to pre-
vent system problems.

Note I ntel® Optane™ is available for Model A & Model B Design | Only.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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FlexiCharger Enable (Advanced Menu > Advanced Chipset Control) N

/
The sub-menu here allows you to enabl e/disable the FlexiChar ger . The FlexiCharg- ﬂ‘
er may be set to automatically start charging your battery when the battery reaches FlexiCharger
acertain capacity level (e.g. you could start the battery charge level at 40%). Warning
You can then set the level to stop charging (e.g. 100%), and of course this stop BRIV e D06 F
charge level must be higher then the start charge level. arger continuously "En-

abled” for a period of
Seethesidebar warningfor information on runningtheFlexiCharger for an ex- BAEEREGEREE o
tended period asthisisnot recommended. the battery meter's read-
ing accuracy will deteri-

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc. orate

To reset this, set the
FlexiCharger to "Dis-
abled", and then allow
the battery to completely
discharge (see

FlexicCharger

before enabling the
function again.

FlexiCharger
Enabled
Disabled

Figure5-4
Advanced Chipset
Control >
FlexiCharger
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Software Guard Extensions (Advanced Menu > Advanced Chipset Control)
Intel provides SGX, which isaset of instructions allowing user-level code adegree
of security, and privacy, from the operating system. Make sure that SW Guard Ex-
tensions is Enabled here, and then install the driver (see “ Intel® Software Guard
Extensions Driver” on page 6 - 37) to support this.

VT-d (Advanced Menu > Advanced Chipset Control)

Enable/disable Intel® Virtualization Technology for Directed 1/0 (VT-d) from
this menu. This extends Intel's Virtualization Technology (VT) by providing hard-
ware assists for a virtualization solution.

Fast Boot (Advanced Menu > Advanced Chipset Control)
Enabling this function will boot the system with the minimum set of devices re-
quired in order to so in order to achieve afaster boot time.

. |
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Security Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

4

Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Secure Boolt [Enabled]

Secure Boolt
Disabled
Enabled

Figure5-5
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).
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N2
2

Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled), NEVER
forget your password.

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)

Y ou can set a password for user mode access to the Aptio Setup Utility. Thiswill
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode.

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)

Specify whether or not apassword should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is“ Disabled”.

.|
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Secure Boot Control (Security Menu)

Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot is available as a menu option if you have
enabled UEFI Boot (see“ UEFI Boot (Boot Menu)” on page 5 - 16). Enabling Se-
cure Boot will bring up the Secur e Boot M ode menu to enable you to configure Se-
cure Boot as Standard (with a fixed secure boot policy) or Customized (which
enables you to make changes to the Key M anagement database if required).

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

P Restore Factory Keys

BIOS Utilities

Figure5-6
Security -
Secure Boot
(Key Management)

Security Menu 5 - 13




BIOS Utilities

TPM Configuration (Security Menu - with UEFI Enabled)

a This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support. Press Enter to accessthe Security Device Support menu and select Enable
to support TPM aslong as UEFI Boot isenabled (see* Trusted Platform Module”
on page 6 - 52 for details).

TPM Menu Item
Settings

You will need to check
with your IT administra-
tor for the actual TPM
settings required within
your organization.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Security Device Support

Figure5-7
Security Device
Support

.|
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Boot Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

Figure5-8
Boot Menu

Boot Option #1 [Windows Boot Manager

(PO: WDC
WD5000IPCX-22VHATO) ]

SN
ALK

BIOS Screens

Note that the BIOS
screens  pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore

S . your computer's actual
When you turn the computer on it will look for an operating system (e.g. Windows TS TR Cpeey

7) from the devices listed in this menu, and in this priority order. If it cannot find ~ EESFRRIENHAEAEE T
the operating system on that device, it will try to load it from the next device in the B GEEETREEL R NG
order specified in the Boot Option Priorities. Item specific help on the right is §EEESE

available to help you move devices up and down the order.
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Boot Option Priorities (Boot Menu)

Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)

Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack will be enabled as an option under
UEFI Boot.
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Exit Menu

Aptio Setup Utility — Copyright (C) 2018 American Megatrends Inc.

Figure5-9
Exit Menu

Save Changes and Reset

Click Save Changes and Reset to save al changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. Y ou can also choose to restore the original Setup defaults that will re-
turn the Setup to itsoriginal state, and erase any previous changes you have madein
aprevious session.
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Chapter 6: Modules & Options 7

N

Y/

i Wireless Device
OverVIGW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, depending on the configuration purchased. If you are unsure please RS EEA T
contact your service representative. electronic transmission
» Setting Up SATA Mode (Optane™ or AHCI) iev'ﬁiﬁaﬁ§’°a§fo§ﬁﬁﬂ
* WirelessLAN Module Make sure the WLAN &
» Fingerprint Reader Module Bluetooth  module(s)
* Bluetooth & WLAN Combo Module are OFF (or the system

. is in Airplane Mode) if
* Sound Blaster Audio you are using the com-
* Intel® Software Guard Extensions Driver puter aboard aircraft
* Intel® Speed Shift Technology Driver (see
+ Intel® Rapid Storage Technology )-

 PC Camera
e Trusted Platform Module
4G Module

Overview 6 - 1
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SATA Mode
Selection

The SATA mode selec-
tion should be made be-
fore installing your
operating system.

DO NOT change your
selected SATA mode
unless you intend to re-
install your operating
system. Make sure you
have backed up all your
data before doing so.

See

Setting Up SATA Mode (Optane™ or AHCI)

AHCI Mode

Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). Make sure you in-
stall the Intel® Rapid Storage Technology application to support your HDDg/
SSDsin AHCI mode (see “ Intel® Rapid Storage Technology” on page 6 - 39).

Intel® Optane™ (For Model A & Model B Design | Only)

Intel® Optane™ isacombination of acompatible memory device and I ntel Rapid
Technology software. This combination is designed to speed up your system per-
formance by caching boot data, executables, frequently accessed data and system
page files to an non volatile, low latency Intel® Optane™ SSD.

Contact your distributor or supplier to seeif your system supports this technology.

Intel® Rapid Storage Technology Application

Make sure you install the Intel® Rapid Storage Technology application if you
have set up your system in Intel RST Premium (for Intel® Optane™) mode (see
“Intel® Rapid Storage Technology” on page 6 - 39).

After setting the SATA modeto Intel® Optane™ and installing the I ntel® Rapid
Storage Technology application, DO NOT uninstall the Intel® Rapid Storage
Technology application.

6 - 2 Setting Up SATA Mode (Optane™ or AHCI)
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Intel® Optane™ Setup Procedure

Afterinitial setup make sureyouinstall thelntel Rapid Storage Technology driver
- see“|RST Driver Installation” on page 6 - 39).

See also “ Clearing I ntel® Optane™” on page 6 - 7 (however backup up any neces-
sary filesand data befor edeleting an Optane setup, asdoing so will result intheloss
of al data on the volumes).

Y ou need to setup Intele Optane™ before installing your Windows 10 operating
system, and you will need to prepare the following in order to do so.

* The Microsoft Windows 10 OS DVD.

» An attached external DVD drive.

* AnIntel® Optane™ SSD installed in your system.

* TheDevice Drivers & Utilities + User’'s Manual disc.

Start-up your notebook computer and press <F2> to enter the BIOS.

Go to the Boot menu, select UEFI Setting and press <Enter> (see page 5 - 15).
Set UEFI Boot to “Enabled”.

Press <Esc> to exit the menu and go to the Main menu.

Select OffBoard NVMe Controller Configuration and press enter to check that
an Intel® Optane™ SSD is present.

Press <Esc> to exit the menu and go to the Advanced menu.

aprwNE

o
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Figure6-1
SATA Mode
Selection (BIOS)

Figure6- 2
Intel(R) Rapid
Storage Technology
(Advanced Menu)

7. Select SATA Mode (see page 5 - 8), press <Enter> and select “Intel RST
Premium With Intel Optane System Acceleration”.

SATA Mode:

AHCTI Mode

Intel RST Premium With Intel Optane System Acceleration

8. Press <F4> and <Yes> to “Save Changes and Reset".

9. As the computer restarts press <F2> to enter the BIOS again.

10. Go to Intel(R) Rapid Storage Technology (Advanced menu) and press <Enter>.

11. . (Note this item only appears after you have restarted and accessed the BIOS
again after having set SATA Mode to Intel RST Premium....)

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

p PCIe 1.0 INTEL MEMPEKIW016GA FUBT704300GR0O16D, 13.4GB

12. If you are reinstalling a system that has previously been setup in Intel RST
Premium mode, make sure you have cleared the Intel Optane Memory (see
“Clearing Intel® Optane™” on page 6 - 7).
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13. Press <F4> and <Yes> to “Save Changes and Reset”, however ensure that the
condition in the bulleted point below is met before doing so. ﬁ

» Make sure the Windows 10 OSDVD isin the attached DV D drive, as the com-
puter starts up it will automatically boot from the Windows 10 OS DVD (you

Creating a Windows
Partition for Optane

will be prompted to press a key to boot from the DVD).

When installing Win-

14. Press <F7> as the computer starts up to bring up the boot device menu. dows, make sure that
15. Select the DVD drive containing the Windows 10 OS DVD and press <Enter>. you leave a minimum of
16. Press a key at system startup to begin installing Windows from your Microsoft 5MB  of unallocated
. . space for the Intel® Op-
Windows 10 disc.
. . . . . tane™ software to cre-
17. Click Next > Install Now to continue installing the operating system as normal
. o . . . ate needed metadata.
(see your Windows documentation if you need help on installing the Windows
0S). After you have created a
18. Select Custom: Install Windows only (advanced). Windows partition the
19. Itis recommended that you select and then delete existing partitions. Windows Setup screen
20. Click New to create a partition for Windows. will display the partitions
21. Itis very important to make sure that when you create the partition, to leave at and”5|zes,d|nclud|ng|]f tEe
least a minimum of unallocated space of 5MB (see sidebar). unallocated space. Ifthe
. . . . . unallocated space is
22. Follow the on-screen instructions to install the Windows 10 operating system. less than 5MB. then de-
23. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual B0 e parti{ions —
disc as per Table 4 - 1, on page 4 - 4 (make sure you install the Intel Rapid recreate them until the
Storage Technology driver - see overleaf). criteria is met.
24. Run the Intel® Rapid Storage Technology application to manage your Intel®

Optane™ system as instructed in “Intel® Rapid Storage Technology for
Optane Systems” on page 6 - 40.

Note this is 5MB only,
not GB.

Setting Up SATA Mode (Optane™ or AHCI) 6 - 5
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25. After installing the Intel® Rapid Storage Technology application you can access
Device Manager (right-click the Start menu and select Device Manager).
26. Click Disk drives to check the Optane drive.

& Device Manager

File Action View Help
e M0 B B XE
v & DESKTOP-EFITHGK ~
» By Audio inputs and outputs
i Batteries
Figure6- 3 & Computer

~ am Disk drives

Device Manager s NVMe INTEL MEMPEKTWO1

(Disk drives) = STS00LT012-1DG142

[ Display adapters

B Firmware

¥l Human Interface Devices

== Imaging devices

= Keyboards

L1 Memory technology devices
» “ Mice and other pointing devices

3 Monitors

& Network adapters

A Print queues

D Processors

B Security devices

B software devices

.|
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Clearing Intel® Optane™

If you wish to clear an existing Intel® Optane™ setup then follow the procedure be-
low to do so. However backup up any necessary files and data before clearing an
Intel® Optane™ setup, as doing so will result in the loss of all data on the volumes.

1. Make sure that Intel® Optane™ is Enabled in the Intel® Rapid Storage Tech-
nology application.

2. Start-up your computer and press <F2> to enter the BIOS.

3. GotoIntel(R) Rapid Storage Technology (in the Advanced menu) and press
<Enter>.

4. Select Intel Optane, **** (listed under Optane Volume:) and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Figure6- 4
Intel(R) Rapid
Storage Technology
(Advanced Menu)

p Intel Optane, ***kkiid

.|
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5. Select “Deconcatentate” and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

p Deconcatentate

Figure6-5
Intel(R) Rapid
Storage Technology
(Deconcatentate)

6. Select Yes from the “Are you sure you want to perform deconcatentation”
option.
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7. Select “Start deconcatentation” and press <Enter>.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Are you sure you want to perform
deconcatenation?

Figure6-6
Intel(R) Rapid
Storage Technology
(Start
Deconcatentation)

8. The system will return to the standard Intel(R) Rapid Storage Technology menu
when complete (see Figure 6 - 2 on page 6 - 4).

9. You should then select the appropriate SATA Mode for your system and reinstall
the OS.

.|
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Wireless LAN Module

e If your purchase option includes a Combination WirelessL AN & Bluetooth mod-
Operation Aboard ule (either Intel® or Qualcomm Ather os) then install the driver for the appropriate
Aircraft modul e as instructed below.

SN
ALK

WCEE A EE IRl Make sure that the moduleis on (i.e. the system is not in Air plane M ode) beforein-

electronic transmission stalling the driver
devices aboard aircraft )

SR CSEDECLEIEEE M ake sure you ingtall the drivers in the order indicated in Table 4 - 1, on page 4 - 4.
Make sure the WLAN &

SRR EEEIEORE  Note that you need to install both the WLAN & Bluetooth drivers for the WLAN

A EERER Y & Bluetooth Combo modules.
the computer aboard

aircraft by putting the
system in to Airplane
Mode (see

).

6 - 10 Wireless LAN Module



Modules & Options

Intel® WLAN Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and theninsert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

CIickliln the check box to agree to the End User License Agreement and click
Install.

Click Finish.
The operating system is the default setting for Wireless LAN control in

Windows (see page 6 - 12).

OO AWN

Qualcomm Atheros WLAN Combo Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into the DVD drive.

Click Option Drivers (button).

Click 1.Install WLAN Driver > Yes.

Select the language preferred and click Next.

Click Next > Next.

Click in the check box to accept to the License Agreement and click Next.
Click Finish.

Click Yesto restart the computer.

The operating system is the default setting for Wireless LAN control in
Windows (see page 6 - 12).

©oOoNOUA~WN

. |
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WLAN Configuration in Windows 10

Y ou can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

1
2.
3.
4

Figure6-7
WiFi & Network
Connections

Click the Wireless icon u in the notification area of the taskbar.

Make sure that Airplane mode is off (the Airplane mode icon should be gray).
A list of available access points will appear.

Double-click an access point to connect to it (or click it and click Connect).

RD114
'
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Enter a network security key (password) if required, and click Next.

You can choose to share or connect to devices or not.

When you are connected to the network access point it will display Connected
SIS Connected )

Select any connected network and click Disconnect [[EEeauaad to disconnect
from a connected access point.

\ A/
Z &
Wireless Device
Operation Aboard Aircraft

Disconnect

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited.

Figure6- 8
Network Connected
(Click Disconnect)

Make sure the module is either OFF or
in Airplane mode if you are using the
computer aboard aircraft.
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9. You can click the Airplane Mode button to turn the mode On or Off.

10. You need to either use Airplane Mode, or turn the WLAN module off aboard
aircraft.

11. Network & Internet in Windows Settings will bring up a more comprehensive list
of network and internet settings including Wi-Fi (can be turned on/off), Airplane

mode (Airplane mode and Wireless devices can be turned on/off) VPN, Dial-up,
Ethernet and Proxy.

© home Wi-Fi
o, e | Wi-Fi
o @ o
8 s o
. ] o T ithemet
FI gure 6 = 9 Hb it WAy pincows Cetiar Ll Wi-Fi services
Network & Internet A -
Settings o
& Data usage
@ B oy

Network & Internet O on
Wi-Fi, airplane mode, VPN 2
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Fingerprint Reader Module

(For Model A, Model B Design | & Model C Only)

The fingerprint reader module provides a high level of security for your computer.
Make sure you have administrator’ s rights to your computer, and have a Windows
password enabled for full security protection.

There are two different fingerprint modules supplied with this model. Install the
driver fromthe Device Drivers & Utilities+ User’sManual disc by following the
appropriate instructions on the page overleaf.

The fingerprint reader module uses the Sign-in options configuration of the Win-
dows Account.

Modules & Options

Fingerprint Reader

and Power Saving
States

If your computer is in a
power saving state (e.g.
Hibernate or Sleep) you

should keep your finger
clear of the fingerprint
sensor.

Allow the system to fully
resume before swiping
your finger across the
sensor.
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Fingerprint Reader Driver Installation

1. Makesurethesystemisnot in Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into the DVD drive.

Click Option Drivers.

Click 2.Install Fingerprint Driver > Yes.

Click the check box to accept the license terms and then click I nstall.
Click Finish to complete the installation.

Thefingerprint reader modul e uses the Sign-in options configuration of the
Windows Account (see overleaf).

Ok wWN

.|
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Fingerprint Module Configuration WA
1. Click the Settings item in the Start Menu and then click Accounts and click Sign- ’Ll‘

in options. PIN Code
2. You will need to add a Windows password (click Add under Password). You will be asked to add
3. After you have added the password you will need to also add a PIN. a PIN code when setting
4. Under Windows Hello click Set up under Fingerprint. up the Fingerprint Read-
5.

The wizard will then guide you through the set up process to scan your fingerprints. er. This is in addition to
; your windows pass-
word.

Require sign-in

Note this code as it may
be required to help you
sign-in if there are any

A
Pe 1
1 you've been away, when shoukd Windows require you 1o sign in again?

Family & other users

s o ey * issues with using the fin-
Syne your settings q o -
Password J gerprint reader to sign-in
Chnge your sccount password (see
Change
PIN )
You can use this PIN ta sign in to Windows. apps, and
Change: | fargot my PN
Swipe the same finger on the fingerprint
Windows Hello reader. .
Wil nesedd 10 scan your fingerprint a few times 1o set up Flgure 6 = 10

Sign in to Windows, apps and services using Windows Hello,

Accounts - Sign-in
® e options

(Add Fingerprint)

Picture password

Sign in 10 Windows using a tavosite photo
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6. You will be instructed to swipe the same finger across the reader a number of
times (this may be in excess of 20 times).

7. Try to present different parts of your finger in different positions (similar to the
various positions you may use when using it, and if you see red at any point try a
different position).

8. Click Close when complete.

9. You can choose to Add another finger (this is recommended) or Remove the
current fingerprint reading.

10. You can now scan your fingerprint to log-on to the computer.

\ A/
L&
Fingerprint Sign-In Issues

If at the Windows Hello screen, the Fingerprint reader fails to recognize the fingerprint
3 times it will then block access to the computer.

In this case you will need to use your PIN (the PIN you used when initially setting up the
fingerprint reader) to access the computer. Alternatively you can sign-in using your win-
dows password.

After using the PIN code (or windows Password) to access the computer you can go to the
Settings > Accounts > Sign-in options if you wish to change any settings.
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Bluetooth & WLAN Combo Module -~
If your purchase option includes aCombination WirelessL AN & Bluetooth mod- Wirelelss ;evice
ule (either Intel® or Qualcomm Ather os) then install the driver for the appropriate OperatibnAboard

module as instructed below. Aircraft

Make sure that the module ison (i.e. the system isnot in Airplane Mode) beforein- SRy A sl iE bl

stalling the driver electronic  transmission
' devices aboard aircraft

is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see

4

Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported

in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.

).

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.
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Intel Bluetooth Combo Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and then insert the Device
Drivers & Utilities + User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next > Next.

Click in the check box to accept the license and click Next.

Select the setup type (Typical is recommended) and click Install.

Click Finish.

See “ Bluetooth Configuration in Windows” on page 6 - 21 for configura-
tion instructions.

ONOOUAWDN

Qualcomm Atheros Bluetooth Combo Driver Installation

1. Makesurethesystemisnotin Airplane Mode, and then insert the Device
Drivers & Utilities+ User’s Manual disc into an attached DVD drive.
Click Option Drivers (button).

Click 3.Install Combo BT Driver > Yes.

Click Next > Next.

Click Install.

Click Finish.

Click Yesto restart the computer.

See “ Bluetooth Configuration in Windows” on page 6 - 21 for configura-
tion instructions.

ONOOUAWN

. |
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Bluetooth Configuration in Windows

1. Go to the Settings control panel and click Devices (or click the Bluetooth icon
in the taskbar and click Add a Bluetooth Device).

2. Click Bluetooth & other devices and make sure Bluetooth is On.

3. Click Add Bluetooth or other device > Bluetooth (Add a device) and a list of
discovered devices will appear.

- Add a Bluetooth Device
D Home Bluetooth & other devices : 3 -
R Allow a Device to Connect Figure 6-11

Show Bluetooth Devices Settings > Bluetooth
Send 2 File & Other Devices

Now discoverable xs “DESKTOR-HTASCEU" : ) (Add a Bluetooth

Mouse, keyboard, & pen Receive a File DeVICG)

@ USE Optical Moisse

Join a Personal Area Network

Other devices

o M Storage Device Open Settings

Remove lcon

Add a device

Add a device

Choose the kind of device you want to add. Fl gure 6 = 12
Add a Device

* Bluetooth
Mice, keyboards, pens, or other kinds of Bluetooth devices

Bluetooth & WLAN Combo Module 6 - 21



Modules & Options

4. Double-click the device you want to pair with the computer and click Connect, if

the PIN matches that on the device to which you wish to connect (you may
need to click paid on the device).

Add a device

Add a device
Make sure your device is turned on and discoverable. Select a device below to
Figure6 - 13 connect. i device

b Bluetooth Connect D PHonc Add a device

Make sure your device is turned on and discoverable. Select a device below to
connect

E;l U_NB

NBENO

Cancel
Add a device
Unknown device

Your device is ready to go!

Unknown device

_ Disconnect
Unknown device
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5. Select a device and click Remove Device Remove device

any device (click Yes to confirm).

@

Home

I Find a setting

2

|

=

Devices

Bluetooth & other devices

Printers & scanners

Mouse

Touchpad

Typing

Pen & Windows Ink

AutoPlay

usBe

Bluetooth & other devices

+ Add Bluetooth or other device

Bluetooth
@ on

Now discoverable as "DESKTOP-H7ABCBU"

Mouse, keyboard, & pen
o USB Optical Mouse

Other devices

Mass Storage Device

[z}

iPhane
Connected

Remove device

] Download over metered connections

Tn heln nrevent syira charnes kessn thic nff sn devies snftwars

to disconnect from

Modules & Options

Figure6- 14
Bluetooth Remove
Device
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To Make your Computer Discoverable to Bluetooth Devices

1. Go to the Settings control panel and click Devices (or click the Bluetooth icon

in the taskbar and click Open Settings).

Click Bluetooth & other devices and click More Bluetooth options.

3. InBluetooth Settings make sure that Allow Bluetooth devices to find this PC
check box (Discovery) has a check inside it.

4. Make sure that the Alert me when a new Bluetooth device wants to connect
check box (Notifications) has a check inside it, if you want to be notified when a
Bluetooth device wants to connect.

ettings = L b

n

| O Bluetooth Sertings *
& Home Bluetooth & other devices
] I_I Lownload cver metered Connections
d a setting F =

|

| Options COM Ports  Hardwars
-J Discovery

ad [FliAllow Bluetooth devices 1o find this PC

L Bluetooth devices will see the name of this PC.

L | etooth & other devices .
i Bluetooth & other devices Related settings

5 and printers ‘ Natifications

& Printers & scanners Devie
F - 6 15 [] Alert me when a new Bluetooth device wanis to connect
I Ure = Sound settings
g 0 Mause e
B I u e'[OOth Set“ n g S o Teudivad Display settings [ Show the Bluetoath icon in the potification area
[ouchp:
B Typing

LY

= Pen & Windows Ink

() AutoPlay

B Have a question?
1 USB |
Get hedp

Bestore Defaults

Make Windows better. | [ ]| conen Boply
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Sound Blaster Audio

Install the Sound Blaster AP to allow you to configure the audio settings to your
requirements for the best performance in games, music and movies.

Sound Blaster X® Pro-Gaming 360° Audio AP Installation

1. Insert the Device Drivers & Utilities + User’'s Manual disc an attached
DVD drive.

2. Click Option Drivers (button).

3. Click 4.1nstall Sound Blaster AP > Yes.

4. Click OK and the system will automatically restart to complete the driver
installation process.

5. Sound Blaster Connect App will download but you will need to have a
working internet connection.

6. Click the Sart menu in Windows to access the Microsoft Store App tile

under Explore.

7. ClicktheSigninicon &, and select Downloads and updates. _
8. Click Check for Updates. 5'9%98? - t16r
9. A Iist_ of_e_lpps being downloaded will pOp-up. . Ouc()nn ei‘:’ ©
10. To prioritize the Sound Blaster Connect driver you can click Pause all to (Taskbar
pause the download queue. Notification Area
Icon)

. |
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11. Click on Sound Blaster Connect and click on the resumeicon ¢ to down-
load the driver.

12. When just installed the Sound Blaster Connect will appear in the Win-
dows Sart menu.
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Sound Blaster Connect Application
Run the Sound Blaster Connect control panel from the Start menu in Windows.

Play
More ways
Paid Wi-Fi & Cellular We speak Yahoo to play. Join
.
' Paint 3D
Calendar ~] s -
Peopie . § q Figure6- 17
Photos " Sy =l ¢ § Sound Blaster
o —_— J Connect
Mo  Get Office OneNote [ Solitai n (W| ndows Start
. | Realtek Audio Console 2 -
New Menu)

Explore

Microsoft Store Microsoft Edge

Settings

§ Sound Blaster Connect i 8 -
e ;! R l

CES
,* ‘ly t L fa) XBOX LIVE
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R Sound Blaster Connect
ZAS The Sound Blaster Connect BLASTER X EXPERIEINCE home Dashboard con-
Setup for External tains anumber of preset audio configurations for your use. Y ou can create your own
Speakers/Headphones - gy brary settings by clicking the plusiconin Library [ . Click the Out-

WERRIERISSEEIEEERIEE]  put icon to select Headphones or Speakers.
balanced when connecting

to external speakers/head- ©)Click to expand
phones then select a pre-
exisitng setting under Blast-
er Experience e.g Neutral,
and test if the balance
achieved is better.

It is recommended that you
experiment with different
settings in order to achieve
the best result, and you can
adjust any of the settings.

Click on the dotted symbol
to the right of the Library
settings and select Revert
to return to the default set-
tings.

Ky
=
s
0
R
o
*
.4
&
e
A

Figure6- 18
Sound Blaster
Connect
(Dashboard)
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Sound Blaster Connect - Sound

The Sound page allows you to adjust the Per sonal settings for Reality 3D, Equal-
izer, Acoustic Engine, Scout M ode and Environment.

Sound Blaster Cinema 3 Reality 3D allows you to enable 5.1/71 surround sound
for headphones or speakers for Music, Movie or Games (click the button to turn it

SOUND
Figure6- 19
Sound Blaster
Connect Sound
(Reality 3D)

EQUALIZER ACQUSTIC ENGINE SCOUT MODE ENVIRONMENT

. |
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The Equalizer allows you to manually adjust the Custom settings (click On to en-
able the Equalizer).

Figure6 - 20
Sound Blaster
Connect Sound

(Equalizer)
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The Acoustic Engine offers a suite of playback technologies to enhance sound.
Each playback technology has an On/Off button to allow you to enable/disable it,
and most controls feature adial to adjust the levels.

Figure6 - 21 a
Sound Blaster
Connect Sound
(Acoustic Engine)

* Surround: Provides virtual sound channels to control the level of immersion.

» Crystalizer: Enriches audio to make it sound livelier.

* Bass: Enhances the bass level of the sound system.

e Smart Volume: Minimizes sudden volume changes to avoid the need for con-
stant adjustment.

» Dialog Plus: Optimizes dialogue levels for movies etc.
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Sound Blaster Connect - Scout Mode
Click on the power button to enable Scout M ode to enhance your ability to hear en-
emies in games from a further distance away than would normally be possible.

Figure6 - 22
Sound Blaster (} Dashboard SOUND
Connect Sound

b (Scout Mode) REALITY 2D EQUALIZER ACOUSTIC ENGINE

Scout Mode
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Sound Blaster Connect - Environment
These profiles add a sense of realism to the gaming experience.

Sound Blaster Connect

Figure6 - 23
Sound Blaster
Connect Sound

(Environment) a
A ©

Racing

EQUALIZER STIC ENGINE

FPS RPG

Recording Studic Cinema Grand Hall
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Sound Blaster Connect - Voice Morph
These profiles allow you to alter your voice in gaming or online chats.

Figure6- 24
Sound Blaster
Connect Voice
(Voice Morph)
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Sound Blaster Connect - Setup
Setup at the bottom left of the screen contains 2 headings (Speaker and Calibra-
tion) which allow you to select the appropriate type of speakers or headphones for
your system, and to adjust their calibration.

Figure6 - 25
Sound Blaster
-~ WG T Connect Setup
(Speaker &
Calibration)

. |
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Sound Blaster Connect - Settings

Settings at the bottom left of the screen allows you to set the language and distance

preferences and to check for the latest application updates. Click Reset in Recovery
to return to the factory default settlings.

Figure 6 - 26
Sound Blaster
Connect

b (Settings > General)
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Intel® Software Guard Extensions Driver

Install the Intel® Software Guard Extensions Driver which provides a set of in-
structions allowing user-level code a degree of security, and privacy, from the oper-
ating system. Make sure that SW Guard Extensions is Enabled in the BIOS
beforeinstalling thedriver (see” Software Guard Extensions (Advanced Menu >
Advanced Chipset Control)” on page5 - 10).

Intel SGX Driver Installation

1. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached
DVD drive.

Click Option Drivers (button).

Click 5.Install SGX Driver > Yes.

Click Next.

Click Finish to complete the installation.

agbrwd

. |
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Intel® Speed Shift Technology Driver

Install the Intel® Speed Shift Technology driver as outlined below. Speed Shift
Technology allows operating system to hand off some or all control of the handing
P-states are voltage-fre- |  of the computer’ s* P-States to the processor. This has a couple of noticeabl e benefits

quency pairs thatsetthe | responsiveness and the reduction of power consumption.
speed and power con-

iggﬂo“ of the copro- | gpeed Shift Technology Driver Installation
' 1. Insert the Device Drivers & Utilities+ User’s Manual disc into an attached
DVD drive.

4

*P-States

When the operating volt-
age of the processor is

lower, so is the power | 2. Click Option Drivers (button).
consumption. 3. Click 6.Install Speed Shift Driver > Yes.
4. When the“Isthis package from a source you trust?’ message pops-up click
“Yes, add it”.
5. Thiswill complete the installation procedure.

.|
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Intel® Rapid Storage Technology e
IRST and M.2 PCl-e
SSDs

The Intel® Rapid Storage Technology driver supports your AHCI mode SATA
drive, or your Intel® Optane™ system. Install the Intel Rapid Storage Technolo-
gy application (after installing all necessary driversin the correct order) to support
your Optane system or SATA driveif set upin AHCI modeinthe BIOS (see“ SA- AR UEE I CR Tl
TA Mode (Advanced Menu)” on page5 - 8). Storage _Technology

does not support M.2
. . SSDs with a PCl-e In-
IRST Driver Installation terface (M.2 SSDs with

a SATA Interface are

1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached supported).

DVD drive.

Click Option Drivers (button).

Click 7.Install IRST Driver > Yes.

Click Next.

Click in the check box to accept the license and click Next.

Click Next > Next > Next.

Click Finish to restart the computer.

Run the Intel® Rapid Storage Technology app from the Apps screen.

After setting the SATA modeto Intel® Optane™ and installing the Intel® Rapid
Storage Technology application, DO NOT uninstall the Intel® Rapid Storage
Technology application.

N>R~ WN
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Figure6 - 27
Intel® Rapid
Storage Technology
Status

Intel® Rapid Storage Technology for Optane Systems

Intel® Rapid Storage Technology application displays status information on your
Intel® Optane™ configuration. Run the Intel® Rapid Storage Technology appli-
cation from theitem in the Start menu.

When the Intel® Rapid Storage Technology application is launched the system
will open the Status window. Here you can view the general health of the storage
system. Various volume creation and management options are available depending
on the system’ s status.

@ Intel® Rapid Storage Technolagy = o

«/ Current Status Storage System View [3)

o W SATA disk (466 GB) (System)
o i

r PCle 55D (13 68)
Gl .

Intel® Optane™ Memory

Intel® Optane™ memory status: disabled. Enable

.|
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Enabling Intel® Optane™

1. Runthe Intel® Rapid Storage Technology application.
2. Click Enable.

¥ Intel® Rapid Storage Technology - o *

“. Manage ' ntel® Qptane™ Memory Fcrlurm.\ri. Help ‘ @ FlgUI’e 6 = 28
[

Preferences

_ IRST - Intel®
 Current Status Storage Sstem View ({) Optane™ Memory

Yowur systern & functioning normaly, o ; _:;_.::1“. 1466 GBI} [Systerm (En ab | e)
Manage

PCle 550 (13 GB)
) o
G 13c8

Click e any elernent in the s1crage system view 1 Manage its properties.
00 The Windows* write-cache butfier flushing policy can be enabied for al RAID arvay deives to ensure data integeity or disabled to
impircve data performance. Click the Melp icon for more information on seting the write-cache buffer flushing policy based on

your needs. =

i g Mmory. ‘ Enable

3. The system will pop-up a message and ask you to select a compatible fast drive
(in this case there should only be one option).

Enable Intel ® Optane™ memary -

Select a compatible fast drive:

PCle 550 on Controller 3, Port 0 {13 GB) - Flgure 6 = 29
Lﬁ::’:::-‘:cn Controlier 0, Port 0 (466 GB) (system] | RST - Intel ®
Enable Optane™

0 After Intel ® Optane™ memory (s enabled, please restan your PC before perfarming any partition or formatting MEI no I‘y
Operaions.

0 Ensure that the PC is connected o an AC power source during this process.

1, This process will take some time and may negatively impact system performance. All data on the fast
drive will be erased. Do you want to enable Intel ® Optane™ memory now?

Mate help e m
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Figure6 - 30
Device Manager
(Disk drives)

oo

You will need to restart the computer after enabling Optane, and make sure the
system is powered by the powered AC/DC adapter, and not by battery only.

Click Yes to begin the process (this may take some time).
After the process has been completed restart the computer.

After restarting can access Device Manager (right-click the Start menu and select

Device Manager).

Click Disk drives to check that the drive should read Intel Optane ******,

'.".j Device Manager
File Action View Help

& = = HE B

v % DESKTOP-EFITHGK

iy Audio inputs and outputs
E Batteries
L4 Computer

“ um Disk drives

(= Intel Optane+466GBSSD )

L&l Display adapters
i Firmware
¥l Human Interface Devices

:]‘; Imaging devices
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9. Runthe Intel® Rapid Storage Technology application to check the status.

43" Intel® Rapid Storage Technology

= o %
Intel® Qptane™ Memory Parformance I Breferences Help | intel
+/ Current Status Storage System View (&)
Your systern is functioning normally, Intel® Optane™ Memory Array -
- e
Click on any element in the storage system view to manage its properties. Q w 466 GB m‘mﬂ‘l H-,'.w' A CHie
10 The Windows* write-cache buffer flushing policy can be enabled for all RAID array drives to ensure data w 13GB 46568 i -
integrity or disabled to improve data performance. Click the Help icon for more information on setting the = FI gur e 6 31
write-cache buffer flushing policy based on your nwdsq\ IRST - Inte|®
Intel® Optane’™ Memory Optane™ Memory
Intel® Optane™ memory status: enabled. Disabie (En ab | ed)
Intel® Optane™ Memory
Intel® Optane™ memory status: enabled. Disable
More help on this page
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Disabling Intel® Optane™

\ A/
'Ll\ If you need to disable Intel® Optane™ for any reason follow these instructions.

Disabling Intel®
Optane™

1. Runthe Intel® Rapid Storage Technology application.
2. Click Disable.

Dlsable Intel® OptaneTM & Intel® Rapid Storage Technology = a x
if you want to reinstall/

reset the system or up- Intel® Optane™ Memory | Performance | Preferences ‘ Help intel
date the IRST driver.
See also “/ Current Status Storage System View O
Your system fs functioning narmally. Intel ® Optane™ Memary Array
e L2
CIIck G iy elernein In thi stonge Systir view to ransge its properties 22 @ w6 Irﬂ::mo;:n;;mwm“iym
, O sl dnesse s i s sy i esson || (epe——
Fi gur e6-32 wiite-cache buffer flushing policy based on your needs. &
IRST - Intel® intel® Optane™ |t ne™ Memory
Optane™ Memory Yol® Cea ‘ﬂ'a\ :
(Disable) Intel® Optane™ memory stati:=? ble

3. Click Yes when the message pops up.

Intel® Rapid Storage Technology ‘

Disabling Intel® Optane™ memory will take some time and negatively impact system performance. No data will be
lost during this process. Do you want to disable Intel ® Optane™ memory now?

Figure6 - 33
IRST - Yes to
Disable More help Yes No
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Restart the computer to complete the process.

\ A/

Run the Intel® Rapid Storage Technology application. 2§

HDDs & Intel®
Optane™ SSDs

The Status of Intel® Optane™ Memory is indicated in the Window.
To enable Intel® Optane™ Memory follow the process indicated in “Enabling
Intel® Optane™” on page 6 - 41.

Note that if your sys-
tem’s HDD or Intel®
Bmfernnces| Help ‘ (intel) Optane™ SSD is to be

transferred to another

& Intel® Rapid Storage Technology - o b

Intel® Optane™ Memary J Parformance

system for use for any

=/ Current Status Storage System View (@) .
o reason, you will need
Your system is functioning normally. SATA disk (466 GE) (Systemi) o
. P s to disable Intel® Op-
nage

e P50 1368 tane™ in IRST first.
13GB

n
Click on any element in the storage system view to manage its properties. (3

Removal of any cov-

{0 The Windows* write-cache buffer flushing policy can be enabled for all RAID array drives to ensure data integrity or disabled to

Kmﬂ::;}gﬁmme. Click the Help icon for mare information on setting the write-cache buffer flushing policy based on e r(s) and /Or SCfeW(S)
violates the terms of
A Ouate?. Memory your warranty.

Intel® Optane™ memory status: disabled. Enable

Intel® Optane™ Memory
Intel ® Optane™ memory status: disabled. Enable Fi gure 6-34
IRST - Intel®
Optane™ Memory
(Status)
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PC Camera

When the PC Camera application is run the LED indicator to the left of the camera
will beilluminated (see @ Figure1- 2 on pagel- 6). Note that you need to use the
Camera app in Windows to take pictures and capture video. Usethe Fn + F10 key
combination (see* Keyboard Shortcuts’ on page 1 - 13) totoggle power tothe PC

Camera module.

Notethat you need to use the Camer a app in Windows to take pictures and cap-
ture video.
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Camera App

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

2. Run the Camera app from the Start menu by clicking on the Camera app icon
(you can type “camera” into the search box to find the Camera app).

3. The interface displays two buttons on the right of the screen; one for photo and
one for video.

Figure6 - 35 a
Camera App Mode

Photo Video Icons
4. Simply click on the appropriate button to switch to either photo or video modes.
5. You can use the buttons at the top of the screen to access the Settings and Auto/
Pro menus (for Self Timer or Exposure compensation).
Figure 6 - 36
Camera Menu
Buttons
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6. Click Settings B to access the camera settings menu to make adjustments for
Camera press and hold button, photo Aspect ratio, Framing grid, Time lapse,
video recording frame rates and Flicker reduction.

SETTINGS /

Press and hold camera button

[ Disabled v Camera Settlngs

The Self Timer can be set to take Photos after 2, 5 or 10 seconds
and can also be set to continue taking pictures until the camera

e button is pressed again (Photo Burst).
16:9

Photos

The Aspect Ratio can be changed to those the system supports.

Figure6 - 37
Camera Settings

Framing grid

You can use a Framing grid to help you line up pictures.

Time lapse can be set to keep taking photos until the camera but-
ton is pressed again.

The Video recording resolution and frame rate can be set to any
supported by the system. Note that capturing high resolution vid-
eo files requires a substantial amount of disk space for each file.
Video recording After recording video, check the video file size (right-click the file
2806720730 Tps and select Properties) and the remaining free space on your hard
i disk (go to File Explorer, right-click the hard disk, and select Prop-
e erties). If necessary you can remove the recorded video file to a
removable medium e.g. CD, DVD or USB Flash drive.

Related setti . . .
RRRREEE=E0 If you need to reduce any screen flicker, change the settings in

Flicker reduction to either e.g. 50Hz or 60Hz.

6 - 48 PC Camera



Modules & Options

7. With the Pro menu expanded you can access the Exposure compensation
button to adjust the brightness.

Figure6 - 38
Camera Brightness
Adjustment
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Figure6 - 39
Video Camera
Recording in
Process

Taking Pictures/Capturing Video

1.

Make sure the PC Camera is turned on by using the Fn + F10 key combination (or
Control Center button).

Run the Camera app from the Start menu by clicking on the Camera app icon
(you can type “camera” into the search box to find the Camera app).

Click to select either photo (@] or video [ =) modes.

Click the photo icon to take a picture. '
Click on the video icon [ to start video capture (when video capture begins a
timer will appear at the bottom of the screen). -

To stop video capture click the stop E button (you can also pause III:n:j:w
capture). -

the video
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Captured photos and videos will be saved to the Photos app stored in the Start
menu (type Photos into the search box if you cannot find the app). You can also
access the photos from the Camera roll icon at the bottom right of the Camera
app screen.

Portal

8 We speak Yahoo
@ n
Get Office ] i
Figure6 - 40
Paid Wi-Fi & Cellular : © PhOtOS App
W paint3D (For Captured
s Photos & Videos)
i Photos &
s Camera Roll in the
Camera App

]
£ T[ype here to search
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Trusted Platform Module

(Optional)

The TPM security chip allowsyou to create and manage digital certificatesfor user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
aremovablemedia (e.g. aUSB flash drive) to stor e passwor dsetc. befor e begin-
ning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security plat-
form.
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Enabling & Activating TPM

1. Restart the computer. /

2. Enter the Aptio Setup Utility pressing .F2 during the POST/startup. TPM Configuration
3. Use the arrow keys to select the Security menu.

4. Select TPM Configuration and press Enter to access the sub-menu. You can select TPM
5. Select Enable in Security Device Support. Configuration  from
6.

You will then need to press F4 to save the changes and restart the computer. the Security menu as
long as UEFI is ena-

bled.

Aptio Setup Utility — Copyright (C) 2017 American Megatrends Inc.

Clearing TPM
Information

Security Device Support [Enable]

You can select Pend-
ing operation, and
then select TPM clear
to clear existing TPM in-
formation in order to re-
set the TPM.

Figure6 - 41
TPM State (Enable)
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TPM Management in Windows
Y ou can manage your TPM settings from within Windows:
1. Go to the Control Panel.

2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.

A BitLocker Drivi Encryption m]

= T “& « Al Contrel Panel ltems » Bitlocker Drive Encryption

c

Control Panel Homae

BitLocker Drive Encryption

Help protect your filés and folders from unauthorized access by protecting your drives with

F|gure 6-42 BitLocker.
BitLocker Drive
EnCI‘yptiOn Operating system drive
(TPM C: BitLocker off
Administration)
= & Tum on BitLocker
Sy

Fixed data drives

Remowable data drives - BitLocker To Go

w MEMSTICK (D) Bittocker off
o IJ:(k Management

Privacy statement G TPM Administration
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4. The TPM Management window allows you to configure the TPM within Windows.
As TPM is usually administered within large enterprises and organizations, your
system administrator will need to assist you in managing the information here.

B Trusted Platform Module (TPM) Management on Local Computer = o *

@ Eile  Action  View Window Help "=

4= | M Hm
o TP Mg o e Comp e
TPM Management on Local Computer -
TPM Managsmant on Local Computer 20,
Configures the TPM and its suppont by the Windows platform E3 Preparethe TPM...
B} Change Owner Password...
Ovorview * | B3 ClearTPM..
Windows computers containing the Trusted Flationn Module (TPM) securty hardware provide enhanced | [ Reset TPM Lockout...
sscurty faatures for soplications. This snag-in displaye information about the computer's TPM and slows
admnsiraton 1o corfigure the device. 1 also sllows administratons 1o view and manage commands View L3 .
undersiood by tha davice MNew Window from Here FIgUI’e 6 = 43
- | G Refresh
ity - Trusted Platform
Help
The TPM i , with reduced fi i)
Ll oy — Module (TPM)
TR Menwrsemwol . Management on
@ ewe TP ownarpatmcel. 3 Local Computer

@ Deorthe TPM 1o remove ownership and reset the TPM 1o factory defauls. o5

Administration

WARNING: Oeanng the TPM causes you to lose all TPM keys and data protected by thase keya
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TPM Actions

1. Click Prepare the TPM and follow the instructions in the Wizard to prepare the
TPM (this will probably require a restart of the computer and confirmation of the
setting changes after restart by pressing the appropriate F key).

2. After the restart the TPM will be prepared and you can then use the Actions menu
to Turn TPM off, Change Owner Password, Clear TPM or Reset TPM Lockout.

3. A wizard will help take you through any setup steps.

Actions
b TPM Management on Local Computer A

Figure6 - 44
TPM Actions Menu Prepare the TPM...

Change Owner Password...

Clear TPM...

Reset TPM Lockout...

View »

New Window from Here

Refresh

BB

Heln
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BitLocker

BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk. Access the Microsoft BitL ocker Drive Encryption control panel
applet from the Windows control panel (System and Security).

1. Click Turn on Bit Locker.
2. Follow the on-screen instructions to setup BitLocker, and make sure you have a
removable media (e.g. a USB flash drive) to store saved recovery keys etc.

A BitLocker Drive Encryption = *

~ 1t % « Al Control Panel ltems > BitLacker Drive Encryption v 0 - 1 y 0 a
Control Panel Home . 2 .
3 BitLocker Drive Encryption

Help protect your files and folders from unauthorized access by protecting your drives with

BitLocker. Figure 6 _ 45
Operating system drive BitLOCker -DriVe
C: BitLocker off Encryption
S
Fixed data drives -
1 G Turn on BitLocker

Removable data drives - BitLocker To Go
MEMSTICK () BitLocker oft
0 1PN Administration
W Disk Management

Privacy statement
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y 4G Module

4% (For Model A and Model B Design | Only)

nggfiﬁzi E,Z\T)Vciz(red If you have included an optional LTE/4G (Long Term Evolution) module (see

Aircraft “Communication” on page D - 3 for specification details) in your purchase option,
you do not require a driver/application installation for Windows. Follow the in-

The use of any portable . . . . . .
e e structions overleaf to install the SIM card (which will be supplied by your service
Stk -l @ provider), and then use the Charms Bar Wirelessicon to access the 4G network
is usually prohibited. in the same manner as the WLAN.
Make sure the WLAN &
Bluetooth module(s)
are OFF (or the system
is in Airplane Mode) if
you are using the com-
puter aboard aircraft
(see

2AN\Z
I

Important Notice

If your purchase option includes both Wireless LAN and 4G modules, then the appropriate
antennas will be installed. Note that In order to comply with FCC RF exposure compliance
requirements, the antenna must not be co-located or operate in conjunction with any other
antenna or transmitter.

Important Notice - 4G & Bluetooth/Wireless LAN Modules

).

In order to comply with FCC regulations you should NOT operate the 4G module and the
Bluetooth/Wireless LAN modules at the same time as this may disrupt radio frequency, and
cause interference. When the 4G module is powered on, make sure that the Bluetooth/
Wireless LAN modules are powered off.

. |
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4G Module SIM Card Installation

Insert the SIM card @ asillustrated below (pay careful attention to the orientation 2LX

of the card as the gold contact side of the card should face upwards towards the top SIM Card

of the computer) until it clicks fully into position. To gect the card ssimply press it Orientation

until it jects, but do not attempt to eject the card while connected to a4G network  BEEEEREREEEE T
(see below). readable side (with the

gold-colored contacts)
should face upwards as
illustrated.

'

2N
Ik

SIM Card Ejection

Simply press on the SIM card to
eject it, however do not do this .
while a connection is in prog- Figure6 - 46

ress. SIM Card Insertion

If you do eject the card while a
4G connection is ongoing, you
will need to shut down the sys-
tem, reinsert the SIM card, re-
start the system and then
reestablish the 3G/4G connec-
tion.

If you wish to change SIM cards
then you will need to shut the
system down, reinsert the SIM
card, restart the system and
then reestablish the 4G connec-
tion.
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4G Configuration in Windows 10

Y ou can configure a4G connection as below, however make sure the system is not
in Airplane Mode before configuration begins. Y ou can connect to a4G connection
in much the same way as the WLAN connection.

oukrwbdE

© N

Click the Settings item in the Start Menu and then click Network and Internet.
Click Cellular a list of available access points will appear.

Click the access point and click Connect.

The system will connect to your network.

Connected will appear under the connection.

You can then access the internet, download e-mail etc. as per any internet
connection.

To disconnect you can select the connection and click Disconnect.

You need to use Airplane Mode aboard aircraft.

You can also click the Wireless icon - in the notification area of the taskbar, click
Cellular and double-click an access point connect to access the connection
information.
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Chapter 7: Troubleshooting

Overview

Should you have any problemswith your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’'t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautionsin the preface.
If al elsefails, talk to your service representative. Y ou should also make a record of what happened and what
remedies you tried.

Of course, if something goeswrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you' ve tried everything, and the system still won't cooperate, try turning it off
for afew minutes and then rebooting. Y ou will lose any unsaved data, but it may start working again. Then call
your service representative.

. |
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Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working.

Power - Isthe computer actually plugged into aworking electrical outlet? If plugged into apower strip,
make sure it is actually working. Check the LED Power & Communication Indicators (see“LCD Panel
Open - Model A” on page 1 - 6) to see the computer’s power status.

Connections - Check al the cables to make sure that there are no loose connections anywhere.

Power Savings - Make sure that the system is not in Hiber nate or Sleep mode by pressing the keys config-
ured in your Power Options (see “ Power-Saving States” on page 3 - 7), the Fn + F12 key combination, or
power button to wake-up the system.

Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keysto adjust the bright-
ness.

Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

Boot Drive - Make sure there are no optical media and/or USB storage devicesin any connected drive.
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Backup and General Maintenance

» Always backup your important data, and keep copies of your OS and programs safe, but close to hand.
Don't forget to note the serial numbersif you are storing them out of their original cases, e.g. inaCD wal-
let.

* Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with
your OS, or buy the more powerful dedicated programs to do so.

» Write down your passwords and keep them safe (away from your computer). Thisis especially important if
you choose to use a Super visor password for the BIOS (see “ The Setup Utility” on page5 - 2).

» Keep copiesof vital settingsfiles such as network, dialup settings, mail settings etc.(even if just brief notes).

N2
2

Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses

» Ingtal an Anti-Virus program and keep the definitionsfile (the file which tells your program which viruses
to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tionsfile updates are usually downloadable directly from the internet.

» Becareful when opening e-mail from sources you don’'t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

» Keepa“Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic
information which allows you to startup your computer) handy. You may refer to your OS's documentation
for instructions on how to make one, and many Anti-Virus programs will also provide such adisk (or at
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software

Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are
doing, otherwise you will risk severely damaging your system.

Don’'t open your computer or undertake any repair or upgrade work if you are not comfortable with what
you are doing.

Read the documentation. We can assume, since you are reading this that you are looking at the computer’s
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by
the installation of new hardware and/or software. Always refer to the documentation of any new hardware
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

When installing a new device always make sure the device is powered on, and in many cases you will need
to restart the computer. Always check that all the cables are correctly connected.

Make sure you have installed the drivers for any new hardware you have installed (latest driver filesare
usually available to download from vendor’s websites).
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Troubleshooting

» Thoroughly check any recent changes you made to your system as these changes may affect one or more
system components, or software programs. If possible, go back and undo the change you just made and see
if the problem still occurs.

» Don't over complicate things. The less you have to deal with then the easier the source of the problem may
be found; Example - if your computer has many devices plugged into its ports, and a number of programs
running, then it will be difficult to determine the cause of aproblem. Try disconnecting all of the devices and
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and

removing devices and restarting where necessary) will often find the source of a problem, although this may
be time consuming.
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Troubleshooting

Problems and Possible Solutions

Problem

Possible Cause - Solution

You turned on the power but it doesn't
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator _Il], is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn't start up
immediately, turn it off then on again.

You are losing battery power too quickly.

The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/lUSB device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
pages 3 -16to 3 - 21).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/lUSB device is consuming a lot of power. Turn off/remove
the unused device to save power.

The system will not start up when it is
being operated in a low temperature
environment.

This is due to the electrical characteristics of battery cells at low
temperatures. Although the lowest operational temperature tolerance of the
system is listed at 5°C, however if the system is in DC mode (on battery), the
battery must have a remaining charge capacity of 60%+; at 10°C or above.
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Troubleshooting

Problem

Possible Cause - Solution

The system will not wake up from a
power saving state (Sleep/Hibernate)
on network activity (Wake on LAN) even
though | have plugged in the powered
AC/DC adapter.

Wake on LAN is supported in AC mode only.

When the system enters a power saving state the plugged in AC/DC adapter
should be connected, and should remain connected, in order to allow the
system to wake up on network activity. Unplugging the adapter, and then
plugging it back in again, will not allow the system to wake up on network
activity.

The computer feels too hot.

Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn't sitting on a thermal surface (see
“Overheating” on page 1 - 19/1 - 22). Make sure you're using the correct
adapter.

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

When playing a video in Media Player,
while using a 4K panel, the counting timer
area at the bottom of the screen
appears to be cut off slightly.

The size of text, apps and other items in Settings > System > Display is set to
250%. In this case it is recommended that the setting should be less than
250%.

When you are playing a game and you
use the Windows Key to switch to the
desktop an error message, or Blue
Screen, occurs.

This is a DirectX compatibility issue. In this case disable DirectX from within the
game controls.
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Troubleshooting

Problem Possible Cause - Solution

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F12 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you're connected to an external monitor, make sure
it's plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external | You haven't installed the video driver and configured it appropriately from the
monitor | have plugged in and powered | Control Panel. See Appendix C for instructions on installing and configuring
on. the video driver.

You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

\ A/
RS
Password Warning
If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot

remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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Problem

Possible Cause - Solution

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Keyboard Shortcuts” on page 1 - 13) to adjust.

My internal microphone seems to be
disabled and/or | can still hear sound
from the speakers even though | have
plugged headphones into the headphone
jack.

“Enable jack detection when device is plugged in” is disabled in Connector
Settings (Device advanced settings) in the Realtek Audio Console control
panel. Go to the Realtek Audio Console control panel and click Device
advanced settings and make sure that “Enable jack detection when device is
plugged in” is On (see Figure 2 - 18 on page 2 - 18).

Unwelcome numbers when

typing.

appear

Num Lock is turned ON (see “Keyboard Shortcuts” on page 1 - 13).

| am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

4

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and
enable it automatically. However special functions/hot keys unigue to the system’s regular keyboard may not work.
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Problem

Possible Cause - Solution

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F12) key combination, or press the power button if no
LEDs are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. | have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device’s documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.

The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Go to the Charms
Bar and select Settings and then click the WiFi icon (Airplane mode should be

off).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Keyboard Shortcuts” on pagel - 13). Run the camera
application to view the camera picture.
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Problem

Possible Cause - Solution

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 6 - 1).

A file cannot be copied to/from a

connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

No sound can be heard through an HDMI
connected display.

You have not configured the HDMI audio output. See “HDMI Audio
Configuration” on page C - 9.

The fingerprint reader has problems
scanning fingers.

When fingers are wet or sweaty the software application may have difficulty
reading a scanned finger. Make sure your fingers are clean and dry when
attempting to scan them across the sensor for detection.

At the Windows Hello screen, the
Fingerprint reader fails to recognize the
fingerprint 3 times and blocks access
to the computer.

In this case you will need to use your PIN (the PIN you used when initially
setting up the fingerprint reader) to access the computer. Alternatively you can
sign-in using your windows password.

After using the PIN code (or windows Password) to access the computer you
can go to the Settings > Accounts > Sign-in options if you wish to change any
settings.

Gaming performance is slow.

It is recommended that you use Maximum fan speed when playing games.
Use the Fn + 1 key combination to adjust the fan speed.
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Problem

Possible Cause - Solution

When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

Go to the Devices & Printers control panel in Windows.
Double-click the Bluetooth headset.
Click Connect to complete the stereo connection.

Go to the Sound control panel in Windows.

Right-click (in the Playback tab) the Bluetooth Stereo Audio device (the
default device is Headset).

3. Click Connect to complete the stereo connection.

NP OWNE
pyj

A file being copied to/from a connected
Bluetooth device appears to be
transferring very slowly.

You may have the Bluetooth control panel (Settings > Devices > Bluetooth)
open. When transferring data between the computer and a Bluetooth enabled
device, make sure that the Bluetooth control panel is closed.

2 &
Bluetooth Control Panel
(Settings > Devices)

Manage Bluetooth devices

Close the Bluetooth control pan-

el (pictured on the right) when i A
transferring data between the com- ) o
puter and a Bluetooth enabled de- w

vice. o
h-:nlr.luv
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Problem Possible Cause - Solution

| can’'t hear any sound from the | You need to enable listening to the microphone in the audio control panel in
microphone in my connected headset, | order to hear any sound through your connected headset as follows:

when trying to test the audio playback.
1. Right-click the volume control icon in the taskbar.
2. Select Recording Devices. '

Open Vohime Mixer
Playback devices
Recording devices

Sounds

Troubleshoot sound problems

3. Double-click Microphone and select Listen.
4. Click to put a check in Listen to this device check box.

=% Microphone Properties *

General Listen |evels Enhancements Advanced

You can listen to a portable music player or other device through
this Microphone jack, If you connect a microphone, you may hear

feedback.
= = 0

Listen to this device

Playback through this device:

Default Playback Device ~

5. Click Apply.

You can then listen to the playback though the headset for testing.

7. Remember to disable this feature (remove the check from the Listen to
this device check box) otherwise you may hear an echo from the internal
microphone when you disconnect the headset.

o
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Resolving the “Can’t connect to this network” issue with the 4G Module

1.

2.

If you have issues connecting to the cellular network when you are attempting to use the 4G network then you
may need to manually connect to the Internet access point name (APN).

Usually the Internet APN is set automatically, however if your cellular data connection isn't working, you should
try manually entering a new Internet APN based on your location and mobile operator.

To find your APN settings contact your mobile operator directly (or of you can connect to a WiFi network on your
PC, or have a phone handy, try searching online to find the Internet APN settings for your mobile operator).
See http://windows.microsoft.com/en-us/windows-10/cellular-settings or search the Microsoft website for
"Windows 10 cellular settings".
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Intel® Optane™ Notes

Intel® Optane™ is a combination of a compatible memory device and Intel Rapid Technology software. This
combination is designed to speed up your system performance. However note the following;

* The SATA Mode should be set BEFORE installing an oper ating system, and after you have backed up all
necessary files and data (see sidebar). See “ Setting Up SATA Mode (Optane™ or AHCI)” on page 6 - 2 for
details. Make sure you install the I ntel Rapid Storage Technology application if you have set the SATA
Modeto Intel RST Premium, or to AHCI (see”|RST Driver Installation” on page 6 - 39).

* Itisvery important to make sure that when you create a hard disk drive partition when installing Windows
for an Intel® Optane™ system, that you leave at least aminimum of 5SMB of unallocated space (notethisis
5MB only, not GB).

» After setting the SATA modeto Intel® Optane™ and installing the Intel® Rapid Storage Technol ogy
application, DO NOT uninstall the Intel® Rapid Sorage Technology application.

» If you are reinstalling a system that has previously been setup in Intel RST Premium mode, make sure
you have cleared the Intel Optane Memory (see“ Clearing I ntel® Optane™” on page 6 - 7). If you
haven't cleared the Optane setup you may not find a suitable hard disk drive partition on which to reinstall
an operating system.

» If you need to reinstall an operating system, uninstall the IRST driver/application or swap the hard disk
drive (or Intel® Optane™ SSD) make sure you have cleared the Intel Optane Memory (see“ Clearing
Intel® Optane™” on page 6 - 7).
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Interface (Ports & Jacks)

Appendix A: Interface (Ports & Jacks)

Overview

The following chapter will give aquick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.

Interface (Ports & Jacks) A - 1



Interface (Ports & Jacks)

Notebook Ports and Jacks

ltem

Description

2-in-1 Audio Jack
(Headphone-Out &
S/PDIF-Out Jack)

(#)

Headphones may be connected through this jack. Note: Set your system’s volume to a reduced
level before connecting to this jack. In addition this jack also functions as a S/PDIF (Sony/Philips
Digital Interface Format) Out port allowing you to connect your DVD-capable PC to a Dolby AC-
3 compatible receiver for “5.1” or ‘dts’ surround sound.

Card Reader

O 5D I MMC

The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

« MMC (MultiMedia Card) / RSMMC
e SD (Secure Digital) / Mini SD / SDHC / SDXC up to UHSHI

DC-In Jack

Plug the supplied AC/DC adapter into this jack to power your computer.

HDMI-Out Port

The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Microphone-In Jack

ﬁ\\

Plug an external microphone in to this jack to record on your computer.
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Iltem Description

Mini DisplayPort 1.3 The Mini DisplayPorts are miniaturized versions of the DisplayPort, which is a digital display
|GI interface standard that allows a digital audio/video interconnect, between the computer and its
external display or a home-theater system.

SN
28

Mini DisplayPort Cables

When using cables connected to the Mini DisplayPort, try to make sure that the cables are not bent excessively,
as bending the cables may cause signal problems.

RJ-45 LAN Jack This port supports LAN (Network) functions (you will need to open the cover slightly before
inserting a LAN cable).
% Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.
Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
O5 purchased at any computer store.
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Item

Description

USB 3.1 (USB3.1Gen?2
Type C) Ports

UsSB3.0(USB3.1Gen1l
Type A) Port

5=

Powered USB 3.0 (USB
3.1 Gen 1 Type A) Port

These USB ports are for low-speed peripherals such as keyboards, mice or scanners, and for
high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners
etc. Devices can be plugged into the computer, and unplugged from the computer, without the
need to turn the system off (if the power rating of your USB device is 500mA or above, make sure
you use the power supply which comes with the device).

The USB 3.0 ports capable of 5Gbps (SuperSpeed) are classified as USB 3.1 Gen 1. There are
three USB 3.1 Gen 1 (Type A) ports on this computer model. In addition there are two USB 3.1
Gen 2 ports (Type C) capable of 10Gbps SuperSpeed+. Type C ports are the smaller sized
USB ports, and the larger USB Type A ports are denoted by their blue color.

Note: The powered USB 3.0 port may be toggled on /off by means of the Fn + Power Button
key combination. When the powered USB port is on it will supply power (for charging devices
only, not for operating devices) when the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery with a capacity level above 20% (this
may not work with certain devices - see page 7 - 11). Toggle power to this port by using Fn +
power button.

Note: This function is designed to help charge USB compliant devices, but is not designed to
allow their operation.

Note: The maximum amount of current supplied by USB Type-C ports is 500 mA for USB2.0/900
mA for USB 3.1
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Appendix B: Control Center

Overview

The following chapter will give aquick description of the functions of the Control Center & Flexikey® appli-
cations.

Control Center
The Control Center gives quick access to frequently used controls and settings. Click the Control Center icons
to toggle the appropriate function, or hold the mouse button down and move the dial control where applicable.

Flexikey®

The Flexikey® application isaquick hotkey configuration application, which allowsyou to assign asinglekey
to launch multiple key combinations, or to launch programsand applications, to create text macr os and to
disable certain keys. The application can also be used to configure the mouse buttons to create hotkeys for
gaming etc. All the configuration settings are retained under (up to12) profiles to which the settings are applied.
Click Flexikey in the Control Center to launch the application.
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VEONTROL CENTER 2.0

CCONTROL CaNTER 2.0

Entertainment

4

Control Center Access

To run the Control Center press the Fn + Esc key combination, or double-click the icon n
in the notification area of the taskbar.

Close the Control Center by clicking the close icon in the top right of the panel.

Flexikey® Access

The Flexikey® is accessed from within the Control Center by clicking FlexiKey® in the top
left of the Control Center.

Figure B - 1 - Control Center & FlexiKey
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Control Center Menus

The Control Center contains 5 menu headings (System Monitor, Basic Setting, LED Device, FlexiKey
and Extra Setting) in the top left of the Control Center. Click the menu headings and then click any of the
buttons outlined on the following pages. The LED Device menu displayed will depend on whether you have
acolored LED keyboard (see page B - 10) or white LED keyboard (see page B- 14)

(@—

'ﬂ-'-,\
e \
A
N
Entertainment

Y CONTROL CENTER 8.0

[] + [=] ety

Figure B - 2 - Control Center Menus
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System Monitor
The System Monitor tab provides information on the computer’s GPU and CPU.

System Monitor

(G

— —
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Gompocst 1670 it — ) utomsx 4000 e
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& Temparature 4 2 -
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FAN SPEED

2459 \-‘
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Automatic

@

Fan Speed Setting

4;;| CPU Vaoltage
F 1108 v

Figure B - 3 - System Monitor
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Fan Speed Setting

Y ou can set the fan speed to M aximum (full power), Automatic or Custom from thismenu item. Thefan speed
will adjust itself automatically to control the heat of the CPU. However you can adjust the setting to maximum
if you prefer. Y ou can use the Offset dlider to adjust the settings to your preference.

The Custom setting allows you to click and drag on any of the 2 midrange nodes on the graph in order to adjust
the temperature parameters of the CPU Fan or GPU Fan (click on the CPU Fan or GPU Fanicon for either on
to select it, then click and drag either of the midrange nodes).

All these settings can be overridden by the system as a safety precaution, if it requires heavier use of the
fan.

Figure B - 4 - CPU/GPU Fan Custom Settings

.|
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Fan Speed - Max-Q (System Program) AN rEED
If your NVIDIA video adapter supports % MAX-Q

(check with your distributor/supplier) technology you can set the fan to Max-Q. When the Max-Q setting is en-
abled, and the system is operating within suitable power/performance parameters, the GPU will consume less
power, produce less heat, and therefore the fans will not need to spin so much, resulting in a quieter system.

Systam Monitor

O NVIDA GeForce GTX 1070 coretaso

Temperature

y cPU '-.'r.m)ellll

Q742

Figure B - 5 - Fan Max-Q

.|
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Basic Setting
The Basic Setting alows you to adjust the power mode and other system features.

VCONTROL CENTER 2.0

'[g: ’ ) '

——

Figure B - 6 - Basic Setting & Power Modes
Power Modes
Y ou can set aPower M ode by clicking the appropriate icon in the center of the Control Center. Each pow-
er mode will affect Airplane Mode and PC camera power.

* InPower Saving Mode the Airplane M ode will be ON and the PC Camera will be turned OFF.
* InQuiet Mode the Airplane Mode will be OFF.
* In Performance Mode and Entertainment Mode the Airplane M ode will be OFF.

» Clicking the Default button in Entertainment will reset the default settings for this mode.

.|
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Power Status /
The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter

plugged in to aworking power outlet. The power status bar will show the current battery charge state.

Brightness 82\
The Brightness

icon will show the current screen brightness level. Y ou can use the dial to adjust the screen brightness, or you
can use the Fn + F8/F9 key combinations.

PC Camera/Touchpad/Left Windows Key
Click these buttonsto toggle the PC Camera or Touchpad power status, or to turn the L eft WindowsK ey func-
tionality on/off. The button under the icon will appear highlighted when it is enabled. Note that the power status
of the cameramodule is also effected by the Power M ode selected (see “ Power Modes’” on page B - 7).

Sleep / Hibernate Button
Click either the Hibernate or Sleep buttons to have the computer enter the selected power-saving mode (you
will receive awarning before the system switches to the power-saving mode and will need to click OK to con-

firm).
92
Volume =

The Volumeicon will show the current volume level. Y ou can use the dial to adjust the Volume or the Fn + F5/
F6 key combinations, or use the Fn+ F3 key combination to mute the volume.
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Caps Lock/Scroll Lock/Number Lock/Airplane Mode
Click the button to toggle the appropriate lock mode and
Airplane Mode. Note that Airplane Mode is not an indicator, and is not intended to display the current status
(check the LED indicator), but atoggle and can be overridden by one of the power modes.
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LED Device Menu - Colored LED Keyboards

The Keyboard Backlight LED Device application can be accessed by pressing the Fn plus key (or by
clicking LED Devicein thetop left of the Control Center). Usethe KB Sleep Timer to select the amount of time
the system for which the system isidle before the keyboard LED enters sleep mode (i.e. the LED keyboard illu-
mination will turn off to save power). Y ou can aso adjust the KB Brightness.

/
s

@ LED Devica

Figure B - 7 - Keyboard LED Device Application for Colored LED Keyboards Only (Keyboard All)
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Color Swatch

The color swatch in the middle of the screen allows you to select arange of colors for your keyboard backlight
by clicking on the color required. Click to select any colors from the swatch to apply to the whole keyboard (un-
der Keyboard All) or parts of the keyboard (under Keyboard Partial).

KB Sleep Timer
Enable and then select the amount of time the system for which the system isidle before the keyboard LED en-
ters sleep mode (i.e. the LED keyboard illumination will turn off to save power).

KB Brightness
Click on any of the numbers (1 - 4) onthe KB Brightnessbar to set the brightnesslevel of the LED Device. You
can also turn the keyboard backlight LED Device off by clicking the OFF button, or by usingthe Fn plus - | key.

Figure B - 8 - Keyboard Color Swatch
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LED Mode - Keyboard All/Keyboard Partial
Click either of the headings on the left under LED Mode (Keyboard All or Keyboard Partial) to select how
the colors will be applied.

» Keyboard All - Simply click a color from the outer band of the swatch, or click one of the color mixesfrom
the center of the swatch and it will beimmediately applied to the whole keyboard.

» Keyboard Partial - Simply click a color from the outer band of the swatch, or click one of the color mixes
from the center of the swatch, and then click one of the keyboard section headings (L eft, Mid or Right) to
apply the color.

VU CONTROL CENTER 2.0

Figure B - 9 - LED Mode - Keyboard Partial
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Keyboard Effects
Click on Keyboard Effect (under LED Mode) and then click any of the Effect buttons to view the effects on
the keyboard.

(&

M B0 = 4 E @K

Wave Breath Cycle Random Dance Tempo
Figure B - 10 - Keyboard Effects
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LED Device Menu - White LED Keyboards

Enable and then select the amount of time the system for which the system isidle before the keyboard LED en-
ters sleep mode (i.e. the LED keyboard illumination will turn off to save power). Y ou can aso adjust the key-

board brightness.

r:;.:j LED Mode

LED Device

Keyboard

EE\ Keyboard Sleep timer

Disable Enable

H

a o

Figure B - 11 - LED Device (for White LED llluminated Keyboards Only)

.|
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Extra Setting
The Extra Setting tab allows you to adjust the app skin color to your choice.

- 5

Extra Setting 4% Change Skin Color
el

Figure B - 12 - Extra Setting

Extra Setting B - 15



Flexikey® Application

Click FlexiK ey in the top left of the Control Center to access the Flexikey® application. Y ou can use the Fn
+ Backspace key combination to toggle the Flexikey® application on and off.

Profiles

The controls at the top right side of the application relate to Profiles. You can Add/Delete Profiles (you can
maintain 12 active Profiles), Export and Import profiles by clicking on the appropriate icon. If you double-
click on aProfile you can change the Pr ofile Name, and import an | mage file (images created using PNG files).

N\ AL/
L&
Windows Key F
Fn & P Keys

(s Ay Mol

Flexiken @

Note that you can
assign actions to

any keyboard key
except the Win-
dows key F Fn
and P key.

Macro Keyboard

Figure B - 13 - Flexikey® - Profiles (Macro Keyboard)

.|
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Flexikey® Application Features

EXPRESSKEY - Thisfeature allowsyou to configure asingle key to send multiple key combinations or to
create more useful shortcut keys. Thisis useful in gaming or when using applications which have a complex
set of keyboard shortcuts.

LAUNCH APP - Thissimply assigns single keysto launch any program’s or application’s executablefile.
EXPRESS TEXT - With this you can assign single keys to send commonly used strings of text.
DISABLE - Use this function to disable any keyboard keys.

STATISTICS - Usethisto quickly record keysin usein any application, and to disable unused keys.

Macro Keyboard and Macro Mouse Settings

Click Enable

el (at the bottom right of the screen) to create settings for the keyboard and/or mouse

Enable

by clicking the tab at the bottom of the screen (e.g. you may wish to create a profile with settings only for the
mouse or keyboard). Clicking on M acro K eyboard or Macro M ouse allows you to access the settings page for
the either the keyboard or mouse.

Macro Keyboard

Figure B - 14 - Macro Keyboard & Macro Mouse Selection
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Enabling or Disabling Flexikey®

Y ou can enable or disable Flexikey® (and therefore any hotkeys or mouse profile functions currently in use) by
using the Fn + Back space key combination. Pressing this key combination will toggle you between the currently
selected keyboard or mouse profileto the standard keyboard and/or mouse settings, and back again. An on screen
icon will also pop-up to display the status of the application asit is toggled on/off.

i, Flexikey* ON
L3 af}
r 3

Figure B - 15 - FlexiKey On Screen Icons

.|
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Keyboard Settings

The keyboard settings allow you to configure actions for any single key (or a combination of keys). Click the
key and then select the action type (ExpressK ey, Launch App, Express Text or Disable) from the menu at the
top of the page. You can click in Tool Tipsto type in anote to remind you of the action’s function.

\ A/
Z &
Windows Key H-
Fn & P Keys

C CONTROL CENTER 2.0

Sechsmcs | U5E Fri+EBackspace io Enable
+ | +— or Dis Flazeikary
Exproas Teat Disabie

Note that you can
assign actions to
any keyboard key

except the Win-
dows key F Fn
and P key.

Macro Keyboard

Figure B - 16 - Macro Keyboard Configuration

.|
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Mouse Settings

When an external mouse is attached, the mouse settings allow you to configure actions for the left @, right @
and middle @ buttons of the attached mouse, and also for any backward @ and forward @ buttonsiif appli-
cable (on agaming type mouse). Click the button number and then select the action type (ExpressK ey, Launch
App, Express Text or Disable) from the menu. You can click in Tool Tipsto typein a note to remind you of
the action’ s function.

C COoONTROL CENTER 2.0

FleaiCay

Launch APF Exgrenss Texd

Macro Mouse

Figure B - 17 - Macro Mouse Configuration

.|
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Keyboard Settings - Express Key
To configure asingle key to send multiple key combinations, or to create more useful shortcut keys, use Express
Key.
1. Enable and select the keyboard under your chosen profile, click on the chosen key to select it, and then click to
select Express Key.
C CONTROL CENTER 2.5

Spant Fwids

SRR | sunch ArP

— T
+ | = or Disabla Flexikey
P

f_',- Restore

Macro Keyboard

Figure B - 18 - Control Center - Macro Keyboard - Record Express Key

.|
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2. Inthe following example we want to change an existing game key configuration which uses the left shift key for
sprinting, and the W key for moving forwards, to use the left Ctrl key to combine this movement to sprint
for_ward. - o _ _

3. Click the Record button and then press the key or keys (in this case we will press Left Shift and W)
required (make sure you press the key(s) required and do not click on them).

4. Click the Record buttonh again to complete the process and stop recording.

5. Click on the key, and then click in the Tool Tips field and type to give the key combination a name e.g. “Sprint
Fwds”.

6. If you want to remove any individual key click to select it, and then click Restore.

7. Any assigned Express Keys will be highlighted in green.

4

Tool Tips

The Tool Tips field allows you to type a note to remind yourself of the function you have programmed the key for under
any Profile.

.|
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Enabling Delay Time
If you want to create a delay between key presses within the key combination, then you can use Enable Delay
Time function to do so.

Enable and select the keyboard under your chosen profile, click on the chosen key to select it, and then click to

1.

2.

select Express Key.

Click the Record button and then press the key or keys required in the sequence and time delay
between key presses required (make sure you press the key(s) required and do not click on them).

. o
Click the Record button ()

again to complete the process and stop recording.

Click to select a key in the sequence and click Enable Delay Time , then click a key to view

the time delay.

P COoONTROL CENTER 2.5

Figure B - 19 - Enable Delay Time
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5.  You can edit the delay between key presses by clicking in the Delay Time (MS) field and typing a new number
for the delay between the key presses.

Action Delay Time
(m3)

Figure B - 20 - Time Record Between Key Presses

6. If you want to remove any individual key click to select it, and then click the delete . symbol.
7. If you want to clear all the settings click Restore to return to the default key setting.
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Keyboard Settings - Launch App
Y ou can configure keys to launch any application or program as follows:

1. Enable and select the keyboard under your chosen profile, click to select a key to launch the application, and

then click to select Launch App.
2. Click Browse... at the bottom left of the application window.

EXE Files [ens]

pen

Macro Keyboard

Figure B - 21 - Macro Keyboard - Launch App (Browse to Executable File)

.|
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3. Navigate to the executable file of the application and click Open.
4. The key will now be configured to open the selected application under your chosen Profile, and the key will
appear in red.

C CONTROL CENTER =.0

CAProgram F

Macro Keyboard

Figure B - 22 - Macro Keyboard - Key Set to Launch App
5. If you want to remove any Launch App Key, select it and click on Restore.
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Keyboard Settings - Express Text

A single key can be set to send a string of text within any application using Express Text.

1. Enable and select the keyboard under your chosen profile, click to select a key, and then click to select Express

Text.

2. Click in the Text Context field and type in your message and click Save.

3. Click the Record button in Start key and press the keys to use if required (the Start key is the key used to in
your target program to open a text message), or you can leave it blank if you prefer. Click the Record button

again to stop the process.

Macro Keyboard

Figure B - 23 - Macro Keyboard - Express Text

.|
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4. Click the Record button in Send and press the keys to use if required (the Send key is the key used to in your
target program to send a text message e.g the Enter key would be the most commonly used), or you can leave
it blank if you prefer. Click the Record button again to stop the process.

5. The key will now be configured to send the text message in the target program under your chosen Profile, and
the key will appear in blue.

6. If you want to remove any Express Text key, select it and click on Restore.

SN
L&

Copy & Paste Text

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have
copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type
the text into the field instead.
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Keyboard Settings - Disable
Y ou can use the program to disable any keys not required.

1. Enable and select the keyboard under your chosen profile, click to select a key to disable, and then click to select

Disable.
2. The key will now be disabled.
3. If you want to enable the key again, select it and click on Restore.
4. The key will be disabled under your chosen Profile, and the key will appear in Gray.

CCONTROL CENTER 2.0

Macro Keyboard

Figure B - 24 - Macro Keyboard - Disable

.|
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Mouse Settings - Express Key

To assign a mouse button click to send multiple key combinations (an external mouse must be attached), or to
create more useful shortcut keys, use Express Key.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Key.

2. In the following example we will configure the central mouse wheel to combine the actions of left shift key for
sprinting, and the W key for moving forwards in a game program.

3. Click on the central mouse wheel for the shortcut action.

¢ CONTROL CENTER 2.0

Figure B - 25 - Macro Mouse - Express Key Record Key Combination (Mouse)
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4. Click the Record button and then press the key or keys (in this case we will press Left Shift and W)
required (make sure you Eress the key(s) required and do not click on them).

5. Click the Record button again to complete the process and stop recording.

6. Click on the key, and then click in the Tool Tips field and type to give the key combination a name e.g. “Sprint
Fwds”.

7. Click in the Tool Tips field and type to give the key combination a name e.g. “Sprint Fwds”, then click back in
the Name field (to avoid adding the recorded keys to the Tool Tips hame).

8. If you want to remove any mouse setting click to select it, and then click Restore.

9. The mouse button for any assigned Express Keys will appear in

Enabling Time Record for Mouse Settings

If you want to create a delay between key presses within the mouse click combination, then you can use Time
Recor d function to do so in the same manner asthat used for keyboard settings (see“ Enabling Delay Time” on
page B - 23).
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Mouse Settings - Launch App

Y ou can assign a mouse button click to launch any application or program as follows:

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Launch App.
2. Click Browse... at the bottom right of the application window.

4

Macro Mouse

Figure B - 26 - Macro Mouse - Launch App (Browse to Executable File)

.|
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3. Navigate to the executable file of the application and click Open.
4. The mouse click will now be configured to open the selected application under your chosen Profile, and the
button will appear in red.

FlexiKey
. | UseFn+Backspace fo Enable
E + or Disable Flexikey

Express Key Launch APP Express Text Disable

Middle

C:\Program Files (x86)\internet Explorer
\iexplore exe

i
Enable

Macro Mouse

Figure B - 27 - Macro Mouse - Button Set to Launch App
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Mouse Settings - Express Text
A mouse button click can be set to send a string of text within any application using Express Text.

1. Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Express Text.

2. Click in the Text Context field and type in your message and click Save.

3. Click the Record button in Start key and press the keys to use if required (the Start key is the key used to in
your target program to open a text message), or you can leave it blank if you prefer. Click the Record button

again to stop the process.

Macro Mouse

Figure B - 28 - Macro Mouse - Express Text

.|
B - 34 Mouse Settings - Express Text



4. Click the Record button in Send and press the keys to use if required (the Send key is the key used to in your
target program to send a text message e.g the Enter key would be the most commonly used), or you can leave
it blank if you prefer. Click the Record button again to stop the process.

5. The key will now be configured to send the text message in the target program under your chosen Profile, and
the key will appear in blue.

6. If you want to remove any Express Text key, select it and click on Restore.

SN
L&

Copy & Paste Text

Note that some applications and games do not support copy and pasted text. Where this is the case, any text you may have
copy and pasted in to the “Type to Text” field may not be displayed within the application. In this case you will need to type
the text into the field instead.

.|
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Mouse Settings - Disable

Y ou can use the program to disable any mouse button clicks if not required.

1.

2.
3.

Enable and select the mouse under your chosen profile, click on a mouse button to select it, and then click to

select Disable.

The button click will now be disabled.

If you want to enable the button again, select it and click on Restore.

The button click will be disabled under your chosen Profile, and the key will appear in Gray.

Y CONTIROL CENTER 2.0

Macro Mouse

Figure B - 29 - Macro Mouse - Disable
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Statistics

The Statisticstab allows you to record keys used in any application, and to disable any infrequently, or unused,
keys to save any accidental incorrect key presses.

1.
2.

3.

o

Click the Statistics Tab, and press the Record button to start recording the frequency of key presses for keys used.
You can then go to the application for which you wish to use the profile, and use the application as per normal

so that a standard set of keys used may be recorded.
Return to the Flexikey® application and press Record button again to stop recording.

At the end of the recording process colors will represent the frequency of key presses, with the darker keys as
the most frequent through to lighter the less frequent (the color dial on the left of the screen displays the color

code against the number of key presses).
You can move the mouse over any key to see the number of times it has been pressed.

If you want to disable a key click Quick Disable and click the keys you wish to disable (the key will become

grayed out) and then click Save to retain the settings.

Y oONTROL CENTER 8.0

Figure B - 30 - Statistics
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Video Driver Controls

Appendix C: Video Driver Controls

Overview

The basic settings for configuring the LCD are outlined in “Video Features’ on
page 1 - 32. The basic video features for this computer can be configured using the
Intel(R) HD GraphicsControl Panel, WindowsDisplay Settingsor NVIDA con-
trol panel.

2N\Z
A

Configuring External Displays

When a single external display is attached to the HDMI or Display Ports, use the System
(in Settings - page ) control panel or the E + P (or Fn + F7 - page ) key combi-

nation, to configure the external display.

When multiple external displays are attached you should use the NVIDIA (page ) con-
trol panel to configure the external displays.

You cannot configure external displays using the Intel(R) HD Graphics control panel.

Overview C - 1

4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.




Video Driver Controls

Microsoft Hybrid Graphics

Most notebook computers come with either a discr ete or integrated graphics solu-
tion.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

Microsoft Hybrid Graphicsisaseamless switchabl e graphics technol ogy designed
to get best performance from the graphics system while allowing longer battery life,
without having to manually change settings. Thus when an application isrun that re-
guires extra performance or quality, then the operating system will run the discrete
GPU (dGPU); when the system does not require such enhanced performance it will
let the integrated (iGPU) handle it.

C - 2 Microsoft Hybrid Graphics



Video Driver Controls

How Switchable Technology works

When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU isrun (e.g, agame or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.

.|
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4

Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

Video Driver Installation

Make sure you install the driversin the order indicated in Table 4 - 1, on page 4 - 4.
Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD
drive and click I nstall Drivers (button).

Video (VGA)

1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes> Next > Next.

3. Click Finish to restart the computer.

NVIDIA Video (VGA)

1.
2.

3.

o A~

Click 3.Install NVIDIA VGA Driver > Yes.

Click AGREE AND CONTINUE (button) to accept the terms of the
license agreement.

Click Next.

Click Restart Now to restart the computer.

After all the drivers have been installed (an internet connection is required) run the
NVIDIA GefForce Experience by clicking the desktop icon g (or App).

Restart the computer and run the application again after restart.

C - 4 Video Driver Installation



Video Driver Controls

NVIDIA GeForce Experience -
If you have a working internet connection (and you will need remain connected NVIDIA GeForce
to the internet to run NVIDIA GeForce Experience) you can click the NVIDIA Experience
GeFor ce Experience desktop icon K< (or App) to run the application. Thiswill op- Version
timize your gaming settings for your NVIDIA GPU by downloading the latest set-

tings from the NVIDIA cloud data center. Hote that the NVIDIA

GeForce Experience
] ] application is subject
You may need to create an NVIDIA account to log-in to the system (alternatively BEECeREEREREIERG

you may be able to use your Facebook or Google account to log-in). update and revision,
so make sure you con-

nect and update regu-

: ] larly in order to get the
update your settings and check for installed games etc. latest settings and in-

formation.

After logging in to the system you can click through any on-screen instructions to

By running the NVIDI A GeFor ce Experienceyou will be able to download the lat-
est drivers to insure compatibility with games, power saving features and various
other enhancementsfor your NVIDIA GPU (these features are subject to change and
update so check with the NVIDIA website for the latest information).

Note that to enable Batter yBoost you must be connected to the internet (see over).

NVIDIA GeForce Experience C - 5



Video Driver Controls

NVIDIA GeForce Experience - BatteryBoost

BatteryBoost allows you to optimize your system’s battery life when gaming. Y ou
can adjust the BatteryBoost slider in Preferences > BatteryBoost (make sure you
have restarted the computer after the first run of NVIDIA GeFor ce Experience).

Running BatteryBoost

1. Onfirst run of NVIDIA GeForce Experience you should be connected to the inter-
net (BatteryBoost will not appear at this stage).

2. After the first run you should restart the computer manually, but you must still be
connected to the internet (the LAN cable should be plugged-in, or your WiFi
connection should be set to Connect Automatically) as the computer restarts.

3. BatteryBoost will be present when NVIDIA GeForce Experience is run again.

Click to put atick in the box alongside Batter yBoost to enable the feature, then ad-
just the dlider towards L onger battery life or Higher performance as preferred.

.|
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Video Driver Controls

Configure Other Displays Using Project

Y ou can configure attached displays from Proj ect.

1.
2.
3.

Attach your display to the appropriate port, and turn it on.

Press the == + P (or Fn + F7) key combination.

Click on any one of the options from the menu to select PC screen only,
Duplicate, Extend or Second screen only.

You can also click Connect to a wireless display at the bottom of the Project
screen and follow the steps to connect to any wireless enabled display.

Project

PC screen only

Duplicate Flgure C - 1
Project

Second screen only

Configure Other Displays Using Project C - 7




Video Driver Controls

Configuring an External Display In Windows

The System > Display Control Panel in Settings may also be used to configure dis-

plays.

1. Attach your external display to the appropriate port, and turn it on.

2. Click the Start Menu and click Settings > System (or right-click the desktop and
select Display Settings).

3. Click the Multiple Displays menu and select Duplicate these displays, Extend
these displays or Show only on 1/2.

4. Click Keep changes to save any changes made.

B fisme Display

FigureC- 3 e _ |
System > Display fi 112 i
(Multiple Displays)

Duplicate these displays

Make Windows better

Extend these displays
Show only on 1

Show only on 2

.|
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5.

Video Driver Controls

You can configure up to 4 displays from the System > Display menu.

4

| Find a setting L'i 4 COﬂ neCted
Displays

Customize your display Notel that when 4 dis-

plays are connected,
only 2 displays may be
configured in Duplicate

B : EEES

FigureC-4
identify  Detect System > Display
Change the size of text, apps, and other items: 100% (Recommended) (4 CO nn eCted
[

' Displays)

Orientation

uplicate desktop on 1 and 2

Duplicate desktop on 2 and 3

Duplicate desktop on 2 and 4

icconnect this display

IS my mam aisplay

Configuring an External Display In Windows C - 9
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HDMI Audio Configuration

HDMI (High-Definition Multimedialnterface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually

The sound volume level | confijgure the HDMI audio output as per the instructions below.
can be clicking using the

4

Volume Adjustment

volume control icon [ 1. Go tothe Sound control panel.
in the notification area 2. Click Playback (tab)
of the taskbar. 3. The playback device will be selected.
4. You may need to select the audio device and click Set Default (button).
5. Double-click the device to access the control panel tabs.
9 Sound X
Playback Recording Sounds Communications
Select a playback device below to modify its settings:
FigureC -5 B G
$) HNot plugged in

Sound - HDMI
Device (set Default)

\I NVIDIA HDMI Output (Port 2)
L w

lot plugged in

SyncMaster-C
NVIDIA High Definition Audio
Default Device

Realtek Digital Output

- Realtzk High Definition Audio
Ready

\us

High Definition Audio

Configure
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Video Driver Controls

6. Adjust the HDMI settings from the control panel tabs.
7. Click OK to close the Sound (‘¥ control panel.

W SymcMaster-C Properties = W SyneMaster-C Properties b4

Ganeral Supperted Formats Levels Crhancements Advancsd Gararal Sopported Formals Lavels Enhancements  Advasced

i — [ e

Change |can
T R The fallawing aucka fermats are currently supporad
M Hursiar of Channets:
@J MvIDas High Definkion Auds Broperties.
HOCP: Supported
N i Depith: 16
28
[
Jack informatian Sample fiates:
LR HDMI Digeal Jack e
48.0 4z
Encaded Foemay:
Mo compressed formats found
Device usage: Use this device (anabie) v

[ ]| conml srviy [k ]| conem Fre

W SymcMaster-C Properties »®

FigureC-6
HDMI Device

W SyncMaster-C Properties X

Gereval Supporied Formats Levels Cnhancements  advanced Garsrsl Supporied Formats Levels  Dnhanesmaerts Advanced

Salect the arhonceenants 1o appl for your cument pesker e Propernes
«configuration. Changes may not take effect until the next tme you start
playhnck, Sebect the sample rate and bt degith 10 be uied whan runming in

shared mads.

[Cnisabie & anhsmcements
L (e 16 B 46000 e (VD ity =] [ e
] Room Correcton

[ Loudness Bqualisation

24 it, 44100 Hz (Studio Quality)
24 it,_a8000 1z [Stuckia Cluali

[T allow apphications to take excluswe control of this device

Ertmncame FYoprtien [l v exclusive mode sppheaticns priarty
Drscrption; Law Fragueacy Protection elevnates fregquencinn

below o specfied cutoff 1o reduce audio distortion

Provider: Microsoft
Sentus: Dinabled Setnga...

Bestors Defuts B ereviaw [
Festore Refaults
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HDMI Notes
A » Connect adevice with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.
» To play audio sources through your external display’s (TV or LCD) speakers
If you are using a third you will need to go to the audio configuration control panel on the display and

party application to play . . . . . .
DVDs ete, from any at- configure the audio input accordingly (see your display device manual).

tached - DVD " device, | pp\)video Configuration

you will need to consult .
the application’s docu- 1. Connect an HDMI cable from the HDMI-Out port to your external display.

Other Applications

mentation to see the 2. Configure your external display as per the instructions in this chapter.

appropriate audio con- 3. Set up your external display (TV or LCD) for HDMI input (see your display device
figuration (the applica- manual).

tion must support digital 4. You can now play video/audio sources through your external display.

to analog translation).

.|
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Wireless Display

Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make surethat your video adapter/display deviceiscompatible
with your particular WL AN/Combo module) in conjunction with a compatible
video adapter/display device (purchased separately) to allow you to display the
contents of the notebook display on another display (e.g. HDTV), without the need
to have cables stretching across a room.

Y ou can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/externa display without using HDMI or A/V ca
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter usingan HDMI or A/V ca
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 10.

4

Compatible
Adapters

For a list of compatible
adapters check the vid-
eo adapter/display de-
vice documentation, or
with  your distributor/
supplier.

HDMI Audio Configuration C - 13
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Wireless Display Configuration

1. Note that no driver or application is required for wireless display in Windows 10.

2. Pressthe g@ + P key combination.

3. Click Connect to a wireless display (see overleaf if this does not appear) at the
bottom of the Project screen and follow the steps to connect to any wireless
enabled display.

Project

PC screen only

FigureC-7
Add a Wireless Duplicate
Display

. Second screen only

4. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

C - 14 Wireless Display Configuration
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o

Double-click any detected display device in the list.

6. You may then need to input a pin number for the device to which you are
connecting and click Next.

7. The display will then connect (for specific settings for your display see the
documentation supplied with your compatible adapter/display for full details).

8. Go tothe Project menu and click Disconnect to temporarily disconnect from the
wireless display.

9. To permanently disconnect from the display (you will need to go back through the

connection process again) you can select it in Devices and click Remove Device

> Yes.

Wireless Display Configuration C - 15
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NVIDIA Control Panel

More advanced video configuration options are provided in the NVIDIA Control
Panel tab. Usethe NVIDIA Control Panel to configure displaysin Discrete mode.

4

NVIDIA Control

Panel
To access the Ge- 1. Go to the Control Panel.
Force..... control panel 2. Double-click NVIDIA Control Panel (click to view the control panel in either Large
from the desktop; right- icons or Small icons if you are in Category view).
click the desktop, then (53 Al Control Paned ftems =%
CIICk NVIDIA ContrOI - ~ I EH » Contral Panel » All Contral Panel ltems > » & | Search Control Pane 0
Panel.
Vi Adjust your computer's settings Viewby: Large icons ~
iu? b)’: iy Devices and Printers IS Display @9 Ease of Access Center ~f
::: ot = File Explorer Options & File History Flash Player (32-bit) [
Intel ® Graphics Settings |
| A e A fonts " HomeGroup oy Indexing Options
N y
= D_EWI » ‘l Internet Options = Keyboard ﬁ Language I
™) Display settings 2
& personalize n
? Mouse I‘.’ l(\.l‘:t.:-.:rk #c Sharing ( NVIDIA Control Panel ) |
) I
C . h Personalization £ Phone and Madem \; Power Options
. FigureC- 8 e ' |
= . Realtek HD Audio [
NVIDIA Control y] Programs and Features m Manager ‘h Recovery |
Panel 9 Region :"1 I?emuiw’l\pp and Desklop ‘ Security and Maintenance .
# Connections \
“? Sound U Speech Recognition g Storage Spaces
bl |
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Further menu itemswill appear inthe NVIDIA Control Panel in Discr ete mode, pro-
viding additional video configuration controls and tools which give access to fea-
tures such as display configuration, 3D Settings etc.

O =0 | 6

pas | Adjust image Settings with Preview O o= — - e
i w— e £ s s B o L L - - - — " -
| et G s
s e
e | L7, Adjust Desktop Color Settings T
L

NVIDIA Control Panel C - 17

4

Navigating the
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.

Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

FigureC-9
NVIDIA Control
Panel
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The Help menus provide index and search features, and direct links to the NVIDIA

website etc.

FigureC- 10
Help Menu

&' NVIDIA Control Panel

- =
Hide Back Forward Home

Contents |ndex Search

@ Inroduction
@ Getting Started
@ Display

@ Workstation
@ Stereoscopic 3D
[2] Glossary

Print

<A NVIDIA. =

Control Panel

3D Settings - Games and Applications

Tasks in the 3D Settings pages allow you to do the following:

e Change the image and rendering settings of your 3D
applications and games that utilize Direct3D and OpenGL
technology.

® Assign specific 3D settings to = game so that these settings
automatically load when a game is launched.

® For systems and NVIDIA GPU-based graphics cards that are
capable of using NVIDIA Scalable Link Interface (SLI)
technology, you can enable this feature for significant

improvements in rendering performance of applications that
are based on Direct3D and OpenGL technology

These and other tasks are explained in the following sections:
® Adjust Image Settings
™ Manage 3D Settings
= NVIDIA Surround Configuration
m NVIDIA SLT Configuration

= NVIDIA Multi-GPU Configuration

m NVIDIA PhysX Configuration

[ NOTES for Optimus technology systems:

Some notebooks have special display connectors that are

driven by the NVIDIA GPU. Displays attached to these
connectors appear in the NVIDIA Control Panel Display

category pages. The NVIDIA GPU will always render the 3D W
cantent an these disnlavs. and vau can adiust various 20

C - 18 NVIDIA Control Panel
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Customization Options

4
One of the most important aspects of hybrid technology isthat it will switch between _
the integrated GPU and discrete GPU seamlessly and automatically, and does not re- DlEplen €2
- . . . Activity Icon
quire any input from the user. However customization options are offered for users
who prefer to set their own parameters for GPU usage. Click to enable Dis-
play GPU Activity
Context Menu Icon in the Notifica-
One of the quickest ways to choose which GPU to use for aparticular applicationis [ tion Arﬁa to quickly
by using the “Run with graphics processor” in the context menu. access the GPU Activ-
ity monitor from the

1. Go to the NVIDIA Control Panel. taskbar.
2. Click Desktop from the top menu and select Add “Run with graphics t
processor” to Context Menu (it should have a check alongside it).
B nvIDIA Control Panel
File Bt Desktop DisBlay Help
G Back [& Add Desktop Context Menu

clectaTask. ¥ Show Notification Tray lcon

=30 Settir L Add "Run with graphics processor” to Context Menu e Dlsplays
i-Adjug Display GPU Activity Icon in Netification Area
- Manage 3D"EeTmgE

L.Configure Surround, PhysX

NVIDIA nView technology allows you to specify how you would like to use multiple displays.

T D'ng:nge resolution FI gure C - 11

i-Adjust desktop color settings 1. Select the displays you want to use.

NVIDIA Control
tate display

HDCP status Geforce GTX 1060 Panel - View
t up digital audio Samsung SyncMaster n

g.....ad]ust desktop size and position
| ey,

Customization Options C - 19
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Close the NVIDIA Control Panel.

4 , . Find the executable file icon of the application you want to run.

Right-click the icon and select Run with graphics processor from the context
menu.

Note the NVIDIA con- . Select either High-performance NVIDIA processor (dGPU) or Integrated

iGPU or dGPU

trol panel refers to graphics (iGPU) to run the program with the selected GPU.
High-performance
NVIDIA processor 5] v Application Tools  Intemet Explorer — [m] x
. . . Home Share View Manage 2]
(WhICh is the discrete « « A [ > ThisPC > Local Disk(C) > Program Files (x86) » Intemet Explorer v|® | SesrchInternet Explorer r
GPU) and lntegrated A GiicEnccess Name - Date modified Type Size
grapthS (Wthh is the B Desktop ’ en-US 1AM  Filefolder
integrated GPU). Felowloak: £ ST i
2 :Uc::m ¥ xapore Asplcation
[ hmmapidi Application extens..
OLMLAN [T iegprops.propdesc PROPDESC File
Docs @ ieinstal spplication
Docs. g,\ ielowutil ﬂ-ziu.mm
PEXRX. 2] 1EShims.dil M jcation extens...
. B ﬁ:x:::d” ‘, ope:.-m-gmmur«n Annlication —
i - [ This PC .
FI gure C 12 = Desktop C Run with graphics processor >) High-performance NVIDIA processor
Context Menu with & Documents 3 Integrated graphics (default)
& Downloads Fini 10 taskbiat | Change default graphics processor...
Run with graphics § igh :‘mlmkh 'I- . able fil
Right=elick the application executablefile
rocessor B Videos cn
P . Local Disk (C:) Copy
= DATA (D) Create shortcut
= MEMSTICK (1) ) Delete
o Network & Renzme
Properties
Tlitems 1 item selected 799 KB ) S
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Global Settings

Global settings allows you to set the preferred graphics processor for overall use. 4

Ideally thiswould betheiGPU for battery life, but this can be set to the dGPU if pre- Customization

ferred. Options

1. Gotothe NVIDIA Control Panel. Although hybrid tech-

2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab). nology is completely

3. Select either Integrated graphics (iGPU) or High performance NVIDIA seamless to the user,
Processor (dGPU) from the drop-down menu. there are customiza-

4. Click the Setting menu items to select any options required. tion options within the

5.

Click Apply to save the settings. control panel (see

" FigureC- 13
AT R R AR T e Global Settin gs

Customization Options C - 21
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1.
2.
3.

o

FigureC- 14
Program Settings

Go to the NVIDIA Control Panel.

Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
Select a program to customize from the drop-down menu, or click Add to add
any program that does not appear in the menu.

Select the preferred graphics processor for the program from the drop-down
menu.

Click the Setting menu items to select any options required.

Click Apply to save the settings.

B rADHA Contenl Panal (=] aC
File [dn Dediop 30 Semings  Help

Hestore Defautts
ge the glebial 30 - e sed utomaecaly sach time the Ipectied programs ane launched

[Shova ey pragrams foond an s computer

2. Salect the refred oraghics processr for S rograe:
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Change Resolution

Y ou can Change Resolution for your attached displays from the NVIDIA control
panel.

1. Attach your external display to the appropriate port, and turn it on.

2. Gotothe NVIDIA Control Panel.

3. Double-click Display (if the sub-menus are not visible), and then click Change
resolution.

4. Click to select the display, and then adjust the settings from “2.Choose the
resolution.” and “3.Apply the following settings.”

5. Click Apply to save the settings.

Eie [t Despon Doy e

Ons - Q| — S
P 1,3 Change Resolution Remare Detaudts
= gy s sl e b S, I U -
.- .

Change Resolution

P —

Change Resolution C - 23
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Display Devices - NVIDIA CP

Note that you can use an HDMI (High-Definition Multimedia Interface) cable con-
nected to the HDMI-Out port and/or DisplayPort compatible cable connected to a
DisplayPort 1.3 to connect an external display. See your external display device's
manual to see which formatsit supports.

2MN\L
I

Configuring External Displays

When a single external display is attached to the HDMI or Display Ports, use the System
(in Settings - page ) control panel, or the E + P (or Fn + F7 - page ) key com-

bination, to configure the external display.

When multiple external displays are attached you should use the NVIDIA (page ) con-
trol panel to configure the external displays.

You cannot configure external displays using the Intel(R) HD Graphics control panel.

.|
C - 24 Display Devices - NVIDIA CP
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Display Mode Description /
Single One of the connected displays is used as the display device Sound Blaster
. . . Audio & HDMI
Clone Clone simply shows an exact copy of the Primary display desktop on the other c ti
display(s). This mode will drive multiple displays with the same content Ll
Extend treats connected displays as separate devices, and they act as a virtual Not(_-:‘ tha? Sound Blaster
Extend desktop resulting in a large workspace. When enabled, you can drag any icons or audio will be disabled
windows across to the other display desktop. It is therefore possible to have one when you are connect-
program visible in one display, and a different program visible in the other display ing to an external dis-
play through an HDMI
connection.
TableC-1
Display Modes
NVIDIA

.|
Display Devices - NVIDIACP C - 25
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4

Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown..” and
then click the appropri-
ate button to force de-
tection of the missing
display.

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page C -
9 for instructions on con-
figuring audio for HDMI
display devices.

FigureC - 16
Set Up Multiple
Displays

Configuring an External Display (NVIDIA)

Clone the External Displays

5.
6.

Attach your external displays to the appropriate ports, and turn them on.

Go to the NVIDIA Control Panel.

Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

Any attached display will appear under “1.Select the displays you want to use.”

2 i e e i i ot g e e

i i e Py Pt s i P of ot gy gtk o i i o il pnmd

Click the check box alongéide any display you wish to use.
Click Apply > Yes to save any changes made (the Apply button will appear in the
bottom right of the control panel when changes have been made).

C - 26 Configuring an External Display (NVIDIA)



Video Driver Controls

Extending the Display

1. Attach your external displays to the appropriate ports, and turn them on. 4

2. Go tothe NVIDIA Control Panel.

3. Double-click Display (if the sub-menus are not visible), and then click Set up
multiple displays.

4. Click to select a primary display under “1.Select the displays you want to use.”

Changing the
Primary Display on
Extended Displays

5. Right-click the icons under “2.Drag the icons to match ....” and select Extend. If you want to switch the
i = =B x| primary display if the

Ors 016 | displays are extended

= | L3 Set Up Multiple Displays } then right-click the sec-

D ar v o apedihomy ‘ ondary display icon and

— | select “Make Primary”.

GeForce GTX 1060 ‘ C“Ck Apply > Yes to
A.,m.c.,....n.....mum]..[mn E save the Change (See
over).

2. Drag the icons to match your display configuration.

FigureC- 17
Extend the Display

& system Information

.|
Configuring an External Display (NVIDIA) C - 27
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FigureC- 18
Switch Primary
Display

The Primary display (the main window display) will be denoted by an asterisk *in
the top right corner of the icon.

To change the Primary display right-click the icon and select Make primary.
Click Apply > Yes to save any changes.

NVIDIA Control Panel - o %
Fle Eait Desktop Display Help

()um ] Q :

171 Set Up Multiple Displays
— VDA n\ﬂ;wimwﬂ a!a_ws \f_:u o SpECEy how you would ke 1o use multipls displays

1. Select the displys you want to use.

Graphics Device

|| seny sa 24302 1
|| Samsung SyreMaster 2

My cisplay is not shown

2. Drag the icons to match your display configuration.

Right-cl
to save

B Sstem Sofocmaiion
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9. You can drag the icons to match the desktop layout you want to use (e.g. you may
want to extend the display to the right or left of the primary display).

10. Click Apply > Yes to save any further changes.

B nviDIA Contral Panel
File Edit Desktop Display Help

Qe -O | @

[13 Set Up Multiple Displays

NVIDIA View ay youto specify how y ke

1. Select the displays you want to use.

| GeForce GTX 1060
| BenQ X124202

1
3

My dispiay is notshown.

22 Primary display

1 Surround spanning options

Description:

Typical usage scenarios:

(@ Svstem Informati

displays

FigureC- 19
Drag Display
Icons

Drag the ieons so they match the physical configuration of #lur desplays. Right-ciick on an icon for additional options.

Apply Cancel

Drag the display icons to match the layout you want to use.

Configuring an External Display (NVIDIA) C - 29
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HDCP Status

If your external display is HDCP (High Bandwith Digital Content protection) com-
patible then the NVIDIA control panel will display the HDCP system status.

MVIDIA Control Panel — m] > |

Eile Edit Desktop Display Help

Qeack ~ O

= View HDCP Status

High-Bandwicith Digital Cantent Protection (HDCP) is a technalogy designed to protect high-definition content. Use this page 1o determine if yo
system is HDCP-capable.

Select the display on which you watch movies.

BenQ X124202

This display supports HDCP.

@  Your graphics card and display are HOCP-capable.

Figure C - 20

HDCP Status -@/—g

(@ system Information

C - 30 HDCP Status



Video Driver Controls

Adjust Video Settings
Y ou can adjust video color and image settings from the Video sub-menus.

1. Gotothe NVIDIA Control Panel.
2. Click “+" next to Video if its sub-items are not shown and then click either Adjust
video color settings or Adjust video image settings.

3. Make any adjustments required for any display and click Apply to save the
settings.

- B = o FigureC - 21
Sarvsang Sy Lanon Oiee Sameng S Adjust Video Color
i e e st Settings

B eh P i plaer memngs

W B WD et

e Camma Advancsd
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Configure Surround, PhysXe

NVIDIA® PhysX® isa physics engine that can use the GPU to accel erate game and
3D application performance. Y ou can select the GeForce video card or CPU as a
PhysX® processor, or configure the computer to auto-select a PhysX® processor
(recommended default setting).

1.
2.
3.
4.
FigureC - 22
Configure

Surround, PhysX

Go to the NVIDIA Control Panel.
Click Configure Surround, PhysX.
Click to select a processor from the menu (PhysX Settings); Auto-select
(recommended) is the default setting.
Click Apply to save the settings.

e,
Yiwim . Configure Surround, PhysX

.|
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Set Digital Audio

AsHDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nalsyou can configure the audio output from the NVIDI A control panel and Sound
control panel. The settings will depend upon the external HDMI display to which
you have connected.

Connected displays will appear alongside the appropriate port. Click “ Open Win-
dows Sound Settings” (button) to access the Sound control panel.

Heatore Defaulty

FigureC - 23
Set up Digital Audio

3. Configqure playback devions with the Windamws Sound st tiegs.

Dt Vvt Sound seflngs

Set Digital Audio C - 33
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Intel® UHD Graphics Control Panel

Advanced video configuration options are provided by the Intel®@ UHD Control
Panel. Usethe Intel® UHD Control Panel to configure displaysin Hybrid mode.
To access the control panel see below and overleaf:

1. Right-click the Desktop and select Intel(R) Graphics Settings from the menu.

Figure C - 24 T ?
Right-Click Desktop S ?
(Intel Graphics efresn
Settings) s
{ B Intel® Graphics Settings
& e GenisisRene!
New >
':3 Display settings
& Personalize
OR
_ 2. Click the icon in the notification area of the Desktop taskbar and select Intel(R)
FigureC- 25 Graphics Settings from the menu.
Taskbar Notification .
Area Icon Menu S

. 215 AM
~ ) B n0me
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OR
3. Double-click the Intel(R) Graphics Settings control panel in the Windows
Control Panel.

All Control Panel ltems - O X

4 [H > ControlPanel > All Control Panel ltems v & Search Control Panel r-l

Adjust your computer's settings Viewby: Largeicons ¥ F' gure C - 26
Control Panel

o " 7 a& Backup and Restare )
D Administrative Tools B a AutoPlay (Windows 7) In te|® Gl’ap h i CS
" % BitLocker Drive Encryption ﬂ Color Management @‘] Credential Manager Set“ ng S
Date and Time ’_ﬁ Default Programs .f._ Device Manager
§T, Devices and Printers g Display @I Ease of Access Center
File Explorer Options & File History Flash Player (32-bit)

Fonts " HomeGroup J;‘, Indexing Options

A
s s : Intel® PROSet/Wireless Q;m 5
Intel(R) Graphics Settings @ Tools ﬁ_w Internet Options

_ Keyboard «» Mouse

<
EE NefdbcaRd SHharing B ercanalization #%9 Dhone and Madem
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Y ou may make changesto any of the graphics properties by clicking the appropriate
4 menu panel and adjusting the settings from the menus.
Home

Click the Home button to

return to the main menu
screen in any of the sub-
menu screens.

Figure C - 27
Intel® UHD Graphics
Control Panel

TUNE YOUR GAME FOR INTEL GRAPHICS 7

Better Eny ents. More Detailed Characte: e Exciting Effects.

Display Video Gamlng Power Options and
Support

C - 36 Intel® UHD Graphics Control Panel



Video Driver Controls

Display
Click either Display Settings or Color Settings to make display adjustments, in-
cluding configuration for any attached external displays.

2N
I

Configuring External

Displays FigureC - 28
When a single external display is Intel® UHD
attached to the HDMI or Display Graphics
Ports, use the Display (page Control Panel
) or System (in Settings - page .
) control panels, or the ﬁ+ Display

P (or Fn + F7 - page ) key
combination, to configure the ex-
ternal display.

When multiple external displays
are attached you should use the
NVIDIA (page ) control
panel to configure the external
displays.

You cannot configure external
displays using the Intel(R) HD
Graphics control panel.

Intel® UHD Graphics Control Panel C - 37
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The Custom Resolutions sub-menu alows you to adjust the display (or any at-
tached display) to any width, height, refresh rate, color depth and underscan percent-
age of your choice. Note that incorrect settings can cause system instability and even
possible component damage, so thisis adjusted at your own risk.

Figure C - 29 Intel® UHD Graphics Control Panel = CIEX
Intel® UHD ® oisplay e
Grap hics General Settings e S Lee
Control Panel Color Settings
Display Settings - g tipte Dioplays it [
Custom
. Height
Resolutions g —_
P o
Underscan Percentage
Select Display m— 2t
Built-in Display ~
I Resulting Resolution: 0x 0, 0 Hz.

Add
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3D

This menu allows you to choose how 3D images are displayed. Perfor mance gives
the smoothest motion of images, Quality displays the most detail, Balanced M ode
provides better computer performance with good quality and Custom allows you to
configure the Anisotropic Filtering and Vertical Sync and features to your prefer-
ences. Click Apply to save changes.

Intel® UHD Graphics Control Panel

OED
Application Settings Select Application @ Consenvative Morphalogical Anti-Aliasing FI gur e C - 30
Global Settings () Applications with default 30 settings Override Apphcation Default Settings Intel® UHD
Ne application found. Press Browse to find more ap: .
Enhance Application Default Settings G rap h ics
W Tum off
Control Panel 3D

< > Mutti-Sample Anti-Aliasing

V' Use Applcation Default Settings

Turn O

wertical Sync
Anisgtropic Filtering

()]
' Usa application Detault Settings =
V' Lise Appiication Default Settings
s Drivur Settings C
n
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Options and Support

Hot Key Manager in Optionsand Support allowsyou to create hot keys for open-
ing the application, rotating the display, scaling etc. Click Apply to save changes.

Intel® HD Graphics Control Panel ol =
@ Options and Support @
Information Center ictelonphic el @
Preferences
Support R @
FigureC - 31 el i
Intel® HD Graphics <Cirl> <Alt>F11
Control Panel Select Profile ?;:T:,:::H: e
Options and Current settings -
Support

So

®

Save Profile
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-1n Display

and any attached displays.

Preferences
Profiles

Support

Select Option

System Information

Intel® UHD Graphics Control Panel
@ Options and Support

Information Center

Hot Key Manager

So

Intel(R) UHD Graphics 630

Report Date: Tuesday, March 20,
2018

Report Time [hh:mm:ss]: 4:41:21 PM

Driver Version: 23.20.16.4974

Operating System: Windows* 10 Pro
(10.0.16299)

Physical Memary: 8046 MB

Vendlor ID: 2026

Device ID: 3E9B

Device Revision: 00

Graphics Qutput Protocol (GOP)  9.0.1074
Version:

Current Resolution: 1920 x 1080

Processor:

Processor Speed:

Processor Graphics in Use:

Shader Version:

Intel(R) Core(TM)
i5-8300H CPU @
2.30GHz

2304 MHz

Intel(R) UHD Graphics
630

51

OpenGL* Version: 4.5
OpenCL* Version: 21

Vulkan* Version: 1.0.66
Microsoft DirectX* @
Runtime Version: 120
Hardware-Supported Version: 120

Video Driver Controls

4

Preferences

Go to the Preferences
sub-menu in Options to
configure the preferences
for the Intel® HD Graphics
Control Panel.

Make sure you click En-

able under Tray Icon to
display the Intel® HD
Graphics Control Panel
icon in the notification area
of the taskbar (as below).

Intel(R) Graphics Settings
Exit Tray

FigureC - 32
Intel® UHD
Graphics
Control Panel
Options -
Information Center
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Video
The Video menu allows you to brighten or darken movies, or to switch to vivid col-

ors. The Preview image will display a sample image using the current settings. Y ou
can Save Profile and name the Profile to recall the settings at any time. Click Apply
to save changes (select Color Enhancement, | mage Enhancement, | mage Scaling
or Gamut M apping from the menu).

Intel® UHD Graphics Control Panel

@ Video

1 Standard Color Correction
FI gure C - 33 W' Lise Application Default Settings
|nte|® UHD Image Enhancement Bomiw
Use: Driver Settings
Graphics o
nput Range
Contro | Pan el - ' Use Application Default Settings
Vldeo Ui Dirieer Seettings
(CO I or Select Profile Total Color Comaction
En h ancemen t) Current Settings ~ Enable ' Disable
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Click the Video menu at the top of the screen to display the sub-menus.The I mage
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction, Contrast Enhancement and Film M ode Detection. Click

Apply to save changes.
Ir.1te|® UHD Graphics Control Panel FigureC - 34
ORGE i oS Intel® UHD Graphics
Color Enhancement Sharpness ©] Control Panel - Video

Use lication Default Settings.
Image Enhancement A = (Image
Preview @

Use Driver Automatic Settings En h an C em en t)

Use Driver Custom Settings CAWindows\System32\Dri... ™

: <3
W -

et -
»
Py

@

Skin Tone Enhancement

V Enable Disable

] 3

Select Profile

Current Settings v

@

Noise Reduction

iy
Use Application Default Settings 4
W Use Driver Automatic Settings L T4

Use Driver Custom Settings 1 w

@

Contrast Enhancement

v Enable Disable
— ] 5
Film Mode Detection @

Save Profile
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Power

The battery life can be extended through dynamic control of the frame rate if Ex-
tended Battery Life for Gaming is enabled. Settings can be selected for when the
system is powered by battery or is plugged in.

Intel® UHD Graphics Control Panel

@ Power

Select a Graphics Power Plan Balanced Mode
Plugged In
F| gure C - 35 Change Settings for the Plan Balanced Mode v
I I’] te I ® U H D Display Power Saving Technalogy @
.  Enable Disable
Graphics

e
COﬂtrO' Pan E| = Maximum Quality Maximum Battery
Power Select Profile Enhanced Power Saving Mode ®

Current Settings ~ Enable  Disable

Global Settings

Extended Battery Life for Gaming @
W Enable Disable

®

Save Profile
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Video Driver Controls

Profiles

Y ou can select one of the preset profiles (Brighten Video, Darken Video and En-
hance Video Colors) from the menu on the left. Alternatively you can go through
the menus to make adjustments to your preferences for Display, Color, Video, Op-
tions and Support and Power (tick any boxes for the settings required), and then
Save the settings to a profile (which may be imported or exported).

Intel® UHD Graphics Control Panel ek
@ Profiles intel

Select Profile

Current Settings v

e

Settings

Display

W] Color

Video

W] Options and Support

W] Power
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Video Driver Controls



Specifications

Appendix D: Specifications
A

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.

Note that this computer model series may support a range of CPUs and/or video adapters.

To find out which CPU is installed on your system go to the Start menu and select Settings, and then select System and
click About. This will also provide information on the amount of Installed RAM etc.

To get information on your system’s video adapter go to the Start menu and select Settings, and then select System and
click Display> Advanced display settings > Display adapter properties.
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Specifications

Mobile Intel® HM370 Express Chipset

Models A & B:
15.6"/ 39.62cm, 16:9, 3.2mm Thick
Backlit Panel

(For Model A, Model B Design | &
Model C)
Memory Expandable from 8GB to 32GB

Compatible with 4GB, 8GB or 16GB
Modules

(For Model A & Model B Design )
UHD (3840 * 2160) / FHD (1920 * 1080)

(For Model B Design 1)
FHD (1920 * 1080)

Model C:
16.1" (40.89cm), 3.2 mm, FHD (1920 *
1080),16:9 Backlit Panel

Dual Channel DDR4

Two 260 Pins SO-DIMM Sockets
Supporting DDR4 2400 / 2666 MHz
*Memory Modules (real operational
frequency depends on the FSB of the
processor)

(For Model B Design 1)
Supports 8GB Memory

\ A/

SO-DIMM Memory Types

All SO-DIMM memory modules installed in the
system should be identical (the same size and

brand) in order to prevent unexpected system
behavior.

Don’t mix SO-DIMM memory module sizes
and brands in order to prevent system prob-
lems.

One Changeable 2.5" /7.0 mm (h) HDD /
SSD with SATA (Serial) Interface

(For Model A, Model B Design | &
Model C)

One M,2 2280 SSD, PCle Gen 3*4 /
SATA Interface - (Factory Option)

(For Model B Design II)
One M,2 2280 SSD, SATA Interface -
(Factory Option)

High Definition Audio Interface
S/PDIF Digital Output

Built-In Array Microphone

Two Built-In Speakers

Sound Blaster® X® Pro-Gaming 360°

Built-in Secure pad OR Touchpad with
Microsoft PTP Multi-Gesture and
Scrolling Functionality - (Factory Option)

WASD Gaming Keys

(For Model A, Model B Design | &
Model C)

Full Size Color llluminated LED Keyboard
with Numeric Pad

(Model B Design II)
Full Size White llluminated LED Keyboard
with Numeric Pad
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*Two USB 3.1 Gen 2 Ports (Type C)
Three USB 3.0 Ports (USB 3.1 Gen 1,
including 1 AC/DC Powered USB Port)
Two Mini DisplayPorts 1.3

One HDMI-Out (High-Definition
Multimedia Interface) Port (with HDCP)
One 2-in-1 Audio Jack

(Headphone / S/PIDF optical output)
One Microphone-In Jack

One RJ-45 LAN Jack

One DC-In Jack

*Note: The maximum amount of current supplied

by USB Type-C ports is 500 mA for USB2.0/900
mA for USB 3.1

*Embedded Multi-In-1 Card Reader
- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC up to UHS-II

*Note: Some of these cards require adapters,
which are usually supplied with the cards.

Specifications

For Model C
Two M.2 Card Slots

For Model A & Model B Design | Only
Two OR Three M.2 Card Slots

Slot 1: for M.2 2230 WLAN Combo Module
Card with PCle/USB/CNVi Interfaces (E Key)

Slot 2 for M.2 2280 SSD (Solid State
Drive) Card with SATA / PCle Gen 3*4
Interface (M Key)

(Factory Option) Slot 3 for LTE (4G
Module) + M.2 3042 Card with USB Interface
(B Key)

For Model B Design Il
Two M.2 Card Slots

Slot 1: for M.2 2230 WLAN Combo Module
Card with PCle/USB/CNVi Interfaces (E Key)

Slot 2 for M.2 2280 SSD (Solid State
Drive) Card with SATA Interface (M Key)

Slot 1: for M.2 2230 WLAN Combo Module
Card with PCle/USB/CNVi Interfaces (E Key)

Slot 2 for M.2 2280 SSD (Solid State
Drive) Card with SATA / PCle Gen 3*4
Interface (M Key)

For All Models

Built-In 10/100/1000Mb Base-TX
Ethernet LAN

Intel® Dual Band Wireless-AC 9560
(2*2 802.11 ac) WLAN + Bluetooth M.2
2230 Combo Module (Factory Option)

Intel® Dual Band Wireless-AC 9462
(1*1 802.11 ac) WLAN + Bluetooth M.2
2230 Combo Module (Factory Option)

For Model B Design Il & Model C Only
1.0M FHD PC Video Camera Module
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Specifications

For Model A, Model B Design | &
Model C:

Intel® Dual Band Wireless-AC 9260
(2*2 802.11 ac) WLAN + Bluetooth M.2
2230 Combo Module (Factory Option)

Qualcomm® Atheros Killer™ Dual Band
Wireless-AC 1550i (2*2 802.11 ac)
WLAN + Bluetooth Combo M.2 2230
Module (Factory Option)

For Model A & Model B Design | Only:
2.0M FHD PC Video Camera Module

4G/LTE M.2 3042 Card Module (Factory
Option)

Supports Wake on LAN

Supports Wake on USB (AC Mode Only)
Supports Wake on RTC Alarm (AC Mode
Only)

Embedded 4 Cell Polymer Battery Pack
55WH

For Model A, Model B Design | &
Model C:

Full Range AC/DC Adapter AC input 100
- 240V, 50 - 60Hz, DC Output 19V, 7.89A
OR 19.5V, 7.7A (150 Watts)

For Model B Design I

Full Range AC/DC Adapter AC input 100
- 240V, 50 - 60Hz, DC Output 19.5V,
6.15A (120 Watts)

Security (Kensington® Type) Lock Slot
BIOS Password

Trusted Platform Module 2.0 (Factory
Option)

Intel® PTT for Systems Without TPM

Area Finger Print Reader (Factory Option
- For Model A, Model B Design | &
Model C Only)

Metallic Finish
Shipping Mode
FlexiCharger

Virtual Reality Ready

USB Drive (Factory Option)
For Model A, Model B Design | &
Model C:

Intel® Optane™

For Model A, Model B Design | &
Model B Design Il::
Supports Windows® 10 Cortana with Voice

These features apply to some individual model
designs within this series (check with your
distributor/supplier for details)

Windows® 10 RS4 (64-bit)

LED Indicators - Power/Suspend, Battery,
HDD, Airplane Mode, Camera

One 128Mb SPI Flash ROM
AMI BIOS

D - 4 Specifications



Temperature

Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity

Operating: 20% - 80%
Non-Operating: 10% - 90%

380mm(w) * 255mm(d) * 18.6mm(h)
OR

380mm(w) * 252mm(d) * 18.6mm(h)
(Design Style Dependent)

For Model A, Model B Design | &
Model B Design II::

1.98kg *Barebone System with 55WH
Battery

For Model C:

2.09kg *Barebone System with 55WH
Battery

*A barebone system does not include the HDD,
RAM, adapter, power cord and factory option
modules (weight tolerance within +/- 5%).

Specifications
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